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Introduction
 AVERTISSEMENT

Consultez le guide Informations importantes sur le produit et la 
sécurité inclus dans l'emballage du produit pour prendre 
connaissance des avertissements et autres informations sur le 
produit.

Présentation de l'appareil

Boutons de zoom. Appuyez sur ces boutons pour effectuer un 
zoom avant et arrière.
Bouton de retour en arrière. Appuyez sur ce bouton pour revenir au 
menu précédent.
Contrôleur Thumb Stick™. Poussez ce bouton dans une direction 
pour faire défiler l'écran ou mettre en évidence un élément. 
Appuyez sur ce bouton pour sélectionner un élément.
Bouton du menu. Appuyez sur ce bouton pour ouvrir le menu d'une 
page. Appuyez deux fois sur ce bouton pour revenir au menu 
principal.

Appuyez sur ce bouton pour régler le rétroéclairage. Maintenez 
ce bouton enfoncé pour allumer ou éteindre l'appareil.
Port mini-USB (sous le capuchon étanche).

Cache du compartiment à piles.

Bague de verrouillage du cache du compartiment à piles.

Rainure de fixation.

Informations concernant la pile
 AVERTISSEMENT

La limite de température de l'appareil peut dépasser la plage de 
températures de certaines piles. Les piles alcalines peuvent 
éclater sous haute température.

AVIS
Les piles alcalines perdent une grande partie de leur capacité à 
basse température. Choisissez de préférence des piles au 
lithium si vous devez utiliser l'appareil à des températures 
négatives.

Mise en place de piles AA
Votre appareil portable nécessite deux piles AA (non fournies). 
Pour des résultats optimaux, utilisez des piles NiMH ou au 
lithium.
1 Tournez l'anneau en D dans le sens inverse des aiguilles 

d'une montre, puis soulevez-le pour retirer le cache.
2 Insérez deux piles AA en respectant la polarité.

3 Remettez le cache de la batterie en place et tournez l'anneau 
en D dans le sens des aiguilles d'une montre.

Sélection du type de pile
1 Dans le menu principal, sélectionnez Configuration > 

Système > Type de pile.
2 Sélectionnez Alcaline, Lithium ou NiMH rechargeable.

Optimisation de l'autonomie de la batterie
Vous pouvez prolonger la durée de la batterie de diverses 
manières.
• Réduisez la luminosité du rétroéclairage (Réglage de la 

luminosité du rétroéclairage, page 7).
• Réduisez la temporisation du rétroéclairage (Paramètres 

d'affichage, page 9).
• Utilisez le mode Economie d'énergie (Activation du mode 

Economie d'énergie, page 1).
• Réduisez la vitesse d'affichage de la carte (Paramètres de la 

carte, page 4).
• Désactivez la fonction GLONASS (GPS et autres systèmes 

de positionnement par satellites, page 9).

Activation du mode Economie d'énergie
Vous pouvez utiliser le mode Economie d'énergie pour 
prolonger l'autonomie de la batterie.

Sélectionnez Configuration > Écran > Économie d'énergie 
> Activé.

En mode Economie d'énergie, l'écran s'éteint à expiration du 
délai de rétroéclairage. Vous pouvez sélectionner  pour 
allumer l'écran et toucher deux fois l'icône  pour afficher la 
page d'état.

Rangement pour une longue période
Si vous ne prévoyez pas d'utiliser l'appareil pendant plusieurs 
mois, retirez la batterie. Les données stockées restent en 
mémoire lorsque la batterie est enlevée.

Mise sous tension de l'appareil
Maintenez enfoncé le bouton .

Acquisition des signaux satellites
La procédure de recherche de signaux satellites peut prendre 
de 30 à 60 secondes.
1 Placez-vous à l'extérieur dans une zone dégagée.
2 Si nécessaire, mettez l'appareil sous tension.
3 Attendez pendant que l'appareil recherche des satellites.

 clignote pendant que l'appareil détermine votre position.
 indique la force du signal GPS.

Activation du rétroéclairage
Sélectionnez un bouton pour activer le rétroéclairage.
Le rétroéclairage s'allume automatiquement lors de 
l'affichage de messages et d'alertes.

Ouverture du menu principal
Dans le menu principal se trouvent les outils et écrans de 
configuration pour les waypoints, activités, itinéraires, etc. 
(Outils supplémentaires du menu principal, page 7).
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A partir de n'importe quelle page, sélectionnez menu deux 
fois.

Waypoints, itinéraires et tracés
Menu Où aller ?
Vous pouvez utiliser le menu Où aller ? pour trouver une 
destination vers laquelle naviguer. Les catégories Où aller ? ne 
sont pas toutes disponibles pour toutes les zones et toutes les 
cartes.

Recherche d'une position à proximité d'un autre 
emplacement
1 Sélectionnez Où aller ? > menu > Rechercher à proximité.
2 Sélectionnez une option.
3 Sélectionnez une position.

Waypoints
Les waypoints sont des positions que vous enregistrez et 
gardez en mémoire dans l'appareil. Les waypoints peuvent 
indiquer où vous vous trouvez, où vous vous rendez ou où vous 
êtes allé. Vous pouvez ajouter des détails sur la position, tels 
qu'un nom, une altitude ou une profondeur.
Vous pouvez ajouter un fichier .gpx contenant des waypoints en 
transférant le fichier dans le dossier GPX (Transfert des fichiers 
sur votre appareil, page 11).

Création d'un waypoint
Vous pouvez enregistrer votre position actuelle comme 
waypoint.
1 Sélectionnez Marquer un waypoint.
2 Si nécessaire, sélectionnez un champ pour modifier le 

waypoint.
3 Sélectionnez Terminé.

Projection d'un waypoint
Vous pouvez créer une position en projetant la distance et le 
relèvement d'une position marquée vers une nouvelle position.
1 Sélectionnez Gestionnaire de waypoints.
2 Sélectionnez un waypoint.
3 Sélectionnez menu > Projeter waypoint.
4 Entrez le relèvement, puis sélectionnez Terminé.
5 Sélectionnez une unité de mesure.
6 Entrez la distance et sélectionnez Terminé.
7 Sélectionnez Enregistrer.

Navigation vers un waypoint
1 Sélectionnez Où aller ? > Waypoints.
2 Sélectionnez un waypoint.
3 Sélectionnez Aller.

Recherche d'une position par nom
1 Sélectionnez Où aller ? > Waypoints > menu > Rechercher 

saisir le nom.
2 Entrez le nom ou une partie du nom.
3 Sélectionnez Aller.

Modification d'un waypoint
1 Sélectionnez Gestionnaire de waypoints.
2 Sélectionnez un waypoint.
3 Sélectionnez un élément à modifier, par exemple le nom.
4 Saisissez les nouvelles informations, puis sélectionnez Aller.

Suppression d'un waypoint
1 Sélectionnez Gestionnaire de waypoints.

2 Sélectionnez un waypoint.
3 Sélectionnez menu > Supprimer.

Moyenne waypoint
Vous pouvez affiner la position d'un waypoint pour plus de 
précision. Lorsqu'il calcule cette moyenne, l'appareil établit 
plusieurs relevés à la même position, puis utilise la valeur 
moyenne pour améliorer la précision.
1 Sélectionnez Gestionnaire de waypoints.
2 Sélectionnez un waypoint.
3 Sélectionnez menu > Ajuster Position.
4 Déplacez-vous à la position du waypoint.
5 Sélectionnez Démarrer.
6 Suivez les instructions présentées à l'écran.
7 Lorsque la barre d'état d'exactitude atteint les 100 %, 

sélectionnez Enregistrer.
Pour des résultats optimaux, effectuez entre 4 et 
8 échantillonnages du waypoint, en laissant s'écouler au moins 
90 minutes entre chacun d'eux.

Itinéraires
Un itinéraire est une séquence de waypoints ou de positions 
menant à votre destination finale.

Création d'un itinéraire
1 Sélectionnez Calculateur d'itinéraire > Créer un itinéraire 

> Sélectionnez 1er point.
2 Sélectionnez une catégorie.
3 Sélectionnez le premier point de l'itinéraire.
4 Sélectionnez Utiliser.
5 Sélectionnez Sélectionnez point suivant pour ajouter des 

points supplémentaires à l'itinéraire.
6 Sélectionnez back pour enregistrer l'itinéraire.

Affichage d'un itinéraire sur la carte
1 Sélectionnez Calculateur d'itinéraire.
2 Sélectionnez un itinéraire.
3 Sélectionnez Afficher carte.

Suivi d'un itinéraire enregistré
1 Sélectionnez Où aller ? > Itinéraires.
2 Sélectionnez un itinéraire.
3 Sélectionnez Aller.

Affichage de l'itinéraire actif
1 Lorsque vous suivez un itinéraire, sélectionnez Itinéraire 

actif.
2 Sélectionnez un point de l'itinéraire pour afficher des 

informations supplémentaires.

Modification du nom d'un itinéraire
1 Sélectionnez Calculateur d'itinéraire.
2 Sélectionnez un itinéraire.
3 Sélectionnez Modifier le nom.
4 Entrez le nouveau nom.

Modification d'un itinéraire
1 Sélectionnez Calculateur d'itinéraire.
2 Sélectionnez un itinéraire.
3 Sélectionnez Modifier l'itinéraire.
4 Sélectionnez un point.
5 Sélectionnez une option :

• Pour afficher ce point sur la carte, sélectionnez 
Consulter.
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• Pour modifier l'ordre des points de l'itinéraire, sélectionnez 
Monter ou Descendre.

• Pour insérer un point sur l'itinéraire, sélectionnez Insérer.
Le point supplémentaire est inséré avant le point que vous 
modifiez.

• Pour supprimer le point de l'itinéraire, sélectionnez 
Supprimer.

6 Sélectionnez back pour enregistrer l'itinéraire.

Suppression d'un itinéraire
1 Sélectionnez Calculateur d'itinéraire.
2 Sélectionnez un itinéraire.
3 Sélectionnez Supprimer l'itinéraire.

Inversion d'un itinéraire
Vous pouvez échanger les points de départ et d'arrivée de votre 
itinéraire pour emprunter l'itinéraire à l'envers.
1 Sélectionnez Calculateur d'itinéraire.
2 Sélectionnez un itinéraire.
3 Sélectionnez Inverser l'itinéraire.

Arrêt de la navigation
Sélectionnez Où aller ? > Arrêt navigation.

Tracés
Un tracé représente un enregistrement de votre itinéraire. Le 
journal de suivi contient des informations sur les différents 
points du trajet enregistré, notamment l'heure, la position et 
l'altitude de chaque point. Par défaut, si l'appareil est allumé il 
crée un journal de suivi lorsque vous vous déplacez.

Enregistrement de journaux de suivi
1 Dans le menu principal, sélectionnez Configuration > 

Traces > Journal de suivi.
2 Sélectionnez Enregistrer, masquer ou Enregistrer, afficher 

sur carte.
Si vous sélectionnez Enregistrer, afficher sur carte, une ligne 
indique votre tracé sur la carte.

3 Sélectionnez Méthode d'enregistrement.
4 Sélectionnez une option :

• Pour enregistrer les tracés à une fréquence variable afin 
d'en créer une représentation optimale, sélectionnez 
Automatique.

• Pour enregistrer les tracés à une distance déterminée, 
sélectionnez Distance.

• Pour enregistrer les tracés à un moment déterminé, 
sélectionnez Heure.

5 Sélectionnez Intervalle.
6 Effectuez l'une des actions suivantes :

• Si vous avez sélectionné Automatique comme Méthode 
d'enregistrement, sélectionnez une option pour 
enregistrer les tracés plus ou moins souvent.

REMARQUE : l'option Le plus souvent enregistre le plus 
grand nombre de détails possible sur le tracé, mais sature 
plus rapidement la mémoire de l'appareil.
• Si vous avez sélectionné Distance ou Heure comme 

Méthode d'enregistrement, saisissez une valeur.
Un journal de suivi sera créé tandis que vous vous déplacerez 
avec votre appareil allumé.

Affichage du tracé actuel
1 Sélectionnez Gestionnaire de tracés > Tracé actuel.
2 Sélectionnez une option :

• Pour afficher le tracé actuel sur la carte, sélectionnez 
Afficher carte.

• Pour afficher le profil d'altitude du tracé actuel, 
sélectionnez Profil d'altitude.

Enregistrement du tracé actuel
1 Sélectionnez Gestionnaire de tracés > Tracé actuel.
2 Sélectionner une option :

• Sélectionnez Enregistrer le tracé pour enregistrer la 
totalité du tracé.

• Sélectionnez Enregistrer une partie, puis sélectionnez 
une partie du tracé.

Parcours d'un tracé enregistré
1 Sélectionnez Où aller ? > Traces.
2 Sélectionnez un tracé enregistré.
3 Sélectionnez Aller.

Effacement du tracé actuel
Sélectionnez Gestionnaire de tracés > Tracé actuel > 
Effacer le tracé actuel.

Suppression d'un tracé
1 Sélectionnez Gestionnaire de tracés.
2 Sélectionnez un tracé.
3 Sélectionnez Supprimer.

Paramètres de tracés
Sélectionnez Configuration > Traces.
Journal de suivi : permet d'activer ou de désactiver 

l'enregistrement des tracés.
Méthode d'enregistrement : permet de définir une méthode 

d'enregistrement des tracés. L'option Automatique permet 
d'enregistrer les tracés à une fréquence variable afin de créer 
une représentation optimale de vos tracés.

Intervalle : permet de définir la fréquence d'enregistrement du 
journal de suivi. L'enregistrement plus fréquent de points crée 
un tracé plus détaillé, mais remplit plus rapidement le journal 
de suivi.

Effacer le tracé actuel : permet d'effacer la mémoire des tracés 
actuels.

Configuration avancée > Archivage automatique : permet de 
définir une méthode d'archivage automatique pour organiser 
vos tracés. Ces derniers sont enregistrés et effacés 
automatiquement.

Configuration avancée > Couleur : permet de modifier la 
couleur de la ligne de tracé sur la carte.

Achat de cartes supplémentaires
1 Consultez la page de votre produit sur garmin.com.
2 Cliquez sur l'onglet Cartes.
3 Suivez les instructions présentées à l'écran.

Recherche d'une adresse
Vous pouvez utiliser les cartes City Navigator® en option pour 
rechercher des adresses.
1 Sélectionnez Où aller ? > Adresses.
2 Au besoin, sélectionnez le pays ou l'état.
3 Entrez la ville ou le code postal.

REMARQUE : toutes les données cartographiques n'offrent 
pas la recherche par code postal.

4 Sélectionnez la ville.
5 Entrez le numéro de rue.
6 Entrez le nom de la rue.
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Navigation
Vous pouvez suivre un itinéraire ou un tracé et naviguer jusqu'à 
un waypoint, un trésor ou n'importe quelle position enregistrée 
dans votre appareil. Vous pouvez utiliser la carte ou le compas 
pour naviguer jusqu'à votre destination.

Navigation vers une destination
1 Sélectionnez Où aller ?.
2 Sélectionnez une catégorie.
3 Si besoin, sélectionnez menu > Rechercher saisir le nom, 

puis entrez le nom complet ou partiel de la destination.
4 Sélectionnez une destination.
5 Sélectionnez Aller.

Votre itinéraire apparaît sur la carte sous forme de ligne 
violette.

6 Naviguez à l'aide de la carte (Navigation à l'aide de la carte, 
page 4) ou du compas (Navigation à l'aide du compas, 
page 5).

Navigation à l'aide de Voir & rallier
Vous pouvez pointer l'appareil vers un objet situé à distance, 
verrouiller la direction, puis naviguer vers l'objet.
REMARQUE : la fonction Voir & rallier est uniquement 
disponible sur les appareils de la série eTrex 32x.
1 Sélectionnez Viser et rallier.
2 Pointez l'appareil vers l'objet.
3 Sélectionnez Verrouiller la direction > Définir parcours.
4 Naviguez à l'aide du compas.

Paramètres de cap
Vous pouvez personnaliser les paramètres du compas.
Sélectionnez Configuration > Cap.
Écran : permet de définir le type de cap directionnel figurant sur 

le compas.
Référence nord : permet de définir la référence nord utilisée sur 

le compas.
Ligne Rallier/pointeur : permet de définir le comportement du 

pointeur affiché sur la carte. L'option Relèvement pointe vers 
la direction de votre destination. L'option Route désirée 
affiche votre position en fonction de la ligne d'itinéraire 
menant à votre destination.

Compas : permet de passer automatiquement d'un compas 
électronique à un compas GPS lorsque vous voyagez à une 
vitesse supérieure pendant une période définie.

Étalonner compas : voir Etalonnage du compas, page 5.

Carte
 représente votre position sur la carte. Lors de vos 

déplacements, l'icône  se déplace et établit un journal de suivi 
(tracé). Les noms et les symboles des waypoints apparaissent 
sur la carte. Lorsque vous naviguez vers une destination, votre 
itinéraire est indiqué sur la carte par une ligne colorée.

Navigation à l'aide de la carte
AVIS

Les cartes incluses sur votre appareil vous permettent de créer 
des itinéraires pour piétons ou cyclistes en suivant les routes et 
les chemins, mais pas des itinéraires pour la navigation 
automobile.

1 Commencez à naviguer vers une destination.
2 Sélectionnez Carte.

 représente votre position sur la carte. Une ligne de couleur 
marque votre itinéraire.

3 Effectuez une ou plusieurs des opérations suivantes :
• Utilisez le contrôleur Thumb Stick pour déplacer le curseur 

sur la carte est afficher différentes zones.
• Pour effectuer un zoom avant ou arrière sur la carte, 

sélectionnez  et .

Modification de l'orientation de la carte
1 Sur la carte, sélectionnez menu.
2 Sélectionnez Paramétrage carte > Orientation.
3 Sélectionnez une option :

• Sélectionnez Nord en haut pour afficher le nord en haut 
de la page.

• Sélectionnez Tracé en haut pour afficher votre direction 
actuelle en haut de la page.

• Sélectionnez Mode Automobile pour afficher une 
perspective à utiliser lorsque vous conduisez, avec votre 
direction actuelle orientée vers le haut de la page.

Mesure de distance sur la carte
Vous pouvez mesurer la distance entre deux positions.
1 Sur la carte, sélectionnez une position.
2 Sélectionnez menu > Mesurer distance.
3 Déplacez l'épingle à un autre emplacement sur la carte.

Paramètres de la carte
Sélectionnez Configuration > Carte.
Orientation : permet d'ajuster l'affichage de la carte sur la page. 

L'option Nord en haut affiche le nord en haut de la page. 
L'optionTracé en haut affiche une vue de haut, avec votre 
direction actuelle vers le haut de la page. L'optionMode 
Automobile affiche une vue en 3D à utiliser lorsque vous 
conduisez, avec votre direction actuelle orientée vers le haut 
de la page.

Champs de données : permet de personnaliser les champs de 
données et les tableaux de bord de la carte, du compas, du 
profil d'altitude et du calculateur de voyage.

Configuration avancée page Carte : permet d'accéder aux 
paramètres avancés de la carte (Paramètres de la carte, 
page 4).

Informations cartographiques : permet d'activer ou de 
désactiver les cartes actuellement chargées dans l'appareil.

Paramètres de carte avancés
Sélectionnez Configuration > Carte > Configuration avancée 
page Carte.
Zoom automatique : permet de sélectionner automatiquement 

le niveau de zoom approprié pour une utilisation optimale sur 
votre carte. Lorsque l'option Désactivé est sélectionnée, vous 
devez effectuer un zoom avant ou arrière manuellement.

Niveaux de zoom : permet de définir le niveau de zoom utilisé 
pour l'affichage des éléments sur la carte. Les éléments de la 
carte n'apparaîtront pas lorsque le niveau de zoom de la 
carte est supérieur au niveau choisi.

Taille du texte : permet de sélectionner la taille de texte pour 
les éléments de la carte.

Détail : permet de sélectionner le niveau de détail de la carte. 
L'affichage d'un grand nombre de détails ralentit le tracé de la 
carte.

Relief ombré : permet d'afficher le relief sur la carte (le cas 
échéant) ou de désactiver l'ombrage.

Compas
En cours de navigation,  pointe vers votre destination, quelle 
que soit la direction dans laquelle vous vous dirigez. Quand 
pointe vers le haut du compas électronique, vous voyagez 
directement en direction de votre destination. Si  pointe vers 
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une autre direction, tournez-vous jusqu'à ce que le pointeur 
pointe vers le haut du compas.

Etalonnage du compas
L'appareil dispose d'un compas électronique 3 axes (modèles 
eTrex 32x uniquement). Vous devrez étalonner le compas après 
avoir parcouru de longues distances, après un changement 
important de température ou après avoir changé les piles.
1 Sortez et éloignez-vous de toute interférence éventuelle avec 

le champ magnétique terrestre, qui peut provenir des 
voitures, des bâtiments ou des lignes électriques aériennes.

2 À partir du compas, sélectionnez menu.
3 Sélectionnez Étalonner compas > Démarrer.
4 Suivez les instructions présentées à l'écran.

Navigation à l'aide du compas
Lorsque vous naviguez vers une destination,  pointe vers votre 
destination, quelle que soit la direction dans laquelle vous vous 
dirigez.
1 Démarrez la navigation vers une destination (Navigation vers 

une destination, page 4).
2 Sélectionnez Compas.
3 Tournez-vous jusqu'à ce que le pointeur  pointe vers le haut 

du compas et avancez dans cette direction jusqu'à 
destination.

Pointeur de cap
Le pointeur de cap est particulièrement utile quand vous 
naviguez sur l'eau ou si vous n'avez aucun obstacle important 
sur votre route. Il vous aide aussi à éviter les dangers à 
proximité du parcours, comme des hauts-fonds ou des roches 
submergées.
Pour activer le pointeur de cap, à partir du compas, sélectionnez 
menu > Régler Compas > Ligne Rallier/pointeur > Parcours 
(CDI).

Le pointeur de cap  indique votre position en fonction de la 
ligne d'itinéraire menant à votre destination. L'indicateur de 
déviation de cap (CDI)  indique la déviation (vers la droite ou 
vers la gauche) par rapport au parcours. L'échelle  fait 
référence à la distance entre les points  sur l'indicateur de 
déviation de cap, qui indique le degré de déviation par rapport 
au parcours.

Profil d'altitude
REMARQUE : le profil d'altitude est uniquement disponible sur 
les appareils de la série eTrex 32x.
Par défaut, le profil d'altitude affiche l'altitude en fonction de la 
distance parcourue. Vous pouvez personnaliser les paramètres 
du profil d'altitude (Paramètres du profil d'altitude, page 5). 
Vous pouvez sélectionner n'importe quel point du profil pour 
accéder à des informations sur ce point.

Etalonnage de l'altimètre barométrique
Vous pouvez étalonner manuellement l'altimètre barométrique si 
vous connaissez l'altitude ou la pression barométrique correcte.
1 Allez à un endroit dont vous connaissez l'altitude ou la 

pression barométrique.

2 Sélectionnez Profil d'altitude > menu > Étalonner 
l'altimètre.

3 Suivez les instructions présentées à l'écran.

Paramètres du profil d'altitude
A partir du profil d'altitude, sélectionnez menu.
Modifier le type de tracé : définit le type de données affichées 

sur le profil d'altitude. .
Régler les échelles de zoom : permet de régler les échelles de 

zoom affichées sur la page Altimètre.
Modifier les champs de données : permet de personnaliser les 

champs de données de l'altimètre.
Réinitialiser : réinitialise les données de l'altimètre, y compris 

les waypoints, tracés et données de trajet.
Étalonner l'altimètre : voir (Etalonnage de l'altimètre 

barométrique, page 5).
Restaurer la configuration d'usine : permet de restaurer les 

paramètres d'usine de l'altimètre.

Calculateur de voyage
Le calculateur de voyage affiche votre vitesse actuelle, la 
vitesse moyenne, l'odomètre du trajet, ainsi que d'autres 
statistiques utiles. Vous pouvez personnaliser le calculateur de 
voyage en modifiant le tableau de bord, les champs de données 
et la disposition de la page.

Paramètres du calculateur de voyage
A partir du calculateur de voyage, sélectionnez menu.
Réinitialiser : réinitialise toutes les valeurs du calculateur de 

voyage. Pour obtenir des informations précises, réinitialisez 
les données de trajet avant chaque déplacement.

Grands chiffres : change la taille des chiffres affichés sur la 
page du calculateur de voyage.

Modifier les champs de données : permet de personnaliser les 
champs de données du calculateur de voyage.

Modifier le tableau de bord : change le thème et les 
informations affichés sur le tableau de bord.
REMARQUE : le tableau de bord mémorise vos paramètres 
personnalisés. Vos paramètres ne sont pas perdus lorsque 
vous changez de profil (Profils, page 9).

Restaurer la configuration d'usine : restaure les paramètres 
d'usine du calculateur de voyage.

Restauration des paramètres de page définis 
en usine
1 Ouvrez la page dont vous souhaitez restaurer les 

paramètres.
2 Sélectionnez menu > Restaurer la configuration d'usine.

Fonctions et paramètres du menu 
principal

Chasses au trésor
La chasse au trésor est une activité pendant laquelle les joueurs 
cachent ou cherchent des caches à l'aide d'indices et de 
coordonnées GPS.

Téléchargement des chasses au trésor à l'aide d'un 
ordinateur
Vous pouvez charger manuellement les chasses au trésor sur 
votre appareil à l'aide d'un ordinateur (Transfert des fichiers sur 
votre appareil, page 11). Vous pouvez placer les fichiers de 
chasse au trésor dans un fichier GPX et les importer dans le 
dossier GPX sur l'appareil. L'abonnement Premium à 
geocaching.com vous permet d'utiliser la fonction « Pocket 
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Query » pour charger plusieurs chasses au trésor sur votre 
appareil au format GPX.
1 Connectez l'appareil à votre ordinateur à l'aide d'un câble 

USB.
2 Consultez le site www.geocaching.com.
3 Créez un compte si nécessaire.
4 Connectez-vous.
5 Suivez les instructions de geocaching.com pour rechercher 

et télécharger des chasses au trésor sur votre appareil.

Navigation vers une cache
1 Sélectionnez Chasses au trésor.
2 Sélectionnez une cache.
3 Sélectionnez Aller.
Consignation de la tentative
Vous pouvez consigner les résultats de votre tentative de 
recherche d'un trésor. Vous pouvez consulter certaines chasses 
au trésor sur www.geocaching.com.
1 Sélectionnez Chasses au trésor > Tentative connexion.
2 Sélectionnez Détecté, Introuvable, Réparation requise ou 

Aucune tentative.
3 Sélectionner une option :

• Pour terminer la consignation, sélectionnez Terminé.
• Pour lancer la navigation jusqu'au trésor le plus proche, 

sélectionnez Rechercher prochaine cache.
• Pour entrer un commentaire concernant la recherche du 

trésor ou le trésor lui-même, sélectionnez Ajouter un 
commentaire, entrez un commentaire, puis sélectionnez 
Terminé.

Si vous êtes connecté à www.geocaching.com, le journal est 
automatiquement téléchargé sur votre compte 
www.geocaching.com.

chirp™

Un chirp est un petit accessoire Garmin® qui est programmé et 
laissé en guise de trésor. Vous pouvez utiliser votre appareil 
pour trouver un chirp lors d'une chasse au trésor. Pour plus 
d'informations sur le chirp, consultez le Manuel d'utilisation du 
chirp sur www.garmin.com.
Activation de la recherche chirp
1 Sélectionnez Configuration > Chasses au trésor.
2 Sélectionnez Recherche chirp™ > Activé.

Envoi et réception de données sans fil
Pour partager des données sans fil, vous devez vous trouver à 
moins de 3 m (10 pieds) d'un appareil compatible.
S'il est couplé à un autre appareil compatible ou à un 
smartphone, votre appareil peut envoyer et recevoir des 
données à l'aide de la technologie ANT+® sans fil. Vous pouvez 
partager des waypoints, des chasses au trésor, des itinéraires et 
des tracés.
REMARQUE : cette fonction n'est pas disponible sur tous les 
modèles.
1 Sélectionnez Partage sans fil.
2 Sélectionnez une option :

• Sélectionnez Envoyer, puis sélectionnez un type de 
données.

• Sélectionnez Réception pour recevoir des données d'un 
autre appareil. Pour cela, l'autre appareil compatible doit 
tenter d'envoyer des données.

3 Suivez les instructions présentées à l'écran.

Configuration d'une alarme de proximité
Les alarmes de proximité vous alertent lorsque vous vous 
trouvez à une distance donnée d'une certaine position.
1 Sélectionnez Alarmes de proximité > Créer une alarme.
2 Sélectionnez une catégorie.
3 Sélectionnez une position.
4 Sélectionnez Utiliser.
5 Entrez un rayon.
Lorsque vous pénétrez dans une zone avec une alarme de 
proximité, l'appareil émet une tonalité.

Calcul de la taille d'une zone
1 Sélectionnez Calcul de zone > Démarrer.
2 Délimitez en marchant le périmètre de la zone à calculer.
3 Lorsque vous avez terminé, sélectionnez Calculer.

Page Satellite
La page Satellite indique votre position actuelle, la précision 
GPS, l'emplacement des satellites, ainsi que la force du signal.

Paramètres de satellite GPS
Sélectionnez Satellite > menu.
REMARQUE : certains paramètres sont uniquement disponibles 
lorsque le mode Utiliser GPS éteint est activé.
Utiliser GPS éteint : vous permet de désactiver le GPS.
Utiliser GPS allumé : vous permet d'activer le GPS.
Tracé en haut : indique si les anneaux de satellites sont 

orientés avec le nord vers le haut de l'écran ou avec votre 
tracé actuel en haut de l'écran.

Une couleur : permet de choisir si la page de satellite doit être 
affichée en multicolore ou en monochrome.

Définir position sur carte : vous permet de marquer votre 
position actuelle sur la carte. Vous pouvez utiliser cette 
position pour créer des itinéraires ou rechercher des 
positions enregistrées.

Position AutoLocate : calcule votre position GPS à l'aide de la 
fonction Garmin AutoLocate®.

Garmin Aventures
Vous pouvez regrouper des éléments sous forme d'aventure. 
Par exemple, vous pouvez créer une aventure retraçant votre 
dernière randonnée. Elle contiendrait le journal de suivi du trajet, 
des photos de la randonnée et les chasses au trésor auxquelles 
vous avez participé. Vous pouvez utiliser le logiciel BaseCamp™

pour créer et gérer vos aventures.
REMARQUE : BaseCamp n'est pas disponible sur tous les 
modèles.

Envoi de fichiers vers BaseCamp
1 Ouvrez BaseCamp.
2 Connectez l'appareil à votre ordinateur.

Sur les ordinateurs Windows®, l'appareil apparaît en tant que 
lecteur amovible ou en tant qu'appareil portable, et la carte 
mémoire peut apparaître en tant que deuxième lecteur 
amovible. Sur les ordinateurs Mac®, l'appareil et la carte 
mémoire apparaissent en tant que volumes installés.
REMARQUE : les lecteurs de l'appareil peuvent ne pas 
s'afficher sur certains ordinateurs comprenant plusieurs 
lecteurs réseau. Reportez-vous à la documentation du 
système d'exploitation pour savoir comment mapper le 
lecteur.

3 Ouvrez le lecteur/volume de carte mémoire ou le lecteur/
volume Garmin.
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4 Sélectionnez une option :
• Sélectionnez un élément présent sur un appareil connecté 

et faites-le glisser vers Ma collection ou vers une liste.
• Dans BaseCamp, sélectionnez Appareil > Recevoir de 

l'appareil, puis sélectionnez l'appareil.

Création d'une aventure
Pour créer une aventure et l'envoyer vers votre appareil, vous 
devez télécharger le logiciel BaseCamp sur votre ordinateur et 
transférer un tracé à partir de votre appareil vers votre 
ordinateur (Envoi de fichiers vers BaseCamp, page 6).
1 Ouvrez BaseCamp.
2 Sélectionnez Fichier > Nouveau > Aventure Garmin.
3 Sélectionnez un tracé, puis sélectionnez Suivant.
4 Si nécessaire, ajoutez des éléments à partir de BaseCamp.
5 Remplissez les champs requis pour donner un nom et une 

description à l'aventure.
6 Si vous voulez modifier la photo de couverture pour 

l'aventure, sélectionnez Modifier, puis sélectionnez une 
photo différente.

7 Sélectionnez Terminer.

Début d'une aventure
Pour débuter une aventure, vous devez en envoyer une à partir 
du logiciel BaseCamp vers votre appareil (Envoi de fichiers vers 
BaseCamp, page 6).
1 Sélectionnez Aventures.
2 Sélectionnez une aventure.
3 Sélectionnez Démarrer.

VIRB®Télécommande
REMARQUE : la fonction Télécommande VIRB est uniquement 
disponible sur les appareils de la série eTrex 32x.
Avant de pouvoir utiliser la fonction Télécommande VIRB, vous 
devez activer les paramètres de télécommande sur votre 
caméra VIRB.
La fonction Télécommande VIRB vous permet de commander 
votre caméra VIRB à distance.
1 Sélectionnez Télécommande VIRB.
2 Sélectionnez une option :

• Sélectionnez REC pour enregistrer une vidéo.
• Sélectionnez Prendre une photo pour prendre une photo.

Outils supplémentaires du menu principal
Réveil : définit une alarme sonore. Vous pouvez régler l'appareil 

de manière à ce qu'il s'allume à une heure déterminée, si 
toutefois il n'est pas déjà allumé.

Calculatrice : affiche une calculatrice.
Calendrier : affiche un calendrier.
Chasse et pêche : affiche les meilleures dates et heures de 

chasse et de pêche pour votre position actuelle.
Chronomètre : permet d'utiliser un chronomètre, marquer un 

circuit et chronométrer un circuit.
Soleil et lune : affiche les heures de lever et coucher du soleil, 

ainsi que la phase de lune, suivant votre position GPS.

Personnalisation de l'appareil
Réglage de la luminosité du rétroéclairage
L'utilisation prolongée du rétroéclairage réduit considérablement 
la durée de vie des piles. Vous pouvez régler la luminosité du 
rétroéclairage afin d'optimiser l'autonomie de la batterie.

REMARQUE : la luminosité du rétroéclairage peut être limitée 
lorsque le niveau de charge des piles est faible.
1 Sélectionnez .
2 Utilisez le curseur pour régler l'intensité du rétroéclairage.
L'appareil peut chauffer lorsque le paramètre de rétroéclairage 
est élevé.

Personnalisation du menu principal
Vous pouvez déplacer, ajouter et supprimer des éléments du 
menu principal.
1 Dans le menu principal, sélectionnez menu > Modifier 

l'ordre.
2 Sélectionnez un élément du menu.
3 Sélectionnez une option :

• Sélectionnez Déplacer pour modifier l'emplacement d'un 
élément dans la liste.

• Sélectionnez Insérer pour ajouter un élément à la liste.
• Sélectionnez Supprimer pour supprimer un élément de la 

liste.

Modification de la séquence de page
Pour pouvoir modifier l'ordre de la séquence de pages, vous 
devez ajouter des pages à la séquence.
1 Sélectionnez Configuration > Séquence de pages.
2 Sélectionnez une page.
3 Sélectionnez Déplacer.
4 Montez ou descendez la page dans la liste.
5 Appuyez sur le contrôleur Thumb Stick.

Ajout d'une page
1 Sélectionnez Configuration > Séquence de pages.
2 Sélectionnez Ajouter page.
3 Sélectionnez la page à ajouter.

Suppression d'une page
1 Sélectionnez Configuration > Séquence de pages.
2 Sélectionnez une page.
3 Sélectionnez Supprimer.
4 Appuyez sur le contrôleur Thumb Stick.

Personnalisation des champs de données
Les champs de données de chaque page principale peuvent 
être personnalisés.
1 Ouvrez la page dont vous souhaitez modifier les champs de 

données.
2 Sélectionnez menu.
3 Sélectionnez Modifier les champs de données.
4 Sélectionnez le nouveau champ de données.
5 Suivez les instructions présentées à l'écran.

Champs de données
Certains champs de données affichent uniquement des données 
lorsque vous naviguez ou lorsque vous utilisez des accessoires 
ANT+.
Altitude : altitude de votre position actuelle au-dessus ou au-

dessous du niveau de la mer.
Altitude au-dessus du niveau de la mer : altitude de votre 

position actuelle (si la carte contient des informations 
d'altitude suffisantes).

Altitude - Maximum : altitude la plus haute atteinte depuis la 
dernière réinitialisation.
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Altitude - Minimum : altitude la plus basse atteinte depuis la 
dernière réinitialisation.

Ascension - Maximum : vitesse de montée maximale en pieds 
par minute ou mètres par minute depuis la dernière 
réinitialisation.

Ascension - Moyenne : distance verticale moyenne 
d'ascension depuis la dernière réinitialisation.

Ascension - Totale : distance verticale totale parcourue en 
montant depuis la dernière réinitialisation.

Baromètre : pression actuelle étalonnée.
Cadence : nombre de tours de manivelle ou nombre de foulées 

par minute. Ces données apparaissent quand votre appareil 
est connecté à un capteur de cadence.

Cap : direction que vous suivez.
Cap compas : direction vers laquelle vous vous dirigez selon le 

compas.
Chronomètre : temps du chronomètre pour l'activité en cours.
Chronomètre alarme : heure actuelle du compte à rebours.
Circuit en cours : temps du chronomètre pour le circuit en 

cours.
Circuit moyen : durée moyenne du circuit pour l'activité en 

cours.
Circuits : nombre de circuits réalisés pour l'activité actuelle.
Circuit total : temps du chronomètre pour tous les circuits 

effectués.
Coucher du soleil : heure du coucher de soleil en fonction de 

votre position GPS.
Date : jour, mois et année en cours.
Dénivelé jusqu'au point de destination : altitude entre votre 

position actuelle et votre destination finale. Ces données 
apparaissent lorsqu'une navigation est en cours.

Descente - Maximum : vitesse de descente maximale en pieds 
par minute ou mètres par minute depuis la dernière 
réinitialisation.

Descente - Moyenne : distance verticale moyenne de descente 
depuis la dernière réinitialisation.

Descente - Totale : distance verticale totale parcourue en 
descendant depuis la dernière réinitialisation.

Distance à destination : distance restant à parcourir jusqu'à la 
destination finale. Ces données apparaissent lorsqu'une 
navigation est en cours.

Distance au suivant : distance restant à parcourir jusqu'au 
prochain waypoint de votre itinéraire. Ces données 
apparaissent lorsqu'une navigation est en cours.

Distance circuit : distance parcourue pour le circuit en cours.
Distance du trajet : distance parcourue pour le tracé actuel.
Ecart route : distance vers la gauche ou la droite de laquelle 

vous vous êtes écarté de votre itinéraire. Ces données 
apparaissent lorsqu'une navigation est en cours.

ETA à destination : estimation de l'heure à laquelle vous 
atteindrez la destination finale (ajustée sur l'heure locale de 
la destination). Ces données apparaissent lorsqu'une 
navigation est en cours.

ETA au suivant : estimation de l'heure à laquelle vous 
atteindrez le prochain waypoint sur l'itinéraire (ajustée sur 
l'heure locale du waypoint). Ces données apparaissent 
lorsqu'une navigation est en cours.

Fréquence cardiaque : fréquence cardiaque en battements par 
minute (bpm). Votre appareil doit être connecté à un 
moniteur de fréquence cardiaque compatible.

Heure : heure en fonction de votre position actuelle et de vos 
paramètres d'heure (format, fuseau horaire, heure d'été).

Intensité signal GPS : intensité du signal satellite GPS.

Lever du soleil : heure du lever de soleil en fonction de votre 
position GPS.

Limite de vitesse : limite de vitesse signalée pour la route 
concernée. Disponible uniquement pour certaines cartes et 
zones. Consultez toujours les panneaux de signalisation pour 
connaître les limites de vitesse imposées.

Niveau pile : énergie restante.
Odomètre : compte de la distance parcourue sur l'ensemble 

des trajets. Ce total n'est pas effacé lors de la réinitialisation 
des données de trajet.

Odomètre du trajet : compte de la distance parcourue depuis la 
dernière réinitialisation.

Pointeur : une flèche pointe dans la direction du prochain 
waypoint ou du prochain changement de direction. Ces 
données apparaissent lorsqu'une navigation est en cours.

Position (latitude/longitude) : position actuelle en latitude et en 
longitude, quel que soit le paramètre de format de position 
sélectionné.

Position (sélectionnée) : position actuelle selon le paramètre 
de format de position utilisé.

Position du point de destination : position de votre destination 
finale. Ces données apparaissent lorsqu'une navigation est 
en cours.

Précision GPS : marge d'erreur pour votre position exacte. Par 
exemple, votre position GPS est précise à ± 3,65 m (12 pi).

Pression atmosphérique : pression environnementale non 
étalonnée.

Profondeur : profondeur de l'eau. Votre appareil doit être 
connecté à un appareil NMEA® 0183 ou NMEA 2000® pouvant 
acquérir la profondeur de l'eau.

Relèvement : direction entre votre position actuelle et votre 
destination. Ces données apparaissent lorsqu'une navigation 
est en cours.

Route désirée : direction entre votre position de départ et votre 
destination. Le parcours peut être affiché comme un itinéraire 
planifié ou défini. Ces données apparaissent lorsqu'une 
navigation est en cours.

Taux plané : rapport entre la distance horizontale et la distance 
verticale parcourues.

Taux plané à destination : taux plané nécessaire pour 
descendre de votre position actuelle jusqu'à l'altitude de la 
destination. Ces données apparaissent lorsqu'une navigation 
est en cours.

Température : température de l'air. La température de votre 
corps influe sur la lecture du capteur des températures. Ces 
données apparaissent quand votre appareil est connecté à 
un capteur de température sans fil.

Température - Eau : température de l'eau. Votre appareil doit 
être connecté à un appareil NMEA 0183 pouvant acquérir la 
température de l'eau.

Température maximum sur 24 h : température maximale 
enregistrée au cours des dernières 24 heures. Ces données 
apparaissent quand votre appareil est connecté à un capteur 
de température sans fil.

Température minimum sur 24 h : température minimale 
enregistrée au cours des dernières 24 heures. Ces données 
apparaissent quand votre appareil est connecté à un capteur 
de température sans fil.

Temps à destination : estimation du temps restant pour 
atteindre la destination. Ces données apparaissent 
lorsqu'une navigation est en cours.

Temps au suivant : estimation du temps restant pour atteindre 
le prochain waypoint de votre itinéraire. Ces données 
apparaissent lorsqu'une navigation est en cours.
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Temps dernier circuit : temps du chronomètre pour le dernier 
circuit réalisé.

Temps de trajet - Total : compte du temps total écoulé en 
déplacement et à l'arrêt depuis la dernière réinitialisation.

Temps trajet - Arrêt : compte du temps écoulé à l'arrêt depuis 
la dernière réinitialisation.

Temps trajet - Déplacement : compte du temps écoulé en 
déplacement depuis la dernière réinitialisation.

Tourner : différence d'angle (en degrés) entre le relèvement 
vers votre destination et la direction que vous suivez 
actuellement. L signifie tourner à gauche. R signifie tourner à 
droite. Ces données apparaissent lorsqu'une navigation est 
en cours.

Vers route désirée : direction que vous devez suivre pour 
revenir sur votre itinéraire. Ces données apparaissent 
lorsqu'une navigation est en cours.

Vitesse : vitesse de déplacement actuelle.
Vitesse corrigée : vitesse à laquelle vous vous rapprochez 

d'une destination sur un itinéraire. Ces données apparaissent 
lorsqu'une navigation est en cours.

Vitesse - Maximum : vitesse maximale atteinte depuis la 
dernière réinitialisation.

Vitesse - Moyenne déplacement : vitesse moyenne en 
déplacement depuis la dernière réinitialisation.

Vitesse - Moyenne globale : vitesse moyenne en déplacement 
et à l'arrêt depuis la dernière réinitialisation.

Vitesse verticale : vitesse de montée/descente au fil du temps.
Vitesse verticale à destination : vitesse de montée/descente 

vers une altitude déterminée. Ces données apparaissent 
lorsqu'une navigation est en cours.

Waypoint destination : dernier point sur l'itinéraire avant la 
destination. Ces données apparaissent lorsqu'une navigation 
est en cours.

Waypoint suivant : prochain point sur l'itinéraire. Ces données 
apparaissent lorsqu'une navigation est en cours.

Profils
Les profils sont des ensembles de paramètres qui vous 
permettent d'optimiser le fonctionnement de votre appareil selon 
l'utilisation que vous en faites. Par exemple, les paramètres et 
vues diffèrent selon que vous utilisez l'appareil pour la chasse 
ou une chasse au trésor.
Lorsque vous utilisez un profil et que vous modifiez des 
paramètres tels que des champs de données ou des unités de 
mesure, ceux-ci sont automatiquement enregistrés dans ce 
profil.

Création d'un profil personnalisé
Vous pouvez personnaliser les paramètres et les champs de 
données pour une activité ou un voyage particulier.
1 Sélectionnez Configuration > Profils > Créer profil > OK.
2 Personnalisez vos réglages et vos champs de données.

Sélection d'un profil
Lorsque vous changez d'activité, vous pouvez modifier le 
réglage de l'appareil en changeant de profil.
1 Sélectionnez Changement de profil.
2 Sélectionnez un profil.

Modification du nom d'un profil
1 Sélectionnez Configuration > Profils.
2 Sélectionnez un profil.
3 Sélectionnez Modifier le nom.
4 Saisissez le nouveau nom.

Suppression d'un profil
REMARQUE : avant de pouvoir supprimer le profil actif, vous 
devez activer un profil différent. Vous ne pouvez supprimer un 
profil tant qu'il est actif.
1 Sélectionnez Configuration > Profils.
2 Sélectionnez un profil.
3 Sélectionnez Supprimer.

Paramètres système
Sélectionnez Configuration > Système.
Système satellite : permet de choisir le système satellitaire 

(GPS et autres systèmes de positionnement par satellites, 
page 9).

WAAS/EGNOS : permet au système d'utiliser les données Wide 
Area Augmentation System/European Geostationary 
Navigation Overlay Service (WAAS/EGNOS).

Langue : définit la langue du texte de l'appareil.
REMARQUE : les changements de langue n'ont aucun 
impact sur les données saisies par l'utilisateur ou les 
données cartographiques, telles que les noms de rues.

Type de pile : permet de modifier le type de pile AA que vous 
utilisez.

Mode USB : permet de configurer l'appareil pour utiliser le mode 
de stockage de masse ou le mode Garmin lorsque l'appareil 
est connecté à un ordinateur.

GPS et autres systèmes de positionnement par 
satellites
En utilisant le GPS avec un autre système satellitaire, vous 
pouvez améliorer les performances dans les environnements 
difficiles et acquérir plus rapidement votre position qu'avec 
l'option GPS seule. L'utilisation de plusieurs systèmes peut 
toutefois réduire plus rapidement l'autonomie de la batterie que 
l'utilisation de l'option GPS seule.
Votre appareil peut utiliser ces systèmes de positionnement par 
satellites (GNSS).
GPS : une constellation de satellites créée par les États-Unis.
GLONASS : une constellation de satellites créée par la Russie.

Paramètres d'affichage
Sélectionnez Configuration > Écran.
Temporisation du rétro-éclairage : permet de définir le délai 

au bout duquel le rétroéclairage sera désactivé.
Économie d'énergie : permet d'économiser la batterie et de 

prolonger l'autonomie en éteignant l'écran à expiration du 
délai de rétroéclairage.

Couleurs : permet de modifier l'aspect du fond de l'écran et des 
zones en surbrillance.

Capture d'écran : permet d'enregistrer l'image affichée sur 
l'écran de l'appareil.

Définition des tonalités de l'appareil
Vous pouvez personnaliser les tonalités associées aux 
messages, boutons, avertissements de changement de direction 
et alarmes.
1 Sélectionnez Configuration > Tonalités > Tonalités > 

Activé.
2 Sélectionnez une tonalité pour chaque type de signal sonore.

Modification des unités de mesure
Vous pouvez personnaliser les unités de mesure de distance et 
de vitesse, d'altitude, de profondeur, de température, de 
pression et de vitesse verticale.
1 Sélectionnez Configuration > Unités.
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2 Sélectionnez un type de mesure.
3 Sélectionnez une unité de mesure.

Paramètres de l'heure
Sélectionnez Configuration > Heure.
Format d'heure : permet de définir si vous souhaitez que 

l'heure soit affichée au format 12 heures ou 24 heures sur 
l'appareil.

Fuseau horaire : permet de définir le fuseau horaire de 
l'appareil. L'option Automatique permet de définir le fuseau 
horaire automatiquement en fonction de votre position GPS.

Paramètres de format de position
REMARQUE : il n'est pas recommandé de modifier le système 
de coordonnées du format de position ou du système 
géodésique, sauf si vous utilisez une carte spécifiant un format 
de position différent.
Sélectionnez Configuration > Format de position.
Format de position : permet de définir le format de position 

dans lequel apparaît la lecture d'une position.
Système géodésique : définit le système de coordonnées qui 

structure la carte.
Ellipsoïde de la carte : affiche le système de coordonnées que 

l'appareil utilise. Le système de coordonnées utilisé par 
défaut est WGS 84.

Paramètres de définition d'itinéraires
Les paramètres de définition d'itinéraires disponibles varient 
selon l'activité sélectionnée.
Sélectionnez Configuration > Définition d'itinéraires.
Méthode de guidage : permet de définir les préférences 

d'optimisation pour le calcul d'itinéraires en fonction de la 
distance, de la durée, et d'un itinéraire sur route ou à vol 
d'oiseau.

Calculer itinéraires pour : définit la méthode utilisée pour 
calculer votre itinéraire.

Verrouiller sur route : permet de verrouiller le triangle bleu, qui 
représente votre position sur la carte, sur la route la plus 
proche. Cette option est surtout utile lorsque vous naviguez 
ou roulez sur une route.

Transitions à vol d'oiseau : permet de définir les préférences 
de recalcul quand vous déviez d'un itinéraire actif.

Réglage du contournement : indique les types de routes, 
terrains et moyens de transport à éviter pendant la 
navigation.

Paramètres de l'altimètre
REMARQUE : l'altimètre est uniquement disponible sur les 
appareils de la série eTrex 32x.
Sélectionnez Configuration > Altimètre.
Étalonnage automatique : permet d'étalonner l'altimètre 

automatiquement chaque fois que vous allumez l'appareil.
Mode Baromètre : l'option Altitude variable permet au 

baromètre de mesurer les changements d'altitude tandis que 
vous vous déplacez. L'option Altitude fixe suppose que 
l'appareil est stationnaire à une altitude fixe, la pression 
barométrique n'étant donc censée changer qu'en fonction de 
la météo.

Enregistrement des pressions : permet de définir la façon 
dont l'appareil enregistre les données de pression. 
L'optionEnregistrer toujours enregistre toutes les données de 
pression, ce qui peut être utile lorsque vous recherchez des 
fronts de pression.

Type de tracé : permet d'enregistrer les variations d'altitude sur 
une période ou une distance donnée, la pression 
barométrique ou les changements de pression 
atmosphérique sur une période donnée.

Étalonner l'altimètre : permet d'étalonner l'altimètre.

Paramètres du mode Marine
Sélectionnez Configuration > Marine.
Mode carte marine : permet de définir le type de carte utilisé 

par l'appareil pour afficher les données marines. L'option 
Nautique affiche différentes fonctions de carte en différentes 
couleurs, de manière à améliorer la lisibilité des points 
d'intérêt marins. La carte se rapproche alors des dessins des 
cartes papier. L'option En pêche (nécessite des cartes 
marines) affiche une vue détaillée des contours inférieurs et 
des sondages de profondeur. La présentation de la carte est 
simplifiée pour une utilisation optimale en pêche.

Aspect : permet de définir l'aspect des aides à la navigation 
marine sur la carte.

Configuration de l'alarme marine : permet de définir des 
alarmes qui se déclenchent lorsque vous dépassez une 
certaine distance de dérive au mouillage, lorsque vous vous 
écartez de votre itinéraire d'une certaine distance ou lorsque 
vous entrez dans des eaux d'une profondeur donnée.

Configuration des alarmes marines
1 Sélectionnez Configuration > Marine > Configuration de 

l'alarme marine.
2 Sélectionnez un type d'alarme.
3 Sélectionnez Activé.
4 Saisissez une distance, puis sélectionnez Aller

Réinitialisation des données
Vous pouvez réinitialiser les données de trajet, supprimer tous 
les waypoints, effacer le tracé actuel ou restaurer les valeurs 
définies en usine.
1 Sélectionnez Configuration > Réinitialiser.
2 Sélectionnez un élément à réinitialiser.

Informations sur l'appareil
Mises à jour produit
Sur votre ordinateur, installez Garmin Express™

(www.garmin.com/express). Sur votre smartphone, installez 
l'application Garmin Connect™.
Ceci vous permet d'accéder facilement aux services suivants 
pour les appareils Garmin :
• Mises à jour logicielles
• Mises à jour cartographiques
• Téléchargements de données sur Garmin Connect
• Enregistrement du produit

Configuration de Garmin Express
1 Connectez l'appareil à votre ordinateur à l'aide d'un câble 

USB.
2 Rendez-vous sur garmin.com/express.
3 Suivez les instructions présentées à l'écran.

Enregistrement de l'appareil
Aidez-nous à mieux vous servir en remplissant dès aujourd'hui 
notre formulaire d'enregistrement en ligne. Conservez en lieu 
sûr l'original de la facture ou une photocopie.
1 Visiter le site garmin.com/express.
2 Connectez-vous à votre compte Garmin.
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Affichage des informations légales et de 
conformité relatives à l'étiquetage 
électronique
L'étiquette de l'appareil est fournie sous forme électronique. 
L'étiquette électronique peut contenir des informations légales, 
comme les numéros d'identification fournis par la FCC ou des 
marques de conformité régionales, ainsi que des informations 
relatives au produit et à sa licence.
1 Sélectionnez Configuration.
2 Sélectionnez À propos de.

Entretien du
AVIS

Evitez d'utiliser des nettoyants chimiques, des solvants ou des 
répulsifs contre les insectes pouvant endommager les parties en 
plastique et les finitions.
Pour éviter tout dommage permanent, ne conservez pas 
l'appareil à un endroit où il pourrait être exposé de manière 
prolongée à des températures extrêmes.
Cet appareil est étanche, conformément à la 
norme IEC 60529 IPX7. Il peut résister à une immersion 
accidentelle dans l'eau à un mètre de profondeur pendant 
30 minutes. Une immersion prolongée risquerait d'endommager 
l'appareil. Après immersion, essuyez l'appareil et laissez-le 
sécher à l'air libre avant de l'utiliser ou de le recharger.
Rincez soigneusement l'appareil à l'eau claire après chaque 
utilisation dans l'eau chlorée ou salée.

Nettoyage de l'appareil
AVIS

La moindre particule de sueur ou de moisissure peut entraîner 
la corrosion des contacts électriques lorsqu'ils sont connectés à 
un chargeur. La corrosion peut empêcher le chargement et le 
transfert de données.

1 Nettoyez l'appareil à l'aide d'un chiffon humecté d'un 
détergent non abrasif.

2 Essuyez l'appareil.
Après le nettoyage, laissez bien sécher l'appareil.

Gestion de données
Vous pouvez stocker des fichiers sur votre appareil. L'appareil 
est muni d'un lecteur de carte mémoire permettant de stocker 
davantage de données.
REMARQUE : l'appareil est compatible avec Windows 7 et 
versions supérieures ainsi qu'avec Mac OS 10.4 et versions 
supérieures.

Installation d'une carte mémoire

 AVERTISSEMENT
N'utilisez pas d'objet pointu pour retirer les batteries 
remplaçables par l'utilisateur.

Vous pouvez installer une carte mémoire microSD® dans 
l'appareil portable pour disposer d'un espace de stockage 
supplémentaire ou pour stocker les cartes préchargées.
1 Tournez l'anneau en D dans le sens inverse des aiguilles 

d'une montre, puis soulevez-le pour retirer le cache.
2 Retirez les piles.
3 Faites glisser le support de carte vers la gauche et soulevez-

le.

4 Placez la carte mémoire dans l'appareil, les contacts dorés 
orientés vers le bas.

5 Fermez le support de carte.
6 Faites glisser le support de carte vers la droite pour le 

verrouiller.
7 Remettez en place les piles et le cache du compartiment.

Connexion de l'appareil à un ordinateur
AVIS

Pour éviter tout risque de corrosion, essuyez soigneusement le 
port USB, le capuchon étanche et la surface environnante avant 
de charger l'appareil ou de le connecter à un ordinateur.

Avant de pouvoir utiliser votre appareil sur un ordinateur, vous 
devez installer des piles. Le port USB de l'ordinateur peut fournir 
une alimentation insuffisante pour le fonctionnement de 
l'appareil.
1 Retirez le capuchon étanche du port mini-USB.
2 Branchez la petite extrémité du câble USB sur le port mini-

USB.
3 Branchez la grande extrémité du câble USB sur le port USB 

d'un ordinateur.
Sur les ordinateurs Windows, l'appareil s'affiche en tant que 
lecteur amovible ou appareil portable et la carte mémoire 
peut s'afficher en tant que deuxième lecteur amovible. Sur 
les ordinateurs Mac, l'appareil et la carte mémoire s'affichent 
comme des volumes installés.

Transfert des fichiers sur votre appareil
1 Connectez l'appareil à votre ordinateur.

Sur les ordinateurs Windows, l'appareil s'affiche en tant que 
lecteur amovible ou appareil portable et la carte mémoire 
peut s'afficher en tant que deuxième lecteur amovible. Sur 
les ordinateurs Mac, l'appareil et la carte mémoire s'affichent 
comme des volumes installés.
REMARQUE : les lecteurs de l'appareil peuvent ne pas 
s'afficher correctement sur certains ordinateurs comprenant 
plusieurs lecteurs réseau. Reportez-vous à la documentation 
de votre système d'exploitation pour savoir comment mapper 
le lecteur.

2 Sur votre ordinateur, ouvrez le gestionnaire de fichiers.
3 Sélectionnez un fichier.
4 Sélectionnez Edition > Copier.
5 Ouvrez l'appareil portable, le lecteur ou le volume de 

l'appareil ou de la carte mémoire.
6 Naviguez jusqu'à un dossier.
7 Sélectionnez Edition > Coller.

Le fichier apparaît dans la liste des fichiers présents dans la 
mémoire de l'appareil ou sur la carte mémoire.

Suppression de fichiers
AVIS

Si vous avez des doutes sur la fonction d'un fichier, ne le 
supprimez pas. La mémoire de l'appareil contient des fichiers 
système importants que vous ne devez pas supprimer.

1 Ouvrez le lecteur ou volume Garmin.
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2 Le cas échéant, ouvrez un dossier ou un volume.
3 Sélectionnez un fichier.
4 Appuyez sur la touche Supprimer de votre clavier.

REMARQUE : si vous utilisez un ordinateur Apple®, vous 
devez vider la corbeille pour supprimer complètement les 
fichiers.

Déconnexion du câble USB
Si votre appareil est connecté à votre ordinateur en tant que 
volume ou lecteur amovible, déconnectez votre appareil de 
votre ordinateur en toute sécurité, afin d'éviter toute perte de 
données. Si votre appareil est connecté à votre ordinateur 
Windows en tant qu'appareil portable, il n'est pas nécessaire de 
déconnecter l'appareil en toute sécurité.
1 Effectuez l'une des actions suivantes :

• Sur un ordinateur sous Windows, sélectionnez l'icône 
Retirer le périphérique en toute sécurité dans la barre 
d'état système, puis sélectionnez votre appareil.

• Pour les ordinateurs Apple, sélectionnez l'appareil, puis 
Fichier > Ejecter.

2 Débranchez le câble de l'ordinateur.

Caractéristiques
Plage de températures de fonctionne-
ment

De -20 à 70 °C (de -4 à 158 °F)

Fréquence/Protocole sans fil 2,4 GHz à -1,13 dBm nominal

Annexe
Accessoires en option
Les accessoires en option, tels que les supports, les cartes, les 
accessoires de sport et les pièces de rechange, sont disponibles 
sur http://buy.garmin.com ou auprès de votre revendeur Garmin.

Couplage des capteurs ANT+
Pour pouvoir effectuer un couplage, vous devez installer le 
moniteur de fréquence cardiaque ou le capteur.
Le couplage est la connexion de capteurs ANT+ sans fil, par 
exemple, la connexion d'un moniteur de fréquence cardiaque à 
votre appareil .
1 Approchez l'appareil à moins de 3 m (10 pi) du capteur.

REMARQUE : tenez-vous à au moins 10 m (30 pi) d'autres 
capteurs ANT+ pendant le couplage.

2 Dans l'arborescence des applications, sélectionnez 
Configuration > Capteur ANT.

3 Sélectionnez votre capteur.
4 Sélectionnez Chercher nouveau.

Lorsque le capteur est couplé avec votre appareil, l'état du 
capteur passe de Recherche en cours à Connecté.

Astuces pour coupler des accessoiresANT+ avec 
votre appareil Garmin
• Vérifiez que l'accessoire ANT+ est compatible avec votre 

appareil Garmin.
• Avant de coupler l'accessoire ANT+ avec votre appareil 

Garmin, éloignez-vous de 10 m (33 pieds) des autres 
accessoires ANT+.

• Approchez l'appareil Garmin à moins de 3 m (10 pieds) de 
l'accessoire ANT+.

• Après le premier couplage, votre appareil Garmin reconnaît 
automatiquement l'accessoire ANT+ à chaque fois qu'il est 
activé. Ce processus est automatique lorsque vous allumez 
l'appareil Garmin et prend seulement quelques secondes 

lorsque les accessoires sont activés et fonctionnent 
correctement.

• Une fois couplé, votre appareil Garmin ne reçoit plus que les 
données de votre accessoire, même si vous êtes proche 
d'autres accessoires.

Dépannage
Redémarrage de l'appareil
Si l'appareil ne répond plus, il peut être nécessaire de le 
redémarrer. Cette opération n'efface aucune donnée ou 
paramètre.
1 Retirez les piles.
2 Réinstallez les piles.

Restauration de tous les paramètres par défaut
Vous pouvez réinitialiser tous les paramètres afin de restaurer 
les paramètres par défaut.

Sélectionnez Configuration > Réinitialiser > Réinitialiser 
tous les paramètres > Oui.

Centre d'assistance Garmin
Rendez-vous sur support.garmin.com pour obtenir de l'aide et 
des informations, et accéder aux manuels des produits, aux 
questions fréquentes, à des vidéos et à l'assistance client.
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Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

Zoom keys. Press to zoom in and out.

Back key. Press to return to the previous menu.

Thumb Stick™controller. Move directionally to scroll or highlight an 
item. Press to select an item.
Menu key. Press to open the menu for a page. Press twice to return 
to the main menu.

 Press to adjust the backlight. Hold to turn the device on or off.

Mini-USB port (under weather cap).

Battery cover.

Battery cover locking ring.

Mounting spine.

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Installing AA Batteries
The handheld device operates on two AA batteries (not 
included). Use NiMH or lithium batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
Selecting the Battery Type
1 From the main menu, select Setup > System > Battery 

Type.
2 Select Alkaline, Lithium, or Rechargeable NiMH.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 6).
• Reduce the backlight timeout (Display Settings, page 8).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Map Settings, page 4).
• Turn off GLONASS (GPS and Other Satellite Systems, 

page 8).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

Select Setup > Display > Battery Save > On.
In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen, and you can 
double tap  to view the status page.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Turning On the Device
Hold .

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your location.
 shows the satellite signal strength.

Turning On the Backlight
Select any key to turn on the backlight.
The backlight turns on automatically when alerts and 
messages are displayed.

Opening the Main Menu
The main menu gives you access to tools and setup screens for 
waypoints, activities, routes, and more (Additional Main Menu 
Tools, page 6).

From any page, select menu twice.

Waypoints, Routes, and Tracks
Where To? Menu
You can use the Where To? menu to find a destination to 
navigate to. Not all Where To? categories are available in all 
areas and maps.

Finding a Location Near Another Location
1 Select Where To? > menu > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been. You can add details about the location, 
such as name, elevation, and depth.

Introduction 1



You can add a .gpx file that contains waypoints by transferring 
the file to the GPX folder (Transferring Files to Your Device, 
page 10).

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to make changes to the waypoint.
3 Select Done.

Projecting a Waypoint
You can create a new location by projecting the distance and 
bearing from a marked location to a new location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select menu > Project Waypoint.
4 Enter the bearing, and select Done.
5 Select a unit of measure.
6 Enter the distance, and select Done.
7 Select Save.

Navigating to a Waypoint
1 Select Where To? > Waypoints.
2 Select a waypoint.
3 Select Go.

Finding a Location by Name
1 Select Where To? > Waypoints > menu > Spell Search.
2 Enter the name or part of the name.
3 Select Go.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select Go.

Deleting a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select menu > Delete.

Waypoint Averaging
You can refine a waypoint location for more accuracy. When 
averaging, the device takes several readings at the same 
location and uses the average value to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select menu > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Routes
A route is a sequence of waypoints or locations that leads you to 
your final destination.

Creating a Route
1 Select Route Planner > Create Route > Select First Point.
2 Select a category.

3 Select the first point in the route.
4 Select Use.
5 Select Select Next Point to add additional points to the 

route.
6 Select back to save the route.

Viewing a Route on the Map
1 Select Route Planner.
2 Select a route.
3 Select View Map.

Navigating a Saved Route
1 Select Where To? > Routes.
2 Select a route.
3 Select Go.

Viewing the Active Route
1 While navigating a route, select Active Route.
2 Select a point in the route to view additional details.

Editing the Name of a Route
1 Select Route Planner.
2 Select a route.
3 Select Change Name.
4 Enter the new name.

Editing a Route
1 Select Route Planner.
2 Select a route.
3 Select Edit Route.
4 Select a point.
5 Select an option:

• To view the point on the map, select Review.
• To change the order of the points on the route, select 

Move Up or Move Down.
• To insert an additional point on the route, select Insert.

The additional point is inserted before the point you are 
editing.

• To remove the point from the route, select Remove.
6 Select back to save the route.

Deleting a Route
1 Select Route Planner.
2 Select a route.
3 Select Delete Route.

Reversing a Route
You can switch the start and end points of your route to navigate 
the route in reverse.
1 Select Route Planner.
2 Select a route.
3 Select Reverse Route.

Stopping Navigation
Select Where To? > Stop Navigation.

Tracks
A track is a recording of your path. The track log contains 
information about points along the recorded path, including time, 
location, and elevation for each point. By default, the device 
creates a track log while you move with the device turned on.

Recording Track Logs
1 From the Main Menu, select Setup > Tracks > Track Log.
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2 Select Record, Do Not Show or Record, Show On Map.
If you select Record, Show On Map, a line on the map 
indicates your track.

3 Select Record Method.
4 Select an option:

• To record tracks at a variable rate that creates an 
optimum representation of your tracks, select Auto.

• To record tracks at a specified distance, select Distance.
• To record tracks at a specified time, select Time.

5 Select Recording Interval.
6 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record tracks more or less often.

NOTE: Using the Most Often interval provides the most track 
detail, but fills up the device memory quicker.
• If you selected Distance or Time for the Record Method, 

enter a value.
As you move with the device turned on, a track log is created.

Viewing the Current Track
1 Select Track Manager > Current Track.
2 Select an option:

• To show the current track on the map, select View Map.
• To show the elevation plot for the current track, select 

Elevation Plot.

Saving the Current Track
1 Select Track Manager > Current Track.
2 Select an option:

• Select Save Track to save the entire track.
• Select Save Portion, and select a portion.

Navigating a Saved Track
1 Select Where To? > Tracks.
2 Select a saved track.
3 Select Go.

Clearing the Current Track
Select Track Manager > Current Track > Clear Current 
Track.

Deleting a Track
1 Select Track Manager.
2 Select a track.
3 Select Delete.

Tracks Settings
Select Setup > Tracks.
Track Log: Turns track recording on or off.
Record Method: Sets a track recording method. Auto records 

the tracks at a variable rate to create an optimum 
representation of your tracks.

Recording Interval: Sets a track log recording rate. Recording 
points more frequently creates a more-detailed track, but fills 
the track log faster.

Clear Current Track: Clears the current track memory.
Advanced Setup > Auto Archive: Sets an automatic archive 

method to organize your tracks. Tracks are saved and 
cleared automatically.

Advanced Setup > Color: Changes the color of the track line 
on the map.

Purchasing Additional Maps
1 Go to your device product page at garmin.com.

2 Click the Maps tab.
3 Follow the on-screen instructions.

Finding an Address
You can use optional City Navigator® maps to search for 
addresses.
1 Select Where To? > Addresses.
2 Select the country or state, if necessary.
3 Enter the city or postal code.

NOTE: Not all map data provides postal code searching.
4 Select the city.
5 Enter the house number.
6 Enter the street.

Navigation
You can navigate to a route, track, waypoint, geocache, or any 
saved location in the device. You can use the map or the 
compass to navigate to your destination.

Navigating to a Destination
1 Select Where To?.
2 Select a category.
3 If necessary, select menu > Spell Search and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.

Your route appears as a magenta line on the map.
6 Navigate using the map (Navigating with the Map, page 4) 

or compass (Navigating with the Compass, page 4).

Navigating with Sight 'N Go
You can point the device at an object in the distance, lock in the 
direction, and navigate to the object.
NOTE: Sight 'N Go is available only with eTrex 32x devices.
1 Select Sight 'N Go.
2 Point the device at an object.
3 Select Lock Direction > Set Course.
4 Navigate using the compass.

Heading Settings
You can customize the compass settings.
Select Setup > Heading.
Display: Sets the type of directional heading shown on the 

compass.
North Reference: Sets the north reference used on the 

compass.
Go To Line/Pointer: Sets the behavior of the pointer that 

appears on the map. Bearing points in the direction of your 
destination. Course shows your relationship to the course line 
leading to the destination.

Compass: Automatically switches from an electronic compass 
to a GPS compass when you are traveling at a higher rate of 
speed for a period of time.

Calibrate Compass: See Calibrating the Compass, page 4.

Map
 represents your location on the map. As you travel,  moves 

and leaves a track log (trail). Waypoint names and symbols 
appear on the map. When you are navigating to a destination, 
your route is marked with a colored line on the map.

Navigation 3
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Navigating with the Map
NOTICE

The maps included on your device can create pedestrian or 
cycling routes using roads and trails, but not routes for 
automobile navigation.

1 Begin navigating to a destination.
2 Select Map.

 represents your location on the map. Your route is marked 
with a colored line.

3 Complete one or more actions:
• Use the Thumb Stick controller to move the cursor on the 

map to view different areas.
• To zoom in and out of the map, select  and .

Changing the Map Orientation
1 From the map, select menu.
2 Select Setup Map > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.

Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select menu > Measure Distance.
3 Move the pin to another location on the map.

Map Settings
Select Setup > Map.
Orientation: Adjusts how the map is shown on the page. North 

Up shows north at the top of the page. Track Up shows a top-
down view with your current direction of travel toward the top 
of the page. Automotive Mode shows an 3D automotive view 
with the direction of travel at the top.

Data Fields: Customizes the data fields and dashboards of the 
map, compass, elevation plot, and trip computer.

Advanced Map Setup: Enables you to open advanced map 
settings (Map Settings, page 4).

Map Information: Enables or disables the maps currently 
loaded on the device.

Advanced Map Settings
Select Setup > Map > Advanced Map Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Zoom Levels: Adjusts the zoom level at which map items will 
appear. The map items will not appear when the map zoom 
level is higher than the selected level.

Text Size: Selects the text size for map items.
Detail: Selects the amount of detail shown on the map. Showing 

more detail may cause the map to redraw more slowly.
Shaded Relief: Shows detail relief on the map (if available) or 

turns off shading.

Compass
When navigating,  points to your destination, regardless of the 
direction you are moving. When  points toward the top of the 
electronic compass, you are traveling directly toward your 
destination. If  points any other direction, turn until it points 
toward the top of the compass.

Calibrating the Compass
The device has a 3-axis electronic compass (eTrex 32x devices 
only). You should calibrate the compass after moving long 
distances, experiencing temperature changes, or changing the 
batteries.
1 Go outside, away from objects that influence magnetic fields, 

such as cars, buildings, or overhead power lines.
2 From the compass, select menu.
3 Select Calibrate Compass > Start.
4 Follow the on-screen instructions.

Navigating with the Compass
When navigating to a destination,  points to your destination, 
regardless of the direction you are moving.
1 Begin navigating to a destination (Navigating to a 

Destination, page 3).
2 Select Compass.
3 Turn until  points toward the top of the compass, and 

continue moving in that direction to the destination.

Course Pointer
The course pointer is most useful when you are navigating on 
water or where there are no major obstacles in your path. It can 
also help you avoid hazards near the course, such as shoals or 
submerged rocks.
To enable the course pointer, from the compass, select menu > 
Setup Heading > Go To Line/Pointer > Course (CDI).

The course pointer  indicates your relationship to the course 
line leading to the destination. The course deviation indicator 
(CDI)  provides the indication of drift (right or left) from the 
course. The scale  refers to the distance between dots  on 
the course deviation indicator, which tell you how far off course 
you are.

Elevation Plot
NOTE: The elevation plot is available only with eTrex 32x 
devices.
By default, the elevation plot displays the elevation over the 
distance traveled. You can customize elevation plot settings 
(Elevation Plot Settings, page 4). You can select any point on 
the plot to view details about that point.

Calibrating the Barometric Altimeter
You can manually calibrate the barometric altimeter if you know 
the correct elevation or the correct barometric pressure.
1 Go to a location where the elevation or barometric pressure 

is known.
2 Select Elevation Plot > menu > Calibrate Altimeter.
3 Follow the on-screen instructions.

Elevation Plot Settings
From the elevation plot, select menu.
Change Plot Type: Sets the type of data shown on the 

elevation plot. .
Adjust Zoom Ranges: Adjusts the zoom ranges shown on the 

altimeter page.
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Change Data Fields: Allows you to customize the altimeter data 
fields.

Reset: Resets the altimeter data, including waypoint, track, and 
trip data.

Calibrate Altimeter: See (Calibrating the Barometric Altimeter, 
page 4).

Restore Defaults: Restores the altimeter to factory default 
settings.

Trip Computer
The trip computer displays your current speed, average speed, 
trip odometer, and other helpful statistics. You can customize 
the trip computer layout, dashboard, and data fields.

Trip Computer Settings
From the trip computer, select menu.
Reset: Resets all the trip computer values to zero. For accurate 

information, reset the trip information before beginning a trip.
Big Numbers: Changes the size of the numbers shown on the 

trip computer page.
Change Data Fields: Customizes the trip computer data fields.
Change Dashboard: Changes the theme and information 

displayed on the dashboard.
NOTE: Your customized settings are remembered by the 
dashboard. Your settings are not lost when you change 
profiles (Profiles, page 8).

Restore Defaults: Restores the trip computer to factory default 
settings.

Restoring Default Page Settings
1 Open a page for which you will restore the settings.
2 Select menu > Restore Defaults.

Main Menu Features and Settings
Geocaches
Geocaching is a treasure hunting activity in which players hide 
or search for hidden caches using clues and GPS coordinates.

Downloading Geocaches Using a Computer
You can load geocaches manually onto your device using a 
computer (Transferring Files to Your Device, page 10). You 
can place the geocache files into a GPX file and import them 
into the GPX folder on the device. With a premium membership 
to geocaching.com, you can use the "pocket query" feature to 
load a large group of geocaches onto your device as a single 
GPX file.
1 Connect the device to your computer using a USB cable.
2 Go to www.geocaching.com.
3 If necessary, create an account.
4 Sign in.
5 Follow the instructions at geocaching.com to find and 

download geocaches to your device.

Navigating to a Geocache
1 Select Geocaches.
2 Select a geocache.
3 Select Go.
Logging the Attempt
After you have attempted to find a geocache, you can log your 
results. You can verify some geocaches at 
www.geocaching.com.
1 Select Geocaches > Log Attempt.

2 Select Found, Did not Find, Needs Repair, or 
Unattempted.

3 Select an option:
• To stop logging, select Done.
• To begin navigation to the geocache nearest you, select 

Find Next Closest.
• To enter a comment about looking for the cache or about 

the cache itself, select Add Comment, enter a comment, 
and select Done.

If you are signed in to www.geocaching.com, the log uploads to 
your www.geocaching.com account automatically.

chirp™

A chirp is a small Garmin® accessory that is programmed and 
left in a geocache. You can use your device to find a chirp in a 
geocache. For more information about the chirp, see the chirp 
Owner's Manual at www.garmin.com.
Enabling chirp Searching
1 Select Setup > Geocaches.
2 Select chirp™ Searching > On.

Sending and Receiving Data Wirelessly
Before you can share data wirelessly, you must be within 10 feet 
(3 m) of a compatible device.
Your device can send and receive data when paired with 
another compatible device or smartphone using ANT+® wireless 
technology. You can share waypoints, geocaches, routes, and 
tracks.
NOTE: This feature is not available for all device models.
1 Select Share Wirelessly.
2 Select an option:

• Select Send, and select a type of data.
• Select Receive to receive data from another device. The 

other compatible device must be attempting to send data.
3 Follow the on-screen instructions.

Setting a Proximity Alarm
Proximity alarms alert you when you are within a specified range 
of a particular location.
1 Select Proximity Alarms > Create Alarm.
2 Select a category.
3 Select a location.
4 Select Use.
5 Enter a radius.
When you enter an area with a proximity alarm, the device 
sounds a tone.

Calculating the Size of an Area
1 Select Area Calculation > Start.
2 Walk around the perimeter of the area you want to calculate.
3 Select Calculate when finished.

Satellite Page
The satellite page shows your current location, GPS accuracy, 
satellite locations, and signal strength.

GPS Satellite Settings
Select Satellite > menu.
NOTE: Some settings are only available when Use Demo Mode 
is enabled.
Use Demo Mode: Allows you to turn the GPS off.
Use Satellite System: Allows you to turn the GPS on.
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Track Up: Indicates whether satellites are shown with rings 
oriented with north toward the top of the screen or oriented 
with your current track toward the top of the screen.

Single Color: Allows you to select whether the satellite page is 
displayed in multicolor or single color.

Set Location On Map: Allows you to mark your current location 
on the map. You can use this location to create routes or 
search for saved locations.

AutoLocate Position: Calculates your GPS position using the 
Garmin AutoLocate® feature.

Garmin Adventures
You can group related items together as an adventure. For 
example, you can create an adventure for your latest hiking trip. 
The adventure could contain the track log of the trip, photos of 
the trip, and geocaches you hunted. You can use BaseCamp™

to create and manage your adventures.
NOTE: BaseCamp is not available for all device models.

Sending Files to BaseCamp
1 Open BaseCamp.
2 Connect the device to your computer.

On Windows® computers, the device appears as a removable 
drive or a portable device, and the memory card may appear 
as a second removable drive. On Mac® computers, the device 
and memory card appear as mounted volumes.
NOTE: Some computers with multiple network drives may not 
display device drives properly. See your operating system 
documentation to learn how to map the drive.

3 Open the Garmin or memory card drive or volume.
4 Select an option:

• Select an item from a connected device and drag it to My 
Collection or to a list.

• From BaseCamp, select Device > Receive from Device, 
and select the device.

Creating an Adventure
Before you can create an adventure and send it to your device, 
you must download BaseCamp to your computer and transfer a 
track from your device to your computer (Sending Files to 
BaseCamp, page 6).
1 Open BaseCamp.
2 Select File > New > Garmin Adventure.
3 Select a track, and select Next.
4 If necessary, add items from BaseCamp.
5 Complete the required fields to name and describe the 

adventure.
6 If you want to change the cover photo for the adventure, 

select Change, and select a different photo.
7 Select Finish.

Starting an Adventure
Before you can start an adventure, you must send an adventure 
from BaseCamp to your device (Sending Files to BaseCamp, 
page 6).
1 Select Adventures.
2 Select an adventure.
3 Select Start.

VIRB® Remote
NOTE: The VIRB Remote feature is available only with eTrex 
32x devices.
Before you can use the VIRB Remote function, you must enable 
the remote setting on your VIRB camera.

The VIRB Remote function allows you to control your VIRB 
camera from a distance.
1 Select VIRB Remote.
2 Select an option:

• Select REC to record video.
• Select Take Photo to take a photograph.

Additional Main Menu Tools
Alarm Clock: Sets an audible alarm. If you are not currently 

using the device, you can set the device to turn on at a 
specific time.

Calculator: Displays a calculator.
Calendar: Displays a calendar.
Hunt and Fish: Displays the predicted best dates and times for 

hunting and fishing at your current location.
Stopwatch: Allows you to use a timer, mark a lap, and time 

laps.
Sun and Moon: Displays sunrise and sunset times, along with 

the moon phase, based on your GPS position.

Customizing the Device
Adjusting the Backlight Brightness
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
battery is low.
1 Select .
2 Use the slider to adjust the backlight level.
The device may feel warm when the backlight setting is high.

Customizing the Main Menu
You can move, add, and delete items in the main menu.
1 From the main menu, select menu > Change Item Order.
2 Select a menu item.
3 Select an option:

• Select Move to change the placement of the item in the 
list.

• Select Insert to add a new item to the list.
• Select Remove to delete an item from the list.

Changing the Page Sequence
Before you can change the order of the page sequence, you 
must add pages to the sequence.
1 Select Setup > Page Sequence.
2 Select a page.
3 Select Move.
4 Move the page up or down in the list.
5 Press the Thumb Stick controller.

Adding a Page
1 Select Setup > Page Sequence.
2 Select Add Page.
3 Select a page to add.

Removing a Page
1 Select Setup > Page Sequence.
2 Select a page.
3 Select Remove.
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4 Press the Thumb Stick controller.

Customizing the Data Fields
You can customize the data fields displayed on each main page.
1 Open the page for which you will change the data fields.
2 Select menu.
3 Select Change Data Fields.
4 Select the new data field.
5 Follow the on-screen instructions.

Data Fields
Some data fields require you to be navigating or require ANT+ 
accessories to display data.
24hr Max Temperature: The maximum temperature recorded in 

the last 24 hours. Your device must be connected to a 
wireless temperature sensor for this data to appear.

24hr Min Temperature: The minimum temperature recorded in 
the last 24 hours. Your device must be connected to a 
wireless temperature sensor for this data to appear.

Accuracy Of GPS: The margin of error for your exact location. 
For example, your GPS location is accurate to within +/- 12 ft. 
(3.65 m).

Alarm Timer: The current time of the countdown timer.
Ambient Pressure: The uncalibrated environmental pressure.
Ascent - Average: The average vertical distance of ascent 

since the last reset.
Ascent - Maximum: The maximum rate of ascent in feet per 

minute or meters per minute since the last reset.
Ascent - Total: The total elevation distance ascended since the 

last reset.
Average Lap: The average lap time for the current activity.
Barometer: The calibrated current pressure.
Battery Level: The remaining battery power.
Bearing: The direction from your current location to a 

destination. You must be navigating for this data to appear.
Cadence: The number of revolutions of the crank arm or 

number of strides per minute. Your device must be 
connected to a cadence accessory for this data to appear.

Compass Heading: The direction you are moving based on the 
compass.

Course: The direction from your starting location to a 
destination. Course can be viewed as a planned or set route. 
You must be navigating for this data to appear.

Current Lap: The stopwatch time for the current lap.
Date: The current day, month, and year.
Depth: The depth of the water. Your device must be connected 

to a NMEA® 0183 or NMEA 2000® device capable of acquiring 
the water depth.

Descent - Average: The average vertical distance of descent 
since the last reset.

Descent - Maximum: The maximum rate of descent in feet per 
minute or meters per minute since the last reset.

Descent - Total: The total elevation distance descended since 
the last reset.

Distance To Destination: The remaining distance to the final 
destination. You must be navigating for this data to appear.

Distance To Next: The remaining distance to the next waypoint 
on the route. You must be navigating for this data to appear.

Elevation: The altitude of your current location above or below 
sea level.

Elevation Above Ground: The altitude of your current location 
above ground level (if maps contain sufficient elevation 
information).

Elevation - Maximum: The highest elevation reached since the 
last reset.

Elevation - Minimum: The lowest elevation reached since the 
last reset.

ETA At Destination: The estimated time of day when you will 
reach the final destination (adjusted to the local time of the 
destination). You must be navigating for this data to appear.

ETA At Next: The estimated time of day when you will reach the 
next waypoint on the route (adjusted to the local time of the 
waypoint). You must be navigating for this data to appear.

Glide Ratio: The ratio of horizontal distance traveled to the 
change in vertical distance.

Glide Ratio To Dest: The glide ratio required to descend from 
your current position to the destination elevation. You must 
be navigating for this data to appear.

GPS Signal Strength: The strength of the GPS satellite signal.
Heading: The direction you are moving.
Heart Rate: Your heart rate in beats per minute (bpm). Your 

device must be connected to a compatible heart rate monitor.
Lap Distance: The distance traveled for the current lap.
Laps: The number of laps completed for the current activity.
Last Lap Time: The stopwatch time for the last completed lap.
Location (lat/lon): The current position in latitude and longitude 

regardless of the selected position format setting.
Location (selected): The current position using the selected 

position format setting.
Location of Destination: The position of your final destination. 

You must be navigating for this data to appear.
Odometer: A running tally of distance traveled for all trips. This 

total does not clear when resetting the trip data.
Off Course: The distance to the left or right by which you have 

strayed from the original path of travel. You must be 
navigating for this data to appear.

Pointer: An arrow points in the direction of the next waypoint or 
turn. You must be navigating for this data to appear.

Speed: The current rate of travel.
Speed Limit: The reported speed limit for the road. Not 

available in all maps and in all areas. Always rely on posted 
road signs for actual speed limits.

Speed - Maximum: The highest speed reached since the last 
reset.

Speed - Moving Avg.: The average speed while moving since 
the last reset.

Speed - Overall Avg.: The average speed while moving and 
stopped since the last reset.

Stopwatch Timer: The stopwatch time for the current activity.
Sunrise: The time of sunrise based on your GPS position.
Sunset: The time of sunset based on your GPS position.
Temperature: The temperature of the air. Your body 

temperature affects the temperature sensor. Your device 
must be connected to a wireless temperature sensor for this 
data to appear.

Temperature - Water: The temperature of the water. Your 
device must be connected to a NMEA 0183 device capable 
of acquiring the water temperature.

Time of Day: The current time of day based on your current 
location and time settings (format, time zone, daylight saving 
time).
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Time To Destination: The estimated time remaining before you 
reach the destination. You must be navigating for this data to 
appear.

Time To Next: The estimated time remaining before you reach 
the next waypoint in the route. You must be navigating for 
this data to appear.

To Course: The direction in which you must move to get back 
on the route. You must be navigating for this data to appear.

Total Lap: The stopwatch time for all the completed laps.
Track Distance: The distance traveled for the current track.
Trip Odometer: A running tally of the distance traveled since 

the last reset.
Trip Time: A running tally of the total time spent moving and not 

moving since the last reset.
Trip Time - Moving: A running tally of the time spent moving 

since the last reset.
Trip Time - Stopped: A running tally of the time spent not 

moving since the last reset.
Turn: The angle of difference (in degrees) between the bearing 

to your destination and your current course. L means turn 
left. R means turn right. You must be navigating for this data 
to appear.

Velocity Made Good: The speed at which you are closing on a 
destination along a route. You must be navigating for this 
data to appear.

Vertical Dist to Dest: The elevation distance between your 
current position and the final destination. You must be 
navigating for this data to appear.

Vertical Speed: The rate of ascent or descent over time.
Vertical Speed To Dest: The rate of ascent or descent to a 

predetermined altitude. You must be navigating for this data 
to appear.

Waypoint At Dest: The last point on the route to the 
destination. You must be navigating for this data to appear.

Waypoint At Next: The next point on the route. You must be 
navigating for this data to appear.

Profiles
Profiles are a collection of settings that optimize your device 
based on how you are using it. For example, the settings and 
views are different when you use the device for hunting than 
when geocaching.
When you are using a profile and you change settings, such as 
data fields or units of measurement, the changes are saved 
automatically as part of the profile.

Creating a Custom Profile
You can customize your settings and data fields for a particular 
activity or trip.
1 Select Setup > Profiles > Create Profile > OK.
2 Customize your settings and data fields.

Selecting a Profile
When you change activities, you can change the setup of the 
device by changing the profile.
1 Select Profile Change.
2 Select a profile.

Editing a Profile Name
1 Select Setup > Profiles.
2 Select a profile.
3 Select Edit Name.
4 Enter the new name.

Deleting a Profile
NOTE: Before you can delete the active profile, you must 
activate a different profile. You cannot delete a profile while it is 
active.
1 Select Setup > Profiles.
2 Select a profile.
3 Select Delete.

System Settings
Select Setup > System.
Satellite System: Sets the satellite system (GPS and Other 

Satellite Systems, page 8).
WAAS/EGNOS: Enables the system to use Wide Area 

Augmentation System/European Geostationary Navigation 
Overlay Service (WAAS/EGNOS) data.

Language: Sets the text language on the device.
NOTE: Changing the text language does not change the 
language of user-entered data or map data, such as street 
names.

Battery Type: Allows you to change the type of AA battery you 
are using.

USB Mode: Sets the device to use mass storage mode or 
Garmin mode when connected to a computer.

GPS and Other Satellite Systems
Using GPS and another satellite system together offers 
increased performance in challenging environments and faster 
position acquisition than using GPS only. However, using 
multiple systems can reduce battery life more quickly than using 
GPS only.
Your device can use these Global Navigation Satellite Systems 
(GNSS).
GPS: A satellite constellation built by the United States.
GLONASS: A satellite constellation built by Russia.

Display Settings
Select Setup > Display.
Backlight Timeout: Adjusts the length of time before the 

backlight turns off.
Battery Save: Saves the battery power and prolongs the battery 

life by turning off the screen when the backlight times out.
Colors: Changes the appearance of the display background and 

selection highlight.
Screen Capture: Allows you to save the image on the device 

screen.

Setting the Device Tones
You can customize tones for messages, keys, turn warnings, 
and alarms.
1 Select Setup > Tones > Tones > On.
2 Select a tone for each audible type.

Changing the Units of Measure
You can customize units of measure for distance and speed, 
elevation, depth, temperature, pressure, and vertical speed.
1 Select Setup > Units.
2 Select a measurement type.
3 Select a unit of measure.

Time Settings
Select Setup > Time.
Time Format: Sets the device to show time in a 12-hour or 24-

hour format.
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Time Zone: Sets the time zone for the device. Automatic sets 
the time zone automatically based on your GPS position.

Position Format Settings
NOTE: You should not change the position format or the map 
datum coordinate system unless you are using a map or chart 
that specifies a different position format.
Select Setup > Position Format.
Position Format: Sets the position format in which a location 

reading appears.
Map Datum: Sets the coordinate system on which the map is 

structured.
Map Spheroid: Shows the coordinate system the device is 

using. The default coordinate system is WGS 84.

Routing Settings
The available routing settings vary based on the activity 
selected.
Select Setup > Routing.
Guidance Method: Sets the preference for optimizing route 

calculation based on distance, time, on-road, or off-road 
routing.

Calculate Routes for: Sets the method used to calculate your 
route.

Lock On Road: Locks the blue triangle, which represents your 
position on the map, onto the nearest road. This is most 
useful when driving or navigating on roads.

Off Road Transitions: Sets recalculation preferences when 
navigating away from an active route.

Avoidance Setup: Sets the types of roads, terrain, and 
transportation methods to avoid while navigating.

Altimeter Settings
NOTE: The altimeter is available only with eTrex 32x devices.
Select Setup > Altimeter.
Auto Calibration: Automatically calibrates the altimeter each 

time the device is turned on.
Barometer Mode: Variable Elevation allows the barometer to 

measure changes in elevation while you are moving. Fixed 
Elevation assumes the device is stationary at a fixed 
elevation, so the barometric pressure should only change 
due to weather.

Pressure Trending: Sets how the device records pressure 
data. Save Always records all pressure data, which can be 
helpful when you are watching for pressure fronts.

Plot Type: Records elevation changes over a period of time or 
distance, records barometric pressure over a period of time, 
or records ambient pressure changes over a period of time.

Calibrate Altimeter: Calibrates the altimeter.

Marine Settings
Select Setup > Marine.
Marine Chart Mode: Sets the type of chart the device uses 

when displaying marine data. Nautical displays various map 
features in different colors so the marine POIs are more 
readable and so the map reflects the drawing scheme of 
paper charts. Fishing (requires marine maps) displays a 
detailed view of bottom contours and depth soundings and 
simplifies map presentation for optimal use while fishing.

Appearance: Sets the appearance of marine navigation aids on 
the map.

Marine Alarm Setup: Sets alarms for when you exceed a 
specified drift distance while anchored, when you are off 

course by a specified distance, and when you enter water of 
a specific depth.

Setting Up Marine Alarms
1 Select Setup > Marine > Marine Alarm Setup.
2 Select an alarm type.
3 Select On.
4 Enter a distance, and select Go.

Resetting Data
You can reset trip data, delete all waypoints, clear the current 
track, or restore default values.
1 Select Setup > Reset.
2 Select an item to reset.

Device Information
Product Updates
On your computer, install Garmin Express™ (www.garmin.com
/express). On your smartphone, install the Garmin Connect™

app.
This provides easy access to these services for Garmin devices:
• Software updates
• Map updates
• Data uploads to Garmin Connect
• Product registration

Setting Up Garmin Express
1 Connect the device to your computer using a USB cable.
2 Go to garmin.com/express.
3 Follow the on-screen instructions.

Registering Your Device
Help us better support you by completing our online registration 
today. Keep the original sales receipt, or a photocopy, in a safe 
place.
1 Go to garmin.com/express.
2 Sign in to your Garmin account.

Viewing E-label Regulatory and Compliance 
Information
The label for this device is provided electronically. The e-label 
may provide regulatory information, such as identification 
numbers provided by the FCC or regional compliance markings, 
as well as applicable product and licensing information.
1 Select Setup.
2 Select About.

Device Care
NOTICE

Avoid chemical cleaners, solvents, and insect repellents that can 
damage plastic components and finishes.
Do not store the device where prolonged exposure to extreme 
temperatures can occur, because it can cause permanent 
damage.
The device is water resistant to IEC Standard 60529 IPX7. It can 
withstand accidental immersion in 1 meter of water for 30 
minutes. Prolonged submersion can cause damage to the 
device. After submersion, be certain to wipe dry and air dry the 
device before using or charging.
Thoroughly rinse the device with fresh water after exposure to 
chlorinated or salt water environments.
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Cleaning the Device
NOTICE

Even small amounts of sweat or moisture can cause corrosion 
of the electrical contacts when connected to a charger. 
Corrosion can prevent charging and data transfer.

1 Wipe the device using a cloth dampened with a mild 
detergent solution.

2 Wipe it dry.
After cleaning, allow the device to dry completely.

Data Management
You can store files on your device. The device has a memory 
card slot for additional data storage.
NOTE: The device is compatible with Windows 7 and newer, 
and Mac OS 10.4 and newer.

Installing a Memory Card

 WARNING
Do not use a sharp object to remove user-replaceable batteries.

You can install a microSD® memory card in the handheld device 
for additional storage or pre-loaded maps.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Remove the battery.
3 Slide the card holder to the left and lift up.

4 Place the memory card with the gold contacts facing down.
5 Close the card holder.
6 Slide the card holder to the right to lock it.
7 Replace the battery and cover.

Connecting the Device to Your Computer
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.

Before you can operate your device while connected to your 
computer, you must install batteries. The computer USB port 
may not provide enough power to operate the device.
1 Pull up the weather cap from the mini-USB port.
2 Plug the small end of the USB cable into the mini-USB port.
3 Plug the large end of the USB cable into a computer USB 

port.
On Windows computers, the device appears as a removable 
drive or a portable device, and the memory card may appear 
as a second removable drive. On Mac computers, the device 
and memory card appear as mounted volumes.

Transferring Files to Your Device
1 Connect the device to your computer.

On Windows computers, the device appears as a removable 
drive or a portable device, and the memory card may appear 
as a second removable drive. On Mac computers, the device 
and memory card appear as mounted volumes.

NOTE: Some computers with multiple network drives may not 
display device drives properly. See your operating system 
documentation to learn how to map the drive.

2 On your computer, open the file browser.
3 Select a file.
4 Select Edit > Copy.
5 Open the portable device, drive, or volume for the device or 

memory card.
6 Browse to a folder.
7 Select Edit > Paste.

The file appears in the list of files in the device memory or on 
the memory card.

Deleting Files
NOTICE

If you do not know the purpose of a file, do not delete it. Your 
device memory contains important system files that should not 
be deleted.

1 Open the Garmin drive or volume.
2 If necessary, open a folder or volume.
3 Select a file.
4 Press the Delete key on your keyboard.

NOTE: If you are using an Apple® computer, you must empty 
the Trash folder to completely remove the files.

Disconnecting the USB Cable
If your device is connected to your computer as a removable 
drive or volume, you must safely disconnect your device from 
your computer to avoid data loss. If your device is connected to 
your Windows computer as a portable device, it is not necessary 
to safely disconnect the device.
1 Complete an action:

• For Windows computers, select the Safely Remove 
Hardware icon in the system tray, and select your device.

• For Apple computers, select the device, and select File > 
Eject.

2 Disconnect the cable from your computer.

Specifications
Operating temperature range From -20° to 70°C (from -4° to 158°F)
Wireless frequency/protocol 2.4 GHz @ -1.13 dBm nominal

Appendix
Optional Accessories
Optional accessories, such as mounts, maps, fitness 
accessories, and replacement parts, are available at 
http://buy.garmin.com or from your Garmin dealer.

Pairing Your ANT+ Sensors
Before you can pair, you must put on the heart rate monitor or 
install the sensor.
Pairing is the connecting of ANT+ wireless sensors, for example, 
connecting a heart rate monitor with your device.
1 Bring the device within 3 m (10 ft.) of the sensor.

NOTE: Stay 10 m (30 ft.) away from other ANT+ sensors 
while pairing.

2 From the app drawer, select Setup > ANT Sensor.
3 Select your sensor.
4 Select Search For New.
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When the sensor is paired with your device, the sensor status 
changes from Searching to Connected.

Tips for Pairing ANT+ Accessories with Your Garmin 
Device
• Verify that the ANT+ accessory is compatible with your 

Garmin device.
• Before you pair the ANT+ accessory with your Garmin 

device, move 10 m (33 ft.) away from other ANT+ 
accessories.

• Bring the Garmin device within range 3 m (10 ft.) of the ANT+ 
accessory.

• After you pair the first time, your Garmin device automatically 
recognizes the ANT+ accessory each time it is activated. This 
process occurs automatically when you turn on the Garmin 
device and only takes a few seconds when the accessories 
are activated and functioning correctly.

• When paired, your Garmin device receives data from only 
your accessory, and you can go near other accessories.

Troubleshooting
Restarting the Device
If the device stops responding, you may need to restart it. This 
does not erase any of your data or settings.
1 Remove the batteries.
2 Reinstall the batteries.

Restoring All Default Settings
You can reset all settings back to the factory default settings.

Select Setup > Reset > Reset All Settings > Yes.

Garmin Support Center
Go to support.garmin.com for help and information, such as 
product manuals, frequently asked questions, videos, and 
customer support.
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Einführung
 WARNUNG

Lesen Sie alle Produktwarnungen und sonstigen wichtigen 
Informationen der Anleitung "Wichtige Sicherheits- und 
Produktinformationen", die dem Produkt beiliegt.

Übersicht über das Gerät

Zoomtasten. Drücken Sie die Tasten, um die Ansicht zu vergrößern 
oder zu verkleinern.
Back-Taste. Drücken Sie die Taste, um zum vorherigen Menü 
zurückzukehren.
Thumb Stick™Steuerung. Bewegen Sie sie in verschiedene Rich-
tungen, um Optionen zu durchblättern oder ein Element zu 
markieren. Drücken Sie auf den Knopf, um ein Element auszu-
wählen.
Menu-Taste. Drücken Sie die Taste, um das Menü für eine Seite 
anzuzeigen. Drücken Sie die Taste zweimal, um zum Hauptmenü 
zurückzukehren.

 Drücken Sie die Taste, um die Beleuchtung anzupassen. Halten 
Sie diese Taste gedrückt, um das Gerät ein- oder auszuschalten.
Mini-USB-Anschluss (unter der Schutzkappe).

Akkuabdeckung.

Sicherungsring für die Akkuabdeckung.

Gehäuserückseite.

Informationen zum Akku
 WARNUNG

Der Temperaturbereich des Geräts liegt möglicherweise über 
dem zulässigen Temperaturbereich einiger Batterien. 
Alkalibatterien können bei hohen Temperaturen beschädigt 
werden.

HINWEIS
Alkalibatterien verlieren bei abnehmenden Temperaturen 
zunehmend an Leistung. Verwenden Sie Lithium-Batterien, 
wenn Sie das Gerät bei Minustemperaturen einsetzen.

Einlegen von AA-Batterien
Das Handheld-Gerät wird mit zwei AA-Batterien betrieben (nicht 
im Lieferumfang enthalten). Beste Ergebnisse erzielen Sie mit 
NiMH-Akkus oder Lithium-Batterien.
1 Drehen Sie den D-Ring gegen den Uhrzeigersinn, und ziehen 

Sie ihn nach oben, um die Abdeckung abzunehmen.
2 Legen Sie zwei AA-Batterien ein, und achten Sie dabei auf 

die korrekte Ausrichtung der Pole.

3 Setzen Sie die Batterieabdeckung wieder auf, und drehen 
Sie den D-Ring im Uhrzeigersinn.

Auswählen des Batterietyps
1 Wählen Sie im Hauptmenü die Option Einstellungen > 

System > Batterietyp.
2 Wählen Sie Alkali, Lithium oder NiMH-Akku.

Optimieren der Akku-Laufzeit
Es gibt verschiedene Möglichkeiten, die Batterie-Laufzeit zu 
verlängern.
• Reduzieren Sie die Beleuchtungshelligkeit (Anpassen der 

Helligkeit der Beleuchtung, Seite 7).
• Reduzieren Sie die Display-Beleuchtungszeit 

(Anzeigeeinstellungen, Seite 10).
• Verwenden Sie den Energiesparmodus (Aktivieren des 

Energiesparmodus, Seite 1).
• Verringern Sie die Kartenaufbaugeschwindigkeit 

(Karteneinstellungen, Seite 4).
• Deaktivieren Sie GLONASS (GPS- und andere 

Satellitensysteme, Seite 9).

Aktivieren des Energiesparmodus
Sie können den Energiesparmodus verwenden, um die Batterie-
Laufzeit zu verlängern.

Wählen Sie Einstellungen > Anzeige > Energiesparmodus 
> Ein.

Im Energiesparmodus wird der Bildschirm ausgeschaltet, wenn 
die Beleuchtung ausgeht. Sie können  wählen, um den 
Bildschirm einzuschalten, und Sie können zweimal auf  tippen, 
um die Statusseite anzuzeigen.

Aufbewahrung über einen längeren Zeitraum
Wenn Sie das Gerät voraussichtlich mehrere Monate lang nicht 
verwenden, entfernen Sie die Batterien. Gespeicherte Daten 
bleiben beim Entfernen der Batterien erhalten.

Einschalten des Geräts
Halten Sie  gedrückt.

Erfassen von Satellitensignalen
Das Erfassen von Satellitensignalen kann 30 bis 60 Sekunden 
dauern.
1 Begeben Sie sich im Freien an eine für den Empfang 

geeignete Stelle.
2 Schalten Sie das Gerät gegebenenfalls ein.
3 Warten Sie, während das Gerät nach Satelliten sucht.

Das Symbol  blinkt, während das Gerät die Position 
ermittelt.

 kennzeichnet die Stärke des Satelligensignals.

Einschalten der Hintergrundbeleuchtung
Wählen Sie eine beliebige Taste, um die Displaybeleuchtung 
einzuschalten.
Die Beleuchtung geht automatisch an, wenn Alarme und 
Meldungen angezeigt werden.
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Öffnen des Hauptmenüs
Über das Hauptmenü können Sie auf Extras und 
Einstellungsseiten für Wegpunkte, Aktivitäten, Routen und mehr 
zugreifen (Weitere Extras im Hauptmenü, Seite 7).

Wählen Sie auf einer beliebigen Seite zweimal die Option 
menu.

Wegpunkte, Routen und Tracks
Menü „Zieleingabe“
Sie können das Menü Zieleingabe verwenden, um nach einem 
Ziel zu suchen, zu dem Sie navigieren möchten. Nicht alle 
Kategorien für Zieleingabe sind in allen Gebieten und auf allen 
Karten verfügbar.

Suchen von Positionen in der Nähe anderer 
Positionen
1 Wählen Sie Zieleingabe > menu > Suchen nahe.
2 Wählen Sie eine Option.
3 Wählen Sie einen Favoriten.

Wegpunkte
Wegpunkte sind Positionen, die Sie auf dem Gerät aufzeichnen 
und speichern. Wegpunkte können anzeigen, wo Sie sich 
gerade befinden, wohin Sie sich begeben oder wo Sie waren. 
Sie können Details zur Position eingeben, beispielsweise den 
Namen, die Höhe und die Tiefe.
Sie können eine GPX-Datei mit Wegpunkten hinzufügen, indem 
Sie die Datei in den GPX-Ordner übertragen (Übertragen von 
Dateien auf das Gerät, Seite 11).

Erstellen von Wegpunkten
Sie können die aktuelle Position als Wegpunkt speichern.
1 Wählen Sie Wegpunkt.
2 Wählen Sie bei Bedarf ein Feld aus, um Änderungen am 

Wegpunkt vorzunehmen.
3 Wählen Sie Fertig.

Projizieren von Wegpunkten
Sie können eine neue Position erstellen, indem Sie die Distanz 
und Peilung von einer markierten Position auf eine neue 
Position projizieren.
1 Wählen Sie Wegpunkt-Manager.
2 Wählen Sie einen Wegpunkt.
3 Wählen Sie menu > Wegpunkt-Projektion.
4 Geben Sie die Peilung ein, und wählen Sie Fertig.
5 Wählen Sie eine Maßeinheit.
6 Geben Sie die Distanz ein, und wählen Sie Fertig.
7 Wählen Sie Speichern.

Navigieren zu einem Wegpunkt
1 Wählen Sie Zieleingabe > Wegpunkte.
2 Wählen Sie einen Wegpunkt.
3 Wählen Sie Go.

Suchen von Positionen nach Namen
1 Wählen Sie Zieleingabe > Wegpunkte > menu > 

Suchbegriff eingeben.
2 Geben Sie den Namen oder einen Teil des Namens ein.
3 Wählen Sie Go.

Bearbeiten von Wegpunkten
1 Wählen Sie Wegpunkt-Manager.
2 Wählen Sie einen Wegpunkt.

3 Wählen Sie ein Element aus, das Sie bearbeiten möchten, 
z. B. den Namen.

4 Geben Sie die neuen Informationen ein, und wählen Sie Go.

Löschen von Wegpunkten
1 Wählen Sie Wegpunkt-Manager.
2 Wählen Sie einen Wegpunkt.
3 Wählen Sie menu > Entfernen.

Wegpunkt-Mittelung
Du kannst eine Wegpunktposition genauer festlegen, um die 
Genauigkeit zu erhöhen. Bei der Mittelung wird vom Gerät 
anhand mehrerer Werte an derselben Position ein Mittelwert 
berechnet, um eine bessere Genauigkeit zu erreichen.
1 Wähle Wegpunkt-Manager.
2 Wähle einen Wegpunkt.
3 Wähle menu > Position mitteln.
4 Gehe zur Wegpunktposition.
5 Wähle Start.
6 Folge den Anweisungen auf dem Display.
7 Wenn die Statusleiste für die Messwertgenauigkeit einen 

Status von 100 % erreicht hat, wähle Speichern.
Du erzielst die besten Ergebnisse, wenn du für den Wegpunkt 
vier bis acht Messungen vornimmst und zwischen den 
Messungen mindestens 90 Minuten wartest.

Routen
Eine Route setzt sich aus einer Reihe von Wegpunkten oder 
Positionen zusammen, die zum Endziel führen.

Erstellen von Routen
1 Wählen Sie Routenplaner > Route erstellen > 1. Punkt 

wählen.
2 Wählen Sie eine Kategorie aus.
3 Wählen Sie den ersten Punkt der Route.
4 Wählen Sie Verwenden.
5 Wählen Sie Nächsten Punkt wählen, um der Route weitere 

Punkte hinzuzufügen.
6 Wählen Sie back, um die Route zu speichern.

Anzeigen von Routen auf der Karte
1 Wählen Sie Routenplaner.
2 Wählen Sie eine Route.
3 Wählen Sie Karte anzeigen.

Navigieren einer gespeicherten Route
1 Wählen Sie Zieleingabe > Routen.
2 Wählen Sie eine Route.
3 Wählen Sie Go.

Anzeigen der aktiven Route
1 Wählen Sie während der Navigation einer Route die Option 

Aktive Route.
2 Wählen Sie einen Punkt in der Route, zu dem Sie zusätzliche 

Details anzeigen möchten.

Bearbeiten des Namens einer Route
1 Wählen Sie Routenplaner.
2 Wählen Sie eine Route.
3 Wählen Sie Namen ändern.
4 Geben Sie den neuen Namen ein.

Bearbeiten von Routen
1 Wählen Sie Routenplaner.
2 Wählen Sie eine Route.
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3 Wählen Sie Route bearbeiten.
4 Wählen Sie einen Punkt aus.
5 Wählen Sie eine Option:

• Zeigen Sie den Punkt auf der Karte an, indem Sie Lesen 
wählen.

• Ändern Sie die Reihenfolge der Punkte in der Route, 
indem Sie Nach oben oder Nach unten wählen.

• Fügen Sie einen zusätzlichen Punkt auf der Route ein, 
indem Sie Einfügen wählen.
Der zusätzliche Punkt wird vor dem Punkt eingefügt, den 
Sie gerade bearbeiten.

• Entfernen Sie den Punkt aus der Route, indem Sie 
Entfernen wählen.

6 Wählen Sie back, um die Route zu speichern.

Löschen von Routen
1 Wählen Sie Routenplaner.
2 Wählen Sie eine Route.
3 Wählen Sie Route löschen.

Umkehren von Routen
Sie können die Start- und Endpunkte der Route vertauschen, 
um die Route in umgekehrter Richtung zu navigieren.
1 Wählen Sie Routenplaner.
2 Wählen Sie eine Route.
3 Wählen Sie Route umkehren.

Beenden der Navigation
Wählen Sie Zieleingabe > Navigation anhalten.

Tracks
Ein Track ist eine Aufzeichnung eines Weges. Die 
Trackaufzeichnung enthält Informationen zu Punkten des 
aufgezeichneten Weges, u. a. Uhrzeit, Position und Höhe für 
jeden Punkt. Das Gerät erstellt standardmäßig eine 
Trackaufzeichnung, während Sie sich mit eingeschaltetem Gerät 
fortbewegen.

Aufzeichnen von Tracks
1 Wählen Sie im Hauptmenü die Option Einstellungen > 

Tracks > Trackaufzeichnung.
2 Wählen Sie Aufzeichnen, nicht anzeigen oder 

Aufzeichnen, auf Karte anzeigen.
Wenn Sie Aufzeichnen, auf Karte anzeigen wählen, wird der 
Track durch eine Linie auf der Karte gekennzeichnet.

3 Wählen Sie Aufzeichnungsart.
4 Wählen Sie eine Option:

• Wenn Sie Tracks mit variabler Rate aufzeichnen möchten, 
um eine optimale Aufzeichnung der Tracks zu erhalten, 
wählen Sie Auto.

• Wenn Sie Tracks in einer bestimmten Distanz aufzeichnen 
möchten, wählen Sie Distanz.

• Wenn Sie Tracks zu einer bestimmten Zeit aufzeichnen 
möchten, wählen Sie Uhrzeit.

5 Wählen Sie Intervall.
6 Führen Sie einen der folgenden Schritte aus:

• Wenn Sie für Aufzeichnungsart die Option Auto 
ausgewählt haben, wählen Sie eine Option, um Tracks 
entweder häufiger oder seltener aufzuzeichnen.

HINWEIS: Bei Verwendung des Intervalls Am häufigsten 
werden sehr detaillierte Tracks erstellt, jedoch wird die 
Kapazität des Gerätespeichers früher ausgelastet.
• Wenn Sie für Aufzeichnungsart die Option Distanz oder 

Uhrzeit gewählt haben, geben Sie einen Wert ein.

Während Sie sich mit eingeschaltetem Gerät fortbewegen, wird 
eine Trackaufzeichnung erstellt.

Anzeigen des aktuellen Tracks
1 Wählen Sie Track-Manager > Aktueller Track.
2 Wählen Sie eine Option:

• Zeigen Sie den aktuellen Track auf der Karte an, indem 
Sie Karte anzeigen wählen.

• Zeigen Sie das Höhenprofil für den aktuellen Track an, 
indem Sie Höhenprofil wählen.

Speichern des aktuellen Tracks
1 Wählen Sie Track-Manager > Aktueller Track.
2 Wählen Sie eine Option:

• Wählen Sie Track speichern, um den gesamten Track zu 
speichern.

• Wählen Sie Abschnitt speichern, und wählen Sie einen 
Abschnitt aus.

Verfolgen eines gespeicherten Tracks
1 Wählen Sie Zieleingabe > Tracks.
2 Wählen Sie einen gespeicherten Track.
3 Wählen Sie Go.

Löschen des aktuellen Tracks
Wählen Sie Track-Manager > Aktueller Track > Aktuellen 
Track löschen.

Löschen von Tracks
1 Wählen Sie Track-Manager.
2 Wählen Sie einen Track.
3 Wählen Sie Entfernen.

Trackeinstellungen
Wählen Sie Einstellungen > Tracks.
Trackaufzeichnung: Aktiviert oder deaktiviert die 

Trackaufzeichnung.
Aufzeichnungsart: Legt eine Trackaufzeichnungsart fest. 

Wählen Sie Auto, um die Tracks mit variabler Rate 
aufzuzeichnen und eine optimale Aufzeichnungsrate der 
Tracks zu erhalten.

Intervall: Legt eine Trackaufzeichnungsrate fest. Wenn Sie 
Punkte häufiger aufzeichnen, wird eine detailliertere 
Kursaufzeichnung erstellt, jedoch wird dadurch die 
Aufzeichnungskapazität früher erreicht.

Aktuellen Track löschen: Löscht den Speicher für den 
aktuellen Track.

Erweiterte Einstellungen > Automatisch archivieren: Legt 
eine Methode für die automatische Archivierung fest, um 
Tracks zu organisieren. Tracks werden automatisch 
gespeichert und gelöscht.

Erweiterte Einstellungen > Farbe: Ändert die Farbe der auf 
der Karte angezeigten Tracklinie.

Erwerben weiterer Karten
1 Rufen Sie unter garmin.com die Produktseite für Ihr Gerät 

auf.
2 Klicken Sie auf die Registerkarte Karten.
3 Folgen Sie den Anweisungen auf dem Bildschirm.

Suchen von Adressen
Sie können mit optionalen City Navigator® Karten nach Adressen 
suchen.
1 Wählen Sie Zieleingabe > Adressen.
2 Wählen Sie bei Bedarf das Land oder das Bundesland bzw. 

die Provinz aus.
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3 Geben Sie die Stadt oder die Postleitzahl ein.
HINWEIS: Nicht alle Karten bieten die Möglichkeit der Suche 
nach Postleitzahlen.

4 Wählen Sie die Stadt.
5 Geben Sie die Hausnummer ein.
6 Geben Sie die Straße ein.

Navigation
Sie können zu Routen, Tracks, Wegpunkten, Geocaches oder 
auf dem Gerät gespeicherten Positionen bzw. unter 
Verwendung der Karte oder des Kompasses zum Ziel 
navigieren.

Navigieren zu einem Ziel
1 Wählen Sie Zieleingabe.
2 Wählen Sie eine Kategorie.
3 Wählen Sie bei Bedarf die Option menu > Suchbegriff 

eingeben, und geben Sie den Namen des Ziels ganz oder 
teilweise ein.

4 Wählen Sie ein Ziel aus.
5 Wählen Sie Go.

Die Route wird auf der Karte als magentafarbene Linie 
angezeigt.

6 Navigieren Sie mithilfe der Karte (Navigieren mit der Karte, 
Seite 4) oder des Kompasses (Navigieren mit dem 
Kompass, Seite 5).

Navigieren mit der Funktion „Peilen und los“
Sie können mit dem Gerät auf ein Objekt in der Ferne zeigen, 
die Richtung speichern und zu dem Objekt navigieren.
HINWEIS: Die Peilen-und-los-Funktion ist nur bei Geräten der 
eTrex 32x verfügbar.
1 Wählen Sie Peilen und los.
2 Zeigen Sie mit dem Gerät auf ein Objekt.
3 Wählen Sie Richtung sperren > Kurs einstellen.
4 Navigieren Sie mithilfe des Kompasses.

Richtungseinstellungen
Sie können die Kompasseinstellungen anpassen.
Wählen Sie Einstellungen > Richtung.
Anzeige: Legt fest, welche Art der Richtungsanzeige auf dem 

Kompass angezeigt wird.
Nordreferenz: Legt die auf dem Kompass verwendete 

Nordreferenz fest.
Zielfahrt-Linie/Zeiger: Legt das Verhalten des auf der Karte 

angezeigten Zeigers fest. Bei der Option Peilung weist der 
Zeiger in die Richtung Ihres Ziels. Bei der Option Kurs wird 
angezeigt, wo Sie sich in Relation zu einer Steuerkurslinie 
befinden, die zum Ziel führt.

Kompass: Wechselt automatisch von einem elektronischen 
Kompass zu einem GPS-Kompass, wenn Sie für einen 
festgelegten Zeitraum mit höherer Geschwindigkeit 
unterwegs sind.

Kompasskalibrierung: Siehe Kalibrieren des Kompasses, 
Seite 5.

Karte
 kennzeichnet die aktuelle Position auf der Karte. Während Sie 

sich fortbewegen, verschiebt sich das Symbol  auf der Karte, 
und der zurückgelegte Weg wird als Linie dargestellt. 
Wegpunktnamen und Symbole werden ebenfalls auf der Karte 
angezeigt. Wenn Sie zum Ziel navigieren, wird die Route durch 
eine farbige Linie auf der Karte markiert.

Navigieren mit der Karte
HINWEIS

Mit den im Lieferumfang des Geräts enthaltenen Karten können 
Sie Fußgänger- oder Radfahrrouten auf Straßen und Wegen 
erstellen, jedoch keine Routen für die Navigation mit dem Auto.

1 Beginnen Sie mit der Navigation zu einem Ziel.
2 Wählen Sie Karte.

 kennzeichnet die aktuelle Position auf der Karte. Die Route 
ist durch eine farbige Linie gekennzeichnet.

3 Führen Sie mindestens einen der folgenden Schritte aus:
• Verwenden Sie die Thumb Stick Steuerung, um den 

Cursor auf der Karte zu verschieben und so andere 
Bereiche anzuzeigen.

• Wählen Sie  bzw. , um die Kartenansicht zu vergrößern 
und zu verkleinern.

Ändern der Kartenausrichtung
1 Wählen Sie auf der Karte die Option menu.
2 Wählen Sie Karte einrichten > Ausrichtung.
3 Wählen Sie eine Option:

• Wählen Sie Nach Norden, um Norden am oberen 
Seitenrand anzuzeigen.

• Wählen Sie Fahrtrichtung, um die aktuelle Fahrtrichtung 
oben auf der Seite anzuzeigen.

• Wählen Sie Fahrzeugmodus, um eine Fahrzeugansicht 
mit der Fahrtrichtung oben auf der Seite anzuzeigen.

Messen von Distanzen auf der Karte
Sie können die Distanz zwischen zwei Positionen messen.
1 Wählen Sie auf der Karte eine Position aus.
2 Wählen Sie menu > Distanz messen.
3 Verschieben Sie die Fahne an eine andere Position auf der 

Karte.

Karteneinstellungen
Wählen Sie Einstellungen > Karte.
Ausrichtung: Passt an, wie die Karte auf der Seite angezeigt 

wird. Mit Nach Norden wird Norden immer am oberen 
Seitenrand angezeigt. Mit Fahrtrichtung wird eine Ansicht von 
oben angezeigt, wobei sich die aktuelle Fahrtrichtung am 
oberen Seitenrand befindet. Mit Fahrzeugmodus wird eine 
3D-Fahrzeugansicht mit der Fahrtrichtung oben angezeigt.

Datenfelder: Passt die Datenfelder und Anzeigen von Karte, 
Kompass, Höhenprofil und Reisecomputer an.

Erweiterte Karteneinstellungen: Ermöglicht es Ihnen, 
erweiterte Karteneinstellungen zu öffnen 
(Karteneinstellungen, Seite 4).

Karteninformationen: Aktiviert oder deaktiviert die derzeit auf 
dem Gerät geladenen Karten.

Erweiterte Karteneinstellungen
Wählen Sie Einstellungen > Karte > Erweiterte 
Karteneinstellungen.
Automatischer Zoom: Wählt automatisch den passenden 

Zoom-Maßstab zur optimalen Benutzung der Karte aus. 
Wenn die Option Aus aktiviert ist, müssen Sie die Ansicht 
manuell vergrößern oder verkleinern.

Zoom-Maßstäbe: Passt den Zoom-Maßstab an, bei dem 
Kartenelemente angezeigt werden. Die Kartenelemente 
werden nicht angezeigt, wenn der Zoom-Maßstab über dem 
ausgewählten Maßstab liegt.

Textgröße: Wählt die Textgröße für Kartenelemente aus.
Detailgrad: Wählt die Menge der Details aus, die auf der Karte 

angezeigt werden sollen. Je detaillierter die Karte, desto 
länger dauert es, sie zu laden und anzuzeigen.
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Plastische Karte: Bietet eine plastische Darstellung auf der 
Karte (sofern verfügbar) oder deaktiviert die Funktion.

Kompass
Bei der Navigation zeigt das Symbol  immer die Richtung zum 
Ziel an und nicht die Richtung, in die Sie sich bewegen. Wenn 
das Symbol  auf dem elektronischen Kompass nach oben 
zeigt, bewegen Sie sich direkt auf das Ziel zu. Wenn das 
Symbol  in eine andere Richtung zeigt, drehen Sie sich, bis es 
auf dem Kompass nach oben zeigt.

Kalibrieren des Kompasses
Das Gerät verfügt über einen elektronischen 3-Achsen-
Kompass (eTrex 32x devices only). Sie sollten den Kompass 
kalibrieren, wenn Sie lange Strecken zurückgelegt haben, 
Temperaturveränderungen aufgetreten sind oder nachdem Sie 
einen Batteriewechsel vorgenommen haben.
1 Gehen Sie nach draußen, abseits von Gegenständen, die 

Magnetfelder beeinflussen, wie Autos, Gebäude oder 
überirdische Stromleitungen.

2 Wählen Sie auf der Kompassseite die Taste menu.
3 Wählen Sie Kompasskalibrierung > Start.
4 Folgen Sie den Anweisungen auf dem Display.

Navigieren mit dem Kompass
Bei der Navigation zu einem Ziel zeigt das Symbol  immer die 
Richtung zum Ziel an und nicht die Richtung, in die Sie sich 
bewegen.
1 Beginnen Sie mit der Navigation zu einem Ziel (Navigieren zu 

einem Ziel, Seite 4).
2 Wählen Sie Kompass.
3 Drehen Sie sich, bis  auf dem Kompass nach oben zeigt. 

Bewegen Sie sich dann weiter in diese Richtung bis zum Ziel.

Kurszeiger
Die Verwendung des Kurszeigers bietet sich vor allem an, wenn 
Sie auf Gewässern navigieren oder an Orten, an denen keine 
größeren Hindernisse im Weg sind. Zudem können dadurch 
auch Gefahrensituationen in der Nähe des Kurses umgangen 
werden, beispielsweise Untiefen oder unter Wasser befindliche 
Felsen.
Aktivieren Sie den Kurszeiger, indem Sie auf der Kompassseite 
die Option menu > Steuerkurs einrichten > Zielfahrt-Linie/
Zeiger > Kurs (CDI) wählen.

Der Kurszeiger  zeigt an, wo Sie sich in Relation zu einer 
Kurslinie zum Ziel befinden. Der Kursablageanzeiger (CDI) 
zeigt die Abweichung (rechts oder links) vom Kurs an. Der 
Maßstab  bezieht sich auf die Distanz zwischen Punkten 
auf dem Kursablageanzeiger, die angeben, wie weit Sie vom 
Kurs abgekommen sind.

Höhenprofil
HINWEIS: Das Höhenprofil ist nur mit Geräten der eTrex 32x 
verfügbar.
Das Höhenprofil zeigt standardmäßig die Höhe für die 
zurückgelegte Distanz an. Sie können Höhenprofileinstellungen 
anpassen (Höhenprofileinstellungen, Seite 5). Sie können 

einen beliebigen Punkt des Profils auswählen, um Informationen 
zu diesem Punkt anzuzeigen.

Kalibrieren des barometrischen Höhenmessers
Sie können den barometrischen Höhenmesser manuell 
kalibrieren, wenn Sie die genaue Höhe oder den genauen 
barometrischen Druck kennen.
1 Begeben Sie sich an eine Position, deren Höhe oder 

barometrischer Druck bekannt ist.
2 Wählen Sie Höhenprofil > menu > 

Höhenmesserkalibrierung.
3 Folgen Sie den Anweisungen auf dem Display.

Höhenprofileinstellungen
Wählen Sie auf der Höhenprofilseite die Taste menu.
Profiltyp ändern: Legt fest, welche Art von Daten auf der 

Höhenprofilseite angezeigt werden. .
Zoombereiche anpassen: Passt die auf der Höhenmesserseite 

angezeigten Zoombereiche an.
Datenfelder ändern: Ermöglicht es Ihnen, die 

Höhenmesserdatenseiten anzupassen.
Zurücksetzen: Setzt die Höhenmesserdaten zurück, 

einschließlich Wegpunkt-, Track- und Reisedaten.
Höhenmesserkalibrierung: Siehe (Kalibrieren des 

barometrischen Höhenmessers, Seite 5).
Werkseinstellung: Stellt die Werkseinstellungen des 

Höhenmessers wieder her.

Reisecomputer
Der Reisecomputer zeigt die aktuelle Geschwindigkeit, die 
Durchschnittsgeschwindigkeit, den Tagesstrecken-Zähler und 
andere hilfreiche Werte an. Sie können das Layout des 
Reisecomputers, der Anzeige und der Datenfelder anpassen.

Reisecomputereinstellungen
Wählen Sie auf der Reisecomputerseite die Option menu.
Zurücksetzen: Setzt alle Werte des Reisecomputers auf null 

zurück. Setzen Sie die Reiseinformationen vor jeder Tour 
zurück, damit die angezeigten Daten stets aktuell sind.

Große Ziffern: Ändert die Größe der auf der 
Reisecomputerseite angezeigten Zahlen.

Datenfelder ändern: Passt die Datenfelder des 
Reisecomputers an.

Anzeige ändern: Ändert das Design und die Informationen, die 
auf der Anzeige wiedergegeben werden.
HINWEIS: Die angepassten Einstellungen werden von der 
Anzeige gespeichert. Die Einstellungen gehen nicht verloren, 
wenn Sie Profile ändern (Profile, Seite 9).

Werkseinstellung: Stellt die Werkseinstellungen des 
Reisecomputers wieder her.

Wiederherstellen der Standardeinstellungen 
der Seiten
1 Öffnen Sie eine Seite, deren Einstellungen Sie 

wiederherstellen möchten.
2 Wählen Sie menu > Werkseinstellung.

Funktionen und Einstellungen des 
Hauptmenüs

Geocaches
Geocaching ist eine Schatzsuche, bei der Teilnehmer mithilfe 
von Hinweisen und GPS-Koordinaten versteckte Caches suchen 
oder Caches verstecken.
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Herunterladen von Geocaches über den Computer
Sie können Geocaches mit einem Computer manuell auf das 
Gerät übertragen (Übertragen von Dateien auf das Gerät, 
Seite 11). Sie können die Geocache-Dateien in einer GPX-
Datei speichern und sie in den GPX-Ordner auf dem Gerät 
importieren. Als Premium-Mitglied von geocaching.com können 
Sie die Pocket-Query-Funktion verwenden, um eine große 
Gruppe von Geocaches als einzelne GPX-Datei auf das Gerät 
zu übertragen.
1 Schließen Sie das Gerät mit einem USB-Kabel an den 

Computer an.
2 Rufen Sie die Website www.geocaching.com auf.
3 Erstellen Sie bei Bedarf ein Konto.
4 Melden Sie sich an.
5 Folgen Sie den Anweisungen bei geocaching.com, um nach 

Geocaches zu suchen und sie auf das Gerät 
herunterzuladen.

Navigieren zu Geocaches
1 Wählen Sie Geocaches.
2 Wählen Sie einen Geocache aus.
3 Wählen Sie Go.
Loggen von Geocaches
Wenn du versucht hast, einen Geocache zu finden, kannst du 
die Ergebnisse aufzeichnen. Sie können einige Geocaches 
unter www.geocaching.com überprüfen.
1 Wählen Sie Geocaches > Geocache loggen.
2 Wählen Sie Gefunden, Nicht gefunden, Reparatur 

erforderlich oder Unversucht.
3 Wählen Sie eine Option:

• Beenden Sie das Loggen, indem Sie Fertig wählen.
• Beginnen Sie mit der Navigation zu einem Geocache in 

Ihrer unmittelbaren Nähe, indem Sie Nächste suchen 
wählen.

• Geben Sie einen Kommentar zur Suche nach dem Cache 
oder zum Cache ein, indem Sie Kommentar hinzufügen 
wählen, einen Kommentar eingeben und am Ende Fertig 
wählen.

Wenn Sie bei www.geocaching.com angemeldet sind, wird das 
Log automatisch in Ihr Konto bei www.geocaching.com 
hochgeladen.

chirp™

Ein chirp ist ein kleines Garmin® Zubehör, das programmiert und 
in einem Geocache platziert wird. Sie können mithilfe des 
Geräts einen chirp in einem Geocache finden. Weitere 
Informationen zum chirp finden Sie im chirp Benutzerhandbuch 
unter www.garmin.com.
Aktivieren der chirp Suche
1 Wählen Sie Einstellungen > Geocaches.
2 Wählen Sie chirp™-Suche > Ein.

Drahtloses Senden und Empfangen von 
Daten
Damit Sie Daten drahtlos übertragen können, müssen Sie sich 
in einem Abstand von 3 m (10 Fuß) zu einem kompatiblen Gerät 
befinden.
Wenn das Gerät über die drahtlose ANT+® Technologie mit 
einem anderen kompatiblen Gerät oder Smartphone gekoppelt 
ist, kann es Daten senden und empfangen. Sie können 
Wegpunkte, Geocaches, Routen und Tracks weitergeben.
HINWEIS: Diese Funktion ist nicht auf allen Gerätemodellen 
verfügbar.
1 Wählen Sie Drahtlose Übertragung.

2 Wählen Sie eine Option:
• Wählen Sie Senden und dann einen Datentyp.
• Wählen Sie Empfangen, um Daten von einem anderen 

Gerät zu empfangen. Das andere kompatible Gerät muss 
versuchen, Daten zu senden.

3 Folgen Sie den angezeigten Anweisungen.

Einrichten von Annäherungsalarmen
Bei Annäherungsalarmen wird eine Warnung ausgegeben, 
wenn Sie sich in einem vorgegebenen Abstand zu einer 
bestimmten Position befinden.
1 Wählen Sie Annäherungsalarme > Alarm erstellen.
2 Wählen Sie eine Kategorie.
3 Wählen Sie einen Favoriten.
4 Wählen Sie Verwenden.
5 Geben Sie einen Radius ein.
Wenn Sie in einen Bereich mit einem Annäherungsalarm 
eintreten, gibt das Gerät einen Ton aus.

Berechnen der Größe von Flächen
1 Wählen Sie Flächenberechnung > Start.
2 Gehen Sie den Umfang des zu berechnenden Bereichs ab.
3 Wählen Sie abschließend die Option Berechnen.

Satellitenseite
Auf der Satellitenseite werden aktuelle Position, GPS-
Genauigkeit, Satellitenpositionen und Satellitensignalstärke 
angezeigt.

GPS-Satelliteneinstellungen
Wählen Sie Satellit > menu.
HINWEIS: Einige Einstellungen sind nur verfügbar, wenn die 
Option Ohne GPS verwenden aktiviert ist.
Ohne GPS verwenden: Ermöglicht Ihnen, das GPS zu 

deaktivieren.
Mit GPS verwenden: Ermöglicht Ihnen, das GPS zu aktivieren.
Fahrtrichtung: Zeigt an, ob Satelliten mit Ringen genordet zum 

oberen Bildschirmrand dargestellt werden oder ob der 
aktuelle Track nach oben zeigt.

Einfarbig: Ermöglicht Ihnen auszuwählen, ob die Satellitenseite 
mehrfarbig oder einfarbig angezeigt wird.

Position auf Karte einstellen: Ermöglicht Ihnen, Ihre aktuelle 
Position auf der Karte zu markieren. Sie können diese 
Position verwenden, um Routen zu erstellen oder um nach 
gespeicherten Positionen zu suchen.

AutoLocate-Position: Berechnet Ihre GPS-Position mit der 
Garmin AutoLocate® Funktion.

Garmin Adventures
Sie können ähnliche Elemente gruppieren und daraus ein 
Adventure erstellen. Beispielsweise können Sie ein Adventure 
für die letzte Wanderung erstellen. Das Adventure könnte die 
Trackaufzeichnung der Tour, Fotos sowie gesuchte Geocaches 
umfassen. Sie können Adventures mit BaseCamp™ erstellen 
und verwalten.
HINWEIS: BaseCamp ist nicht auf allen Gerätemodellen 
verfügbar.

Senden von Dateien an BaseCamp
1 Öffnen Sie BaseCamp.
2 Verbinden Sie das Gerät mit dem Computer.

Unter Windows® wird das Gerät als Wechseldatenträger oder 
tragbares Gerät und die Speicherkarte ggf. als zweiter 
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Wechseldatenträger angezeigt. Unter Mac® werden das Gerät 
und die Speicherkarte als verbundene Laufwerke angezeigt.
HINWEIS: Auf einigen Computern mit mehreren 
Netzlaufwerken können die Gerätelaufwerke möglicherweise 
nicht ordnungsgemäß angezeigt werden. Informationen zum 
Zuweisen von Laufwerkbuchstaben finden Sie in der 
Dokumentation des Betriebssystems.

3 Öffnen Sie das Laufwerk Garmin oder das Laufwerk der 
Speicherkarte.

4 Wählen Sie eine Option:
• Wählen Sie ein Element auf einem angeschlossenen 

Gerät aus, und ziehen Sie es in Meine Sammlung oder in 
eine Liste.

• Wählen Sie in BaseCamp die Option Gerät > Von Gerät 
empfangen, und wählen Sie das Gerät aus.

Erstellen von Adventures
Bevor Sie ein Adventure erstellen und an das Gerät senden 
können, müssen Sie BaseCamp auf den Computer 
herunterladen und Tracks vom Gerät auf den Computer 
übertragen (Senden von Dateien an BaseCamp, Seite 6).
1 Öffnen Sie BaseCamp.
2 Wählen Sie Datei > Neu > Garmin Adventure.
3 Wählen Sie einen Track und dann die Option Weiter.
4 Fügen Sie bei Bedarf Elemente aus BaseCamp hinzu.
5 Geben Sie Informationen in die erforderlichen Felder ein, um 

dem Adventure einen Namen und eine Beschreibung 
zuzuweisen.

6 Wenn Sie das Titelbild des Adventures ändern möchten, 
wählen Sie Ändern, und wählen Sie ein anderes Foto aus.

7 Wählen Sie Fertig stellen.

Starten von Adventures
Damit Sie ein Adventure starten können, müssen Sie ein 
Adventure von BaseCamp an das Gerät senden (Senden von 
Dateien an BaseCamp, Seite 6).
1 Wählen Sie Adventure.
2 Wählen Sie ein Adventure aus.
3 Wähle Sie Start.

VIRB® Fernbedienung
HINWEIS: Die Funktion für die VIRB Fernbedienung ist nur bei 
Geräten der eTrex 32x verfügbar.
Zum Verwenden der VIRB Fernbedienung musst du auf der 
VIRB Kamera die Fernbedienungseinstellung aktivieren.
Mit der VIRB Fernbedienung lässt sich die VIRB Kamera aus 
einer Entfernung bedienen.
1 Wählen Sie VIRB-Fernbedienung.
2 Wählen Sie eine Option:

• Wählen Sie REC, um Videos aufzuzeichnen.
• Wählen Sie Foto aufnehmen, um ein Foto aufzunehmen.

Weitere Extras im Hauptmenü
Wecker: Richtet einen akustischen Alarm ein. Wenn Sie das 

Gerät derzeit nicht verwenden, können Sie es so einrichten, 
dass es zu einer bestimmten Zeit eingeschaltet wird.

Rechner: Zeigt einen Rechner an.
Kalender: Zeigt einen Kalender an.
Jagen und Angeln: Zeigt eine Vorhersage für die besten Tage 

und Tageszeiten zum Jagen und Angeln an der aktuellen 
Position an.

Stoppuhr: Ermöglicht es Ihnen, einen Timer zu verwenden, 
eine Runde zu markieren und Rundenzeiten zu messen.

Sonne und Mond: Zeigt basierend auf Ihrer GPS-Position 
Zeiten für Sonnenaufgang und Sonnenuntergang an sowie 
die Mondphase.

Anpassen des Geräts
Anpassen der Helligkeit der Beleuchtung
Die übermäßige Verwendung der Beleuchtung kann zu einer 
beträchtlichen Verringerung der Akkulaufzeit führen. Sie können 
die Helligkeit der Beleuchtung anpassen, um die Batterie-
Betriebszeit zu verlängern.
HINWEIS: Die Helligkeit der Beleuchtung kann eingeschränkt 
sein, wenn die Batterie schwach ist.
1 Wählen Sie .
2 Passen Sie die Hintergrundbeleuchtung mit dem 

Schieberegler an.
Das Gerät kann sich warm anfühlen, wenn eine hohe 
Einstellung für die Hintergrundbeleuchtung gewählt ist.

Anpassen des Hauptmenüs
Sie können dem Hauptmenü Elemente hinzufügen und sie 
verschieben und löschen.
1 Wählen Sie im Hauptmenü die Option menu > 

Elementreihenfolge ändern.
2 Wählen Sie eine Menüoption.
3 Wählen Sie eine Option:

• Wählen Sie Verschieben, um die Position des Elements 
in der Liste zu ändern.

• Wählen Sie Einfügen, um der Liste ein neues Element 
hinzuzufügen.

• Wählen Sie Entfernen, um ein Element aus der Liste zu 
löschen.

Ändern der Seitenfolge
Damit Sie die Reihenfolge der Seitenfolge ändern können, 
müssen Sie der Seitenfolge Seiten hinzufügen.
1 Wählen Sie Einstellungen > Seitenfolge.
2 Wählen Sie eine Seite.
3 Wählen Sie Verschieben.
4 Verschieben Sie die Seite in der Liste nach oben oder nach 

unten.
5 Drücken Sie die Thumb Stick Steuerung.

Hinzufügen von Seiten
1 Wählen Sie Einstellungen > Seitenfolge.
2 Wählen Sie Seite hinzufügen.
3 Wählen Sie eine Seite, die Sie hinzufügen möchten.

Entfernen von Seiten
1 Wählen Sie Einstellungen > Seitenfolge.
2 Wählen Sie eine Seite.
3 Wählen Sie Entfernen.
4 Drücken Sie die Thumb Stick Steuerung.

Anpassen der Datenfelder
Sie können die auf jeder Hauptseite angezeigten Datenfelder 
anpassen.
1 Öffnen Sie die Seite, deren Datenfelder Sie ändern möchten.
2 Wählen Sie menu.
3 Wählen Sie Datenfelder ändern.
4 Wählen Sie das neue Datenfeld.
5 Folgen Sie den Anweisungen auf dem Bildschirm.
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Datenfelder
Für einige Datenfelder ist es erforderlich, auf einer Route zu 
navigieren. Außerdem wird u. U. ANT+ Zubehör benötigt, damit 
Daten angezeigt werden können.
24 Stunden maximale Temperatur: Die während der 

vergangenen 24 Stunden aufgezeichnete minimale 
Temperatur. Das Gerät muss mit einem drahtlosen 
Temperatursensor verbunden sein, damit Daten angezeigt 
werden.

24 Stunden minimale Temperatur: Die während der 
vergangenen 24 Stunden aufgezeichnete maximale 
Temperatur. Das Gerät muss mit einem drahtlosen 
Temperatursensor verbunden sein, damit Daten angezeigt 
werden.

Abstieg gesamt: Die gesamte Höhendistanz, die seit dem 
letzten Zurücksetzen des Datenfelds im Abstieg zurückgelegt 
wurde.

Abstiegsdurchschnitt: Der durchschnittliche vertikale Abstieg 
seit dem letzten Zurücksetzen des Datenfelds.

Abstiegsmaximum: Die maximale Abstiegsrate in Metern oder 
Fuß pro Minute seit dem letzten Zurücksetzen des 
Datenfelds.

Akkuladestad: Die verbleibende Akkuleistung.
Aktuelle Runde: Die Timer-Zeit für die aktuelle Runde.
Alarm: Die aktuelle Zeit des Countdown-Timers.
Ankunft nächster Wegpunkt: Die voraussichtliche Uhrzeit, zu 

der Sie den nächsten Wegpunkt der Route erreichen werden 
(in der Ortszeit des Wegpunkts). Sie müssen auf einer Route 
navigieren, damit diese Daten angezeigt werden.

Ankunftszeit: Die voraussichtliche Uhrzeit, zu der Sie das 
Endziel erreichen werden (in der Ortszeit des Ziels). Sie 
müssen auf einer Route navigieren, damit diese Daten 
angezeigt werden.

Anstieg gesamt: Die gesamte Höhendistanz, die seit dem 
letzten Zurücksetzen des Datenfelds im Aufstieg 
zurückgelegt wurde.

Anstiegsdurchschnitt: Der durchschnittliche vertikale Anstieg 
seit dem letzten Zurücksetzen des Datenfelds.

Anstiegsmaximum: Die maximale Anstiegsrate in Metern oder 
Fuß pro Minute seit dem letzten Zurücksetzen des 
Datenfelds.

Barometer: Der kalibrierte aktuelle Luftdruck.
Datum: Die aktuellen Angaben für Tag, Monat und Jahr.
Distanz zum Nächsten: Die verbleibende Distanz zum 

nächsten Wegpunkt der Route. Sie müssen auf einer Route 
navigieren, damit diese Daten angezeigt werden.

Distanz zum Ziel: Die verbleibende Distanz zum Endziel. Sie 
müssen auf einer Route navigieren, damit diese Daten 
angezeigt werden.

Durchschnittliche Runde: Die durchschnittliche Rundenzeit für 
die aktuelle Aktivität.

Gesamtrundenzeit: Die Timer-Zeit für alle beendeten Runden.
Gesamt-Ø-Geschwindigkeit: Die Durchschnittsgeschwindigkeit 

in Bewegung und im Stand seit dem letzten Zurücksetzen 
des Datenfelds.

Geschwindigkeit: Die aktuelle Reisegeschwindigkeit.
Gleitverhältnis: Das Verhältnis von zurückgelegter horizontaler 

Distanz zur Differenz in der vertikalen Distanz.
Gleitverhältnis zum Ziel: Das Gleitverhältnis, das erforderlich 

ist, um von der aktuellen Position zur Zielhöhe abzusteigen. 
Sie müssen auf einer Route navigieren, damit diese Daten 
angezeigt werden.

GPS-Genauigkeit: Die Fehlertoleranz für Ihre genaue Position. 
Beispielsweise liegt die GPS-Genauigkeit für die aktuelle 
Position bei +/-3,65 m (12 Fuß).

GPS-Signalstärke: Die Stärke des GPS-Satellitensignals.
Gutgemachte Geschwindigkeit: Die Geschwindigkeit, mit der 

Sie sich einem Ziel entlang einer Route nähern. Sie müssen 
auf einer Route navigieren, damit diese Daten angezeigt 
werden.

Herzfrequenz: Ihre Herzfrequenz in Schlägen pro Minute. Das 
Gerät muss mit einem kompatiblen Herzfrequenzsensor 
verbunden sein.

Höhe - Minimum: Die minimale Höhe, die seit dem letzten 
Zurücksetzen des Datenfelds erreicht wurde.

Höhe über Grund: Die Höhe der aktuellen Position über oder 
unter dem Meeresspiegel (wenn Karten ausreichende 
Höheninformationen enthalten).

Höhe über NN: Die Höhe der aktuellen Position über oder unter 
dem Meeresspiegel.

Kilometerzähler: Die gesamte, bei allen Reisen zurückgelegte 
Distanz. Dieser Gesamtwert wird beim Zurücksetzen der 
Reisedaten nicht gelöscht.

Kompassrichtung: Die Richtung, in die Sie sich basierend auf 
dem Kompass bewegen.

Kurs: Die Richtung von der Startposition zu einem Ziel. Die 
Strecke kann als geplante oder festgelegte Route angezeigt 
werden. Sie müssen auf einer Route navigieren, damit diese 
Daten angezeigt werden.

Kursabweichung: Die Distanz nach links oder rechts, die Sie 
von der ursprünglichen Wegstrecke abgekommen sind. Sie 
müssen auf einer Route navigieren, damit diese Daten 
angezeigt werden.

Kursänderung: Die Winkeldifferenz (in Grad) zwischen der 
Peilung zum Ziel und dem aktuellen Kurs. L bedeutet, dass 
Sie nach links abbiegen sollen. R bedeutet, dass Sie nach 
rechts abbiegen sollen. Sie müssen auf einer Route 
navigieren, damit diese Daten angezeigt werden.

Letzte Rundenzeit: Die Timer-Zeit für die letzte beendete 
Runde.

Luftlinie zum Ziel: Die Höhendistanz zwischen der aktuellen 
Position und dem endgültigen Ziel. Sie müssen auf einer 
Route navigieren, damit diese Daten angezeigt werden.

Maximale Geschwindigkeit: Die höchste Geschwindigkeit, die 
seit dem letzten Zurücksetzen des Datenfelds erreicht wurde.

Maximale Höhe über NN: Die maximale Höhe, die seit dem 
letzten Zurücksetzen des Datenfelds erreicht wurde.

Nächster Wegpunkt: Der nächste Punkt auf der Route. Sie 
müssen auf einer Route navigieren, damit diese Daten 
angezeigt werden.

Position (gewählt): Die aktuelle Position, die die ausgewählte 
Positionsformateinstellung verwendet.

Position (Länge/Breite): Die aktuelle Position in Längen- und 
Breitengraden unabhängig von der 
Positionsformateinstellung.

Reisedauer, gesamt: Die gesamte Zeit, die Sie seit dem letzten 
Zurücksetzen des Datenfelds in Bewegung und im Stand 
verbracht haben.

Reisedauer im Stand: Die gesamte Zeit, die Sie seit dem 
letzten Zurücksetzen des Datenfelds im Stand verbracht 
haben.

Reisedauer in Bewegung: Die gesamte Zeit, die Sie seit dem 
letzten Zurücksetzen des Datenfelds in Bewegung verbracht 
haben.

Richtung: Die Richtung von der aktuellen Position zu einem 
Ziel. Sie müssen auf einer Route navigieren, damit diese 
Daten angezeigt werden.
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Richtung: Die Richtung, in die Sie sich bewegen.
Runden: Die Anzahl der Runden, die für die aktuelle Aktivität 

beendet wurden.
Runden-Länge: Die während der aktuellen Runde 

zurückgelegte Distanz.
Sonnenaufgang: Der Zeitpunkt des Sonnenaufgangs basierend 

auf der aktuellen GPS-Position.
Sonnenuntergang: Der Zeitpunkt des Sonnenuntergangs 

basierend auf der aktuellen GPS-Position.
Stoppuhr: Die Timer-Zeit für die aktuelle Aktivität.
Tagesstreckenzähler: Die gesamte zurückgelegte Distanz seit 

dem letzten Zurücksetzen des Datenfelds.
Temperatur: Die Lufttemperatur. Ihre Körpertemperatur 

beeinflusst den Temperatursensor. Das Gerät muss mit 
einem drahtlosen Temperatursensor verbunden sein, damit 
Daten angezeigt werden.

Tempolimit: Das für die Straße bestehende Tempolimit. Nicht 
auf allen Karten und in allen Gebieten verfügbar. Zum 
Erfahren des tatsächlichen Tempolimits sind stets die 
Straßenschilder zu beachten.

Tiefe: Die Wassertiefe. Das Gerät muss mit einem NMEA® 0183 
oder NMEA 2000® Gerät verbunden sein, das die Wassertiefe 
ermitteln kann.

Trackdistanz: Die Distanz, die während des aktuellen Tracks 
zurückgelegt wurde.

Trittfrequenz: Die Anzahl der Umdrehungen der Tretkurbel 
oder die Anzahl der Schritte pro Minute. Das Gerät muss mit 
einem Zubehör zum Messen der Trittfrequenz verbunden 
sein, damit Daten angezeigt werden.

Uhrzeit: Die aktuelle Uhrzeit basierend auf der aktuellen 
Position und den Zeiteinstellungen (Format, Zeitzone und 
Sommerzeit).

Umgebungsdruck: Der nicht kalibrierte Umgebungsdruck.
Vertikalgeschwindigkeit: Die über einen Zeitraum festgestellte 

Aufstiegs- oder Abstiegsrate.
Vertikalgeschwindigkeit zum Ziel: Die Aufstiegs- oder 

Abstiegsrate zu einer vorgegebenen Höhe. Sie müssen auf 
einer Route navigieren, damit diese Daten angezeigt werden.

Wassertemperatur: Die Wassertemperatur. Das Gerät muss 
mit einem NMEA 0183 Gerät verbunden sein, das die 
Wassertemperatur ermitteln kann.

Zeiger: Ein Pfeil zeigt in die Richtung des nächsten Wegpunkts 
bzw. der nächsten Richtungsänderung. Sie müssen auf einer 
Route navigieren, damit diese Daten angezeigt werden.

Zeit bis nächster Wegpunkt: Die voraussichtlich verbleibende 
Zeit bis zum Erreichen des nächsten Wegpunkts der Route. 
Sie müssen auf einer Route navigieren, damit diese Daten 
angezeigt werden.

Zeit bis Zielankunft: Die voraussichtlich verbleibende Zeit bis 
zum Erreichen des Ziels. Sie müssen auf einer Route 
navigieren, damit diese Daten angezeigt werden.

Zielposition: Die Position des endgültigen Ziels. Sie müssen 
auf einer Route navigieren, damit diese Daten angezeigt 
werden.

Zielpunkt: Der letzte Punkt auf der Route zum Ziel. Sie müssen 
auf einer Route navigieren, damit diese Daten angezeigt 
werden.

Zum Kurs: Die Richtung, in die Sie sich fortbewegen müssen, 
um zur Route zurückzukehren. Sie müssen auf einer Route 
navigieren, damit diese Daten angezeigt werden.

Ø-Geschwindigkeit in Bewegung: Die 
Durchschnittsgeschwindigkeit in Bewegung seit dem letzten 
Zurücksetzen des Datenfelds.

Profile
Profile enthalten eine Reihe von Einstellungen, mit denen das 
Gerät entsprechend Ihrer Verwendung optimiert wird. 
Beispielsweise werden bei der Verwendung des Geräts beim 
Jagen andere Einstellungen und Ansichten verwendet als bei 
der Verwendung beim Geocaching.
Wenn Sie ein Profil nutzen und Einstellungen ändern, z. B. 
Datenfelder oder Maßeinheiten, werden die Änderungen 
automatisch als Teil des Profils gespeichert.

Erstellen von benutzerdefinierten Profilen
Sie können Ihre Einstellungen und Datenfelder für eine 
bestimmte Aktivität oder Reise anpassen.
1 Wählen Sie Einstellungen > Profile > Profil erstellen > OK.
2 Passen Sie die Einstellungen und Datenfelder an.

Auswählen eines Profils
Wenn Sie zu einer anderen Aktivität wechseln, können Sie die 
Einstellungen des Geräts ändern, indem Sie das Profil ändern.
1 Wählen Sie Profiländerung.
2 Wählen Sie ein Profil.

Bearbeiten eines Profilnamens
1 Wählen Sie Einstellungen > Profile.
2 Wählen Sie ein Profil.
3 Wählen Sie Namen bearbeiten.
4 Geben Sie den neuen Namen ein.

Löschen von Profilen
HINWEIS: Damit Sie ein Aktivitätsprofil löschen können, müssen 
Sie zunächst ein anderes Profil aktivieren. Es ist nicht möglich, 
ein aktives Profil zu löschen.
1 Wählen Sie Einstellungen > Profile.
2 Wählen Sie ein Profil.
3 Wählen Sie Entfernen.

Systemeinstellungen
Wählen Sie Einstellungen > System.
Satellitensystem: Legt das Satellitensystem fest (GPS- und 

andere Satellitensysteme, Seite 9).
WAAS: Aktiviert die Verwendung von WAAS/EGNOS Daten 

(Wide Area Augmentation System/European Geostationary 
Navigation Overlay Service) auf dem System.

Sprache: Stellt die Textsprache des Geräts ein.
HINWEIS: Das Ändern der Textsprache wirkt sich nicht auf 
Benutzereingaben oder Kartendaten wie beispielsweise 
Straßennamen aus.

Batterietyp: Ermöglicht es Ihnen, den verwendeten AA-
Batterietyp auszuwählen.

USB-Modus: Richtet das Gerät so ein, dass beim Herstellen 
einer Verbindung mit dem Computer der 
Massenspeichermodus oder der Garmin Modus verwendet 
wird.

GPS- und andere Satellitensysteme
Die gemeinsame Verwendung des GPS mit einem anderen 
Satellitensystem bietet in schwierigen Umgebungen eine 
bessere Leistung und erfasst die Position schneller als bei der 
ausschließlichen Verwendung des GPS. Allerdings kann bei der 
Verwendung mehrerer Systeme die Akku-Laufzeit kürzer sein 
als bei der ausschließlichen Verwendung des GPS.
Ihr Gerät unterstützt diese globalen 
Navigationssatellitensysteme (GNSS, Global Navigation 
Satellite Systems).
GPS: Eine von den USA eingerichtete Satellitenkonstellation.
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GLONASS: Eine von Russland eingerichtete 
Satellitenkonstellation.

Anzeigeeinstellungen
Wählen Sie Einstellungen > Anzeige.
Beleuchtungsdauer: Passt den Zeitraum an, nach dem die 

Beleuchtung ausgeschaltet wird.
Energiesparmodus: Schont den Akku und verlängert die Akku-

Betriebszeit, indem der Bildschirm ausgeschaltet wird, sobald 
die Beleuchtung ausgeht.

Farben: Ändert die Darstellung des Anzeigehintergrunds und 
der Markierungsfarbe für ausgewählte Elemente.

Screenshot: Ermöglicht es Ihnen, das Bild zu speichern, das 
auf dem Bildschirm des Geräts angezeigt wird.

Einrichten der Töne des Geräts
Sie können die Töne für Nachrichten, Tasten, 
Abbiegewarnungen und Alarme anpassen.
1 Wählen Sie Einstellungen > Töne > Töne > Ein.
2 Wählen Sie einen Ton für jede Art der Tonausgabe aus.

Einrichten der Maßeinheiten
Sie können die Maßeinheiten für Distanz und Geschwindigkeit, 
Höhe, Tiefe, Temperatur, Druck und Vertikalgeschwindigkeit 
anpassen.
1 Wählen Sie Einstellungen > Einheiten.
2 Wählen Sie eine Messgröße.
3 Wählen Sie eine Maßeinheit.

Zeiteinstellungen
Wählen Sie Einstellungen > Uhrzeit.
Zeitformat: Legt fest, ob die Zeit vom Gerät im 12-Stunden- 

oder 24-Stunden-Format angezeigt wird.
Zeitzone: Legt die Zeitzone für das Gerät fest.Mit Automatisch 

wird die Zeitzone abhängig von der GPS-Position 
automatisch eingestellt.

Positionsformateinstellungen
HINWEIS: Sie sollten das Positionsformat oder das 
Koordinatensystem des Kartenbezugssystems nur ändern, 
wenn Sie eine Karte verwenden, für die ein anderes 
Positionsformat erforderlich ist.
Wählen Sie Einstellungen > Positionsformat.
Positionsformat: Legt das Positionsformat fest, in dem 

Positionsangaben angezeigt werden.
Kartendatum: Stellt das Koordinatensystem ein, nach dem die 

Karte strukturiert ist.
Kartensphäroid: Zeigt das vom Gerät verwendete 

Koordinatensystem an. Das Standard-Koordinatensystem ist 
WGS 84.

Routingeinstellungen
Die verfügbaren Routingeinstellungen sind je nach gewählter 
Aktivität unterschiedlich.
Wählen Sie Einstellungen > Routing.
Routenpräferenz: Legt die Präferenz zum Optimieren der 

Routenberechnung basierend auf Distanz, Zeit, Straßen- 
oder Luftlinienrouting fest.

Routen berechnen für: Legt die Methode zum Berechnen der 
Route fest.

Auf Straße zeigen: Fixiert das blaue Dreieck, mit dem Ihre 
Position auf der Karte gekennzeichnet ist, auf der 

nächstgelegenen Straße. Dies bietet sich besonders beim 
Fahren oder Navigieren auf Straßen an.

Luftlinienübergänge: Richtet Präferenzen für die 
Neuberechnung ein, die gelten, wenn Sie sich von der 
aktiven Route entfernen.

Vermeidung einrichten: Legt die Straßen- und Geländetypen 
sowie die Verkehrsmittel fest, die bei der Navigation 
vermieden werden.

Höhenmessereinstellungen
HINWEIS: Der Höhenmesser ist nur bei Geräten der eTrex 32x 
verfügbar.
Wählen Sie Einstellungen > Höhenmesser.
Automatische Kalibrierung: Der Höhenmesser wird 

automatisch bei jedem Einschalten des Geräts kalibriert.
Barometermodus: Bei Auswahl der Option Höhenmesser kann 

das Barometer Höhenänderungen messen, während Sie sich 
fortbewegen. Bei Auswahl der Option Barometer wird 
vorausgesetzt, dass sich das Gerät stationär in einer 
bestimmten Höhe befindet. Der barometrische Druck sollte 
sich daher nur aufgrund des Wetters ändern.

Luftdrucktendenz-Aufzeichnung: Legt fest, wie das Gerät 
Druckdaten aufzeichnet. Bei Auswahl der Option Immer 
speichern werden alle Druckdaten aufgezeichnet. Dies kann 
nützlich sein, wenn Sie Luftdruckschwankungen erwarten.

Profiltyp: Zeichnet Höhenänderungen über einen festgelegten 
Zeitraum oder eine festgelegte Distanz auf, zeichnet den 
barometrischen Druck über einen festgelegten Zeitraum auf 
oder zeichnet Änderungen des Umgebungsdrucks über einen 
festgelegten Zeitraum auf.

Höhenmesserkalibrierung: Kalibriert den Höhenmesser.

Marineeinstellungen
Wählen Sie Einstellungen > Marine.
Seekartenmodus: Legt die Art der Karte fest, die das Gerät 

zum Anzeigen von Marinedaten verwendet. Mit Nautisch 
werden verschiedene Kartenmerkmale in unterschiedlichen 
Farben angezeigt, damit Marine-POIs einfacher zu lesen sind 
und die Karte in ihrer Darstellung Papierkarten ähnelt. Mit 
Angeln (Seekarten erforderlich) wird eine detaillierte Ansicht 
der Bodenkonturen und Tiefenmessungen angezeigt. 
Außerdem wird die Kartendarstellung für eine optimale 
Benutzung beim Fischen vereinfacht.

Darstellung: Legt die Darstellung von maritimen 
Navigationshilfen auf der Karte fest.

Einstellung von Marinealarmen: Richtet Alarme ein, die 
ertönen, wenn eine angegebene Driftentfernung 
überschritten wird, während Sie vor Anker liegen, wenn Sie 
um eine bestimmte Distanz vom Kurs abgewichen sind und 
wenn Sie in Wasser mit einer bestimmten Wassertiefe 
eintreten.

Einrichten von Marinealarmen
1 Wählen Sie Einstellungen > Marine > Einstellung von 

Marinealarmen.
2 Wählen Sie einen Alarmtyp.
3 Wählen Sie Ein.
4 Geben Sie eine Distanz ein, und wählen Sie Go.

Zurücksetzen von Daten
Sie können Reisedaten zurücksetzen, alle Wegpunkte löschen, 
den aktuellen Track löschen oder Standardwerte 
wiederherstellen.
1 Wählen Sie Einstellungen > Zurücksetzen.
2 Wählen Sie ein Element aus, das Sie zurücksetzen möchten.
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Geräteinformationen
Produkt-Updates
Installieren Sie auf dem Computer Garmin Express™

(www.garmin.com/express). Installieren Sie auf dem 
Smartphone die Garmin Connect™ App.
So erhalten Sie einfachen Zugriff auf folgende Dienste für 
Garmin Geräte:
• Software-Updates
• Karten-Updates
• Hochladen von Daten auf Garmin Connect
• Produktregistrierung

Einrichten von Garmin Express
1 Verbinden Sie das Gerät per USB-Kabel mit dem Computer.
2 Rufen Sie die Website garmin.com/express auf.
3 Folgen Sie den Anweisungen auf dem Bildschirm.

Registrieren des Geräts
Helfen Sie uns, unseren Service weiter zu verbessern, und 
füllen Sie die Online-Registrierung noch heute aus. Bewahren 
Sie die Originalquittung oder eine Kopie an einem sicheren Ort 
auf.
1 Rufen Sie garmin.com/express auf.
2 Melden Sie sich bei Ihrem Garmin Konto an.

Anzeigen aufsichtsrechtlicher E-Label- und 
Compliance-Informationen
Das Etikett für dieses Gerät wird in elektronischer Form 
bereitgestellt. Das E-Label kann aufsichtsrechtliche 
Informationen enthalten, beispielsweise von der FCC 
ausgestellte Identifizierungsnummern oder regionale 
Compliance-Zeichen, und auch anwendbare Produkt- und 
Lizenzinformationen bieten.
1 Wählen Sie Einstellungen.
2 Wählen Sie Systeminfo.

Pflege des Geräts
HINWEIS

Verwenden Sie keine chemischen Reinigungsmittel, 
Lösungsmittel oder Insektenschutzmittel, die die Kunststoffteile 
oder die Oberfläche beschädigen könnten.
Bewahren Sie das Gerät nicht an Orten auf, an denen es evtl. 
über längere Zeit sehr hohen oder sehr niedrigen Temperaturen 
ausgesetzt ist, da dies zu Schäden am Gerät führen kann.
Das Gerät ist gemäß IEC-Norm 60529 IPX7 wasserbeständig. 
In einer Tiefe von einem Meter widersteht das Gerät 30 Minuten 
lang dem Eindringen von Wasser. Eine längere Eintauchzeit 
kann zu Schäden am Gerät führen. Reiben Sie das Gerät nach 
Kontakt mit Wasser trocken, und lassen Sie es an der Luft 
trocknen, bevor Sie es verwenden oder aufladen.
Spülen Sie das Gerät mit klarem Wasser ab, nachdem es mit 
Chlor- oder Salzwasser in Berührung gekommen ist.

Reinigen des Geräts
HINWEIS

Bereits geringe Mengen an Schweiß oder Feuchtigkeit können 
beim Anschluss an ein Ladegerät zur Korrosion der elektrischen 
Kontakte führen. Korrosion kann den Ladevorgang und die 
Datenübertragung verhindern.

1 Wischen Sie das Gerät mit einem Tuch ab, das mit einer 
milden Reinigungslösung befeuchtet ist.

2 Wischen Sie das Gerät trocken.

Lassen Sie das Gerät nach der Reinigung vollständig trocknen.

Datenverwaltung
Sie können Dateien auf dem Gerät speichern. Das Gerät verfügt 
über einen freien microSD Kartenslot für zusätzliche Daten.
HINWEIS: Das Gerät ist mit Windows 7 und höher sowie mit 
Mac OS 10.4 und höher kompatibel.

Installieren einer Speicherkarte

 WARNUNG
Verwenden Sie keine scharfen Gegenstände zum Entnehmen 
auswechselbarer Batterien.

Sie können eine microSD® Speicherkarte in das Handgerät 
einlegen, um zusätzlichen Speicherplatz oder vorinstallierte 
Karten zu erhalten.
1 Drehen Sie den D-Ring gegen den Uhrzeigersinn, und ziehen 

Sie ihn nach oben, um die Abdeckung abzunehmen.
2 Entfernen Sie die Batterie.
3 Schieben Sie den Speicherkartenhalter nach links, und 

heben Sie ihn an.

4 Legen Sie die Speicherkarte mit den Goldkontakten nach 
unten ein.

5 Schließen Sie den Speicherkartenhalter.
6 Schieben Sie den Speicherkartenhalter nach rechts, um ihn 

einzurasten.
7 Setzen Sie die Batterie und die Abdeckung wieder auf.

Verbinden des Geräts mit dem Computer
HINWEIS

Zum Schutz vor Korrosion sollten Sie den USB-Anschluss, die 
Schutzkappe und den umliegenden Bereich vor dem Aufladen 
oder dem Anschließen an einen Computer sorgfältig 
abtrocknen.

Damit Sie das Gerät verwenden können, während es mit dem 
Computer verbunden ist, müssen Sie Batterien einlegen. Die 
Stromversorgung über den USB-Anschluss des Computers ist 
eventuell für den Betrieb des Geräts nicht ausreichend.
1 Heben Sie die Schutzkappe über dem Mini-USB-Anschluss 

an.
2 Stecken Sie das schmale Ende des USB-Kabels in den Mini-

USB-Anschluss.
3 Stecken Sie das breite Ende des USB-Kabels in einen USB-

Anschluss am Computer.
Unter Windows wird das Gerät als Wechseldatenträger oder 
tragbares Gerät und die Speicherkarte ggf. als zweiter 
Wechseldatenträger angezeigt. Unter Mac werden das Gerät 
und die Speicherkarte als verbundene Laufwerke angezeigt.

Übertragen von Dateien auf das Gerät
1 Verbinden Sie das Gerät mit dem Computer.

Unter Windows wird das Gerät als Wechseldatenträger oder 
tragbares Gerät angezeigt, und die Speicherkarte wird ggf. 
als zweiter Wechseldatenträger angezeigt. Unter Mac 
werden das Gerät und die Speicherkarte als verbundene 
Laufwerke angezeigt.
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HINWEIS: Auf einigen Computern mit mehreren 
Netzlaufwerken können die Gerätelaufwerke möglicherweise 
nicht ordnungsgemäß angezeigt werden. Informationen zum 
Zuweisen von Laufwerkbuchstaben finden Sie in der 
Dokumentation des Betriebssystems.

2 Öffnen Sie auf dem Computer den Dateibrowser.
3 Wählen Sie eine Datei aus.
4 Wählen Sie Bearbeiten > Kopieren.
5 Öffnen Sie das tragbare Gerät oder Laufwerk für das Gerät 

oder die Speicherkarte.
6 Wechseln Sie zu einem Ordner.
7 Wählen Sie Bearbeiten > Einfügen.

Die Datei wird in der Liste der Dateien im Speicher des 
Geräts bzw. auf der Speicherkarte angezeigt.

Löschen von Dateien
HINWEIS

Wenn Sie sich über den Zweck einer Datei nicht im Klaren sind, 
löschen Sie die betreffende Datei nicht. Der Speicher des 
Geräts enthält wichtige Systemdateien, die nicht gelöscht 
werden dürfen.

1 Öffnen Sie das Laufwerk Garmin.
2 Öffnen Sie bei Bedarf einen Ordner.
3 Wählen Sie eine Datei aus.
4 Drücken Sie auf der Tastatur die Taste Entf.

HINWEIS: Wenn Sie einen Apple® Computer verwenden, 
müssen Sie den Papierkorb leeren, um die Dateien 
vollständig zu entfernen.

Entfernen des USB-Kabels
Wenn das Gerät als Wechseldatenträger an den Computer 
angeschlossen ist, müssen Sie es sicher vom Computer 
trennen, damit es nicht zu Datenverlusten kommt. Wenn das 
Gerät unter Windows als tragbares Gerät verbunden ist, muss 
es nicht sicher getrennt werden.
1 Führen Sie einen der folgenden Schritte aus:

• Windows: Klicken Sie in der Taskleiste auf das Symbol 
Hardware sicher entfernen, und wählen Sie das Gerät 
aus.

• Apple: Wählen Sie das Gerät aus und dann die Option 
Datei > Auswerfen.

2 Trennen Sie das Kabel vom Computer.

Technische Daten
Betriebstemperaturbereich -20 °C bis 70 °C (-4 °F bis 158 °F)
Funkfrequenz/Protokoll 2,4 GHz bei -1,13 dBm (nominal)

Anhang
Optionales Zubehör
Optionales Zubehör, z. B. Halterungen, Karten, Fitnesszubehör 
und Ersatzteile sind unter http://buy.garmin.com oder bei 
Garmin Händlern erhältlich.

Koppeln von ANT+ Sensoren
Vor der Kopplung müssen Sie den Herzfrequenzsensor anlegen 
oder den Sensor installieren.
Unter Koppeln wird das Herstellen einer Verbindung zwischen 
ANT+ Funksensoren verstanden, beispielsweise eines 
Herzfrequenzsensors mit dem Gerät.
1 Das Gerät muss sich in einer Entfernung von maximal 3 m 

(10 Fuß) zum Sensor befinden.

HINWEIS: Halten Sie beim Koppeln eine Entfernung von 
10 m (30 Fuß) zu anderen ANT+ Sensoren ein.

2 Wählen Sie in der Anwendungsschublade die Option 
Einstellungen > ANT-Sensor.

3 Wählen Sie den Sensor aus.
4 Wählen Sie Neu suchen....

Wenn der Sensor mit dem Gerät gekoppelt ist, ändert sich 
der Status des Sensors von Suche in Verbunden.

Tipps zum Koppeln von ANT+ Zubehör mit dem 
Garmin Gerät
• Vergewissern Sie sich, dass das ANT+ Zubehör mit dem 

Garmin Gerät kompatibel ist.
• Bevor Sie das ANT+ Zubehör mit dem Garmin Gerät 

koppeln, entfernen Sie sich 10 m (33 Fuß) aus der 
Reichweite anderer ANT+ Sensoren.

• Das Garmin Gerät muss sich in Reichweite 3 m (10 Fuß) des 
ANT+ Zubehörs befinden.

• Nach der ersten Kopplung erkennt das Garmin Gerät das 
ANT+ Zubehör bei jeder erneuten Aktivierung automatisch. 
Wenn das Zubehör aktiviert ist und ordnungsgemäß 
funktioniert, geschieht dies beim Einschalten des Garmin 
Geräts automatisch und dauert nur einige Sekunden.

• Nach der Kopplung empfängt das Garmin Gerät 
ausschließlich Daten von Ihrem Zubehör, auch wenn Sie sich 
in der Nähe von anderem Zubehör befinden.

Fehlerbehebung
Neustarten des Geräts
Wenn das Gerät nicht mehr reagiert, müssen Sie es 
möglicherweise neu starten. Durch diesen Vorgang werden 
keine Daten oder Einstellungen gelöscht.
1 Entfernen Sie die Batterien.
2 Setzen Sie die Batterien wieder ein.

Wiederherstellen aller Standardeinstellungen
Sie können alle Einstellungen auf die Werkseinstellungen 
zurücksetzen.

Wählen Sie Einstellungen > Zurücksetzen > Alle 
Einstellungen zurücksetzen > Ja.

Garmin Support-Center
Unter support.garmin.com finden Sie Unterstützung und 
Informationen, beispielsweise Produkthandbücher, häufig 
gestellte Fragen, Videos und Support.
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Introducción
 ADVERTENCIA

Consulta la guía Información importante sobre el producto y tu 
seguridad que se incluye en la caja del producto y en la que 
encontrarás advertencias e información importante sobre el 
producto.

Descripción general del dispositivo

Botones de zoom. Pulsa para acercar y alejar el mapa.

Botón de retroceso. Púlsalo para volver al menú anterior.

Thumb Stick™controlador. Muévete en la dirección que quieras 
para desplazarte o resaltar un elemento. Púlsalo para seleccionar 
un elemento.
Botón menu. Púlsalo para abrir el menú de una página. Púlsalo dos 
veces para volver al menú principal.
Selecciona  para ajustar la retroiluminación. Mantenlo pulsado 
para encender o apagar el dispositivo.
Puerto mini-USB (debajo de la tapa protectora).

Tapa de pilas.

Anillo de fijación de la tapa de pilas.

Carcasa de montaje.

Información sobre la batería
 ADVERTENCIA

El índice de temperatura del dispositivo puede exceder el rango 
de uso de algunas baterías. Las pilas alcalinas se pueden 
agrietar a altas temperaturas.

AVISO
Las pilas alcalinas también pierden una cantidad importante de 
su capacidad a medida que la temperatura desciende. Usa 
baterías de litio cuando utilices el dispositivo en condiciones de 
temperaturas extremadamente bajas.

Instalación de las pilas AA
El dispositivo de mano funciona con dos pilas AA (no incluidas). 
Utiliza pilas NiMH o de litio para obtener un resultado óptimo.
1 Gira la anilla en el sentido contrario a las agujas del reloj y 

tira de ella para extraer la tapa.
2 Introduce las dos pilas AA teniendo en cuenta la polaridad.

3 Vuelve a colocar la tapa de la batería y gira la anilla en el 
sentido de las agujas del reloj.

Selección del tipo de pilas/batería
1 En el menú principal, selecciona Ajustes > Sistema > Tipo 

de pila/batería.
2 Selecciona Alcalina, Litio o NiMH recargable.

Optimizar la autonomía de la batería
Puedes llevar a cabo diversas acciones para aumentar la 
autonomía de la batería.
• Reduce el brillo de la retroiluminación (Ajuste del brillo de la 

retroiluminación, página 7).
• Reduce la duración de la retroiluminación (Configurar la 

pantalla, página 9).
• Utiliza el modo ahorro de energía (Encendido del modo de 

ahorro de energía, página 1).
• Reduce la velocidad de trazado del mapa (Configurar el 

mapa, página 4).
• Desactiva GLONASS (GPS y otros sistemas de satélite, 

página 9).

Encendido del modo de ahorro de energía
Puedes utilizar el modo de ahorro de energía para prolongar la 
autonomía de la batería.

Selecciona Ajustes > Pantalla > Ahorro de energía > 
Activado.

En el modo de ahorro de energía, la pantalla se apaga cuando 
se agota el tiempo de espera de la retroiluminación. Puedes 
seleccionar  para encender la pantalla, y tocar dos veces 
para ver la página de estado.

Almacenamiento a largo plazo
Si no vas a utilizar el dispositivo durante varios meses, extrae 
las pilas/ batería. Los datos almacenados no se pierden al 
extraerlas.

Encendido del dispositivo
Mantén pulsado .

Buscar señales de satélite
El proceso de búsqueda de las señales del satélite puede durar 
entre 30 y 60 segundos.
1 Dirígete a un lugar al aire libre.
2 Enciende el dispositivo.
3 Espera mientras el dispositivo busca los satélites.

 parpadea mientras el dispositivo determina tu ubicación.
 muestra la intensidad de la señal del satélite.

Activar la retroiluminación
Selecciona cualquier botón para activar la retroiluminación.
La retroiluminación se activa automáticamente cuando se 
muestran alertas y mensajes.

Apertura del menú principal
El menú principal te proporciona acceso a herramientas y 
pantallas de configuración de waypoints, actividades, rutas y 
mucho más (Herramientas adicionales del menú principal, 
página 7).

Selecciona menu dos veces desde cualquier página.

Waypoints, rutas y tracks
Menú Destino
Puedes utilizar el menú Destino para buscar un destino y 
navegar hasta él. No todas las categorías de Destino estarán 
disponibles en todas las áreas y mapas.
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Buscar ubicaciones próximas a otra
1 Selecciona Destino > menu > Buscar cerca.
2 Selecciona una opción.
3 Selecciona una ubicación.

Waypoints
Los waypoints son ubicaciones que se graban y se guardan en 
el dispositivo. Los waypoints pueden marcar dónde estás, a 
dónde vas o dónde has estado. Puedes añadir detalles sobre la 
ubicación, como el nombre, la altura o la profundidad.
Puedes añadir un archivo .gpx que contenga waypoints 
transfiriendo el archivo a la carpeta GPX (Transferencia de 
archivos al dispositivo, página 11).

Creación de un punto intermedio
Puedes guardar la ubicación actual como punto intermedio.
1 Selecciona Marcar punto intermedio.
2 Si es necesario, selecciona un campo para realizar cambios 

en el punto intermedio.
3 Selecciona Hecho.

Proyectar un waypoint
Puedes crear una nueva ubicación proyectando la distancia y el 
rumbo desde una ubicación marcada hasta una ubicación 
nueva.
1 Selecciona Waypoint Manager.
2 Selecciona un waypoint.
3 Selecciona menu > Proyectar punto intermedio.
4 Introduce el rumbo y selecciona Hecho.
5 Selecciona una unidad de medida.
6 Introduce la distancia y selecciona Hecho.
7 Selecciona Guardar.

Navegar a un waypoint
1 Selecciona Destino > Puntos intermedios.
2 Selecciona un waypoint.
3 Selecciona Ir.

Buscar una ubicación por nombre
1 Selecciona Destino > Puntos intermedios > menu > 

Escribir búsqueda.
2 Introduce el nombre o parte del nombre.
3 Selecciona Ir.

Editar un waypoint
1 Selecciona Waypoint Manager.
2 Selecciona un waypoint.
3 Selecciona un elemento que quieras editar, como el nombre.
4 Introduce la nueva información y selecciona Ir.

Eliminación de un waypoint
1 Selecciona Waypoint Manager.
2 Selecciona un waypoint.
3 Selecciona menu > Borrar.

Promediar punto intermedio
Puedes depurar la ubicación de un punto intermedio para que 
sea más precisa. Al calcular el promedio, el dispositivo realiza 
varias lecturas de la misma ubicación y utiliza el valor promedio 
para proporcionar más precisión.
1 Selecciona Waypoint Manager.
2 Selecciona un punto intermedio.
3 Selecciona menu > Promediar ubicación.
4 Desplázate a la ubicación del punto intermedio.

5 Selecciona Iniciar.
6 Sigue las instrucciones que se muestran en la pantalla.
7 Cuando la barra de estado de confianza alcance el 100%, 

selecciona Guardar.
Para obtener un resultado óptimo, recoge de cuatro a ocho 
muestras para el punto intermedio, esperando al menos 90 
minutos entre unas y otras.

Rutas
Una ruta es una secuencia de puntos intermedios o ubicaciones 
que te llevan a tu destino final.

Creación de una ruta
1 Selecciona Planificador de ruta > Crear ruta > Seleccionar 

primer punto.
2 Selecciona una categoría.
3 Selecciona el primer punto de la ruta.
4 Selecciona Utilizar.
5 Selecciona Seleccionar siguiente punto para añadir puntos 

adicionales a la ruta.
6 Selecciona back para guardar la ruta.

Visualización de una ruta en el mapa
1 Selecciona Planificador de ruta.
2 Selecciona una ruta.
3 Selecciona Ver mapa.

Navegar por una ruta guardada
1 Selecciona Destino > Rutas.
2 Selecciona una ruta.
3 Selecciona Ir.

Visualización de la ruta activa
1 Mientras navegas por una ruta, selecciona Ruta activa.
2 Selecciona un punto de la ruta para ver detalles adicionales.

Edición del nombre de una ruta
1 Selecciona Planificador de ruta.
2 Selecciona una ruta.
3 Selecciona Cambiar nombre.
4 Introduce el nombre nuevo.

Edición de una ruta
1 Selecciona Planificador de ruta.
2 Selecciona una ruta.
3 Selecciona Editar ruta.
4 Selecciona un punto.
5 Selecciona una opción:

• Para ver el punto en el mapa, selecciona Revisar.
• Para cambiar el orden de los puntos en la ruta, selecciona 

Mover hacia arriba o Mover hacia abajo.
• Para introducir un punto adicional en la ruta, selecciona 

Insertar.
El punto adicional se introduce antes del punto que estás 
editando.

• Para borrar el punto de la ruta, selecciona Borrar.
6 Selecciona back para guardar la ruta.

Eliminación de una ruta
1 Selecciona Planificador de ruta.
2 Selecciona una ruta.
3 Selecciona Borrar ruta.
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Inversión de una ruta
Puedes cambiar los puntos de inicio y final de tu ruta para 
navegar por ella en orden inverso.
1 Selecciona Planificador de ruta.
2 Selecciona una ruta.
3 Selecciona Invertir ruta.

Detención de la navegación
Selecciona Destino > Detener navegación.

Tracks
Un track es una grabación del recorrido. El track log contiene 
información sobre los puntos del recorrido grabado, como por 
ejemplo el tiempo, la ubicación y la altura de cada punto. De 
forma predeterminada, el dispositivo crea un track log mientras 
te mueves, siempre que esté encendido.

Grabación de track logs
1 En el menú principal, selecciona Ajustes > Tracks > Track 

log.
2 Selecciona Grabación, no mostrar o Grabación, mostrar.

Si seleccionas Grabación, mostrar, aparecerá una línea en el 
mapa que indicará el track.

3 Selecciona Método de grabación.
4 Selecciona una opción:

• Para grabar tracks a una velocidad variable y crear una 
representación óptima de estos, selecciona Auto.

• Para grabar tracks a una distancia específica, selecciona 
Distancia.

• Para grabar tracks a una hora específica, selecciona 
Tiempo.

5 Selecciona Intervalo de grabación.
6 Realiza una de las siguientes acciones:

• Si seleccionas Auto en Método de grabación, selecciona 
una opción para grabar tracks con más o menos 
frecuencia.

NOTA: el intervalo Más frecuente grabará la mayor cantidad 
posible de detalles del track, pero llenará antes la memoria 
del dispositivo.
• Si has seleccionado Distancia u Tiempo en Método de 

grabación, introduce un valor.
A medida que te mueves con el dispositivo encendido, se crea 
un track log.

Visualizar el track actual
1 Selecciona Track Manager > Track actual.
2 Selecciona una opción:

• Para que el track actual se muestre en el mapa, 
selecciona Ver mapa.

• Para que se muestre la gráfica de altura correspondiente 
al track actual, selecciona Gráfica de altura.

Almacenamiento del track actual
1 Selecciona Track Manager > Track actual.
2 Selecciona una opción:

• Selecciona Guardar track para guardar el track actual.
• Selecciona Guardar parte y selecciona una parte.

Navegar por un track guardado
1 Selecciona Destino > Tracks.
2 Selecciona un track guardado.
3 Selecciona Ir.

Suprimir el track actual
Selecciona Track Manager > Track actual > Borrar track 
actual.

Eliminación de un track
1 Selecciona Track Manager.
2 Selecciona un track.
3 Selecciona Borrar.

Configurar la página Tracks
Selecciona Ajustes > Tracks.
Track log: activa y desactiva la grabación de tracks.
Método de grabación: establece un método de grabación de 

tracks. Auto graba los tracks a una velocidad variable para 
crear una representación óptima de los tracks.

Intervalo de grabación: establece una velocidad de grabación 
del track log. Si se graban puntos con mayor frecuencia se 
crea un track más detallado, pero el track log se llena más 
rápidamente.

Borrar track actual: borra la memoria del track actual.
Configuración avanzada > Archivado automático: establece 

un método de archivo automático para organizar tus tracks. 
Los tracks se guardan y borran automáticamente.

Configuración avanzada > Color: cambia el color de la línea 
del track en el mapa.

Compra de mapas adicionales
1 Visita la página del dispositivo en garmin.com.
2 Haz clic en la ficha Mapas.
3 Sigue las instrucciones que se muestran en la pantalla.

Búsqueda de direcciones
Puedes utilizar los mapas opcionales de City Navigator® para 
buscar direcciones.
1 Selecciona Destino > Direcciones.
2 Selecciona el país o la región, si es necesario.
3 Introduce la ciudad o el código postal.

NOTA: la opción de búsqueda de código postal no está 
disponible en todos los datos de mapas.

4 Selecciona la ciudad.
5 Introduce el número.
6 Introduce la calle.

Navegación
Puedes navegar a una ruta, track, waypoint, geocaché o a 
cualquier otra ubicación guardada en el dispositivo. Puedes 
utilizar el mapa o la brújula para llegar a tu destino.

Navegar a un destino
1 Selecciona Destino.
2 Selecciona una categoría.
3 Si es necesario, seleccione menu > Escribir búsqueda e 

introduzca el nombre del destino entero o en parte.
4 Selecciona un destino.
5 Selecciona Ir.

La ruta aparece como una línea magenta en el mapa.
6 Navega utilizando el mapa (Navegar con el mapa, 

página 4) o la brújula (Navegar con la brújula, página 4).

Navegar con Sight 'N Go
Puedes apuntar con el dispositivo a un objeto en la distancia, 
fijar la dirección y, a continuación, navegar al objeto.
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NOTA: sight 'N Go solo está disponible para dispositivos de la 
eTrex 32x.
1 Selecciona Sight 'N' Go.
2 Apunta con el dispositivo a un objeto.
3 Selecciona Fijar dirección > Establecer trayecto.
4 Navega utilizando la brújula.

Configuración del rumbo
Puedes personalizar la configuración de la brújula.
Selecciona Ajustes > Rumbo.
Pantalla: establece el tipo de rumbo direccional que se muestra 

en la brújula.
Referencia norte: establece la referencia del norte que utiliza la 

brújula.
Línea Goto/Puntero: establece el comportamiento del puntero 

que aparece en el mapa. Rumbo al punto intermedio apunta 
hacia la dirección de tu destino. Trayecto muestra tu relación 
respecto a la línea de trayecto que conduce al destino.

Brújula: cambia automáticamente de una brújula electrónica a 
una brújula GPS cuando te desplazas a una velocidad mayor 
durante un periodo de tiempo determinado.

Calibrar brújula: consulta Calibrar el compás, página 4.

Mapa
 representa tu ubicación en el mapa. A medida que te 

desplazas,  se mueve y deja un track log (rastro). Los nombres 
y los símbolos de los puntos intermedios aparecen en el mapa. 
Mientras navegas a un destino, tu ruta se marca con una línea 
de color en el mapa.

Navegar con el mapa
AVISO

Los mapas incluidos en el dispositivo pueden crear rutas 
ciclistas o peatonales con caminos y senderos, pero no rutas de 
navegación para automóvil.

1 Comienza a navegar hacia un destino.
2 Selecciona Mapa.

 representa tu ubicación en el mapa. Tu ruta se marca con 
una línea de color.

3 Lleva a cabo una o más de las siguientes acciones:
• Utiliza el controlador Thumb Stick para desplazar el cursor 

en el mapa para ver las diferentes áreas.
• Para acercar y alejar la imagen del mapa, selecciona  y 

.

Cambio de la orientación del mapa
1 En el mapa, selecciona menu.
2 Selecciona Configurar mapa > Orientación.
3 Selecciona una opción:

• Selecciona Norte arriba para mostrar el norte en la parte 
superior de la página.

• Selecciona Track arriba para mostrar la dirección de 
desplazamiento actual en la parte superior de la página.

• Selecciona Modo para automóvil para mostrar una 
perspectiva para automóvil con la dirección de 
desplazamiento en la parte superior.

Medición de distancia en el mapa
Puedes medir la distancia entre dos ubicaciones.
1 En el mapa, selecciona una ubicación.
2 Selecciona menu > Medir distancia.
3 Mueve la marca a otra ubicación en el mapa.

Configurar el mapa
Selecciona Ajustes > Mapa.
Orientación: ajusta el modo en que se muestra el mapa en la 

página. Norte arriba muestra el norte en la parte superior de 
la página. Track arriba muestra una vista de arriba a abajo 
con tu dirección de desplazamiento actual hacia la parte 
superior de la página. Modo para automóvil muestra una 
vista para automóvil en 3D con la dirección de 
desplazamiento en la parte superior.

Campos de datos: personaliza los campos de datos y los 
controles del mapa, de la brújula, de la gráfica de altura y del 
procesador de ruta.

Configuración avanzada del mapa: te permite acceder a la 
configuración avanzada del mapa (Configurar el mapa, 
página 4).

Información de mapa: activa o desactiva los mapas cargados 
actualmente en el dispositivo.

Configuración avanzada del mapa
Selecciona Ajustes > Mapa > Configuración avanzada del 
mapa.
Zoom automático: selecciona automáticamente el nivel de 

zoom pertinente para un uso óptimo en el mapa. Cuando la 
opción Desactivado está seleccionada, debes acercar y 
alejar la imagen manualmente.

Niveles de zoom: ajusta el nivel de zoom en el que se 
muestran los elementos del mapa. Los elementos del mapa 
no aparecerán si el nivel de zoom del mapa es superior al 
nivel seleccionado.

Tamaño del texto: selecciona el tamaño del texto para los 
elementos de mapa.

Detalles: selecciona el nivel de detalle del mapa. Si optas por 
que se muestre un nivel de detalle más elevado, es posible 
que el mapa tarde más en volver a dibujarse.

Relieve sombreado: muestra los detalles del mapa en relieve 
(si está disponible) o desactiva el sombreado.

Brújula
Mientras navegas,  indica el destino, independientemente de la 
dirección en la que te muevas. Si  apunta hacia la parte 
superior de la brújula electrónica, significa que te estás 
desplazando directamente hacia tu destino. Si  apunta hacia 
cualquier otra dirección, gira hasta que señale hacia la parte 
superior de la brújula.

Calibrar el compás
El dispositivo tiene una brújula electrónica de tres ejes (solo 
dispositivos de la serie eTrex 32x). Deberás calibrar la brújula 
después de haberte desplazado largas distancias si has 
experimentado cambios de temperatura o has cambiado las 
pilas.
1 Colócate en un sitio alejado de objetos que influyan en 

campos magnéticos, tales como automóviles, edificios o 
tendidos eléctricos.

2 En la brújula, selecciona menu.
3 Selecciona Calibrar brújula > Iniciar.
4 Sigue las instrucciones que se muestran en la pantalla.

Navegar con la brújula
Cuando navegas a un destino,  señala al destino, 
independientemente de la dirección en la que te estés 
desplazando.
1 Comienza la navegación hacia un destino (Navegar a un 

destino, página 3).
2 Selecciona Brújula.
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3 Gírala hasta que  apunte hacia la parte superior de la 
brújula y continúa moviéndote en esa dirección hasta llegar 
al destino.

Puntero de trayecto
El puntero de trayecto resulta de especial utilidad si te 
desplazas por agua o en zonas en las que no existan 
obstáculos en el recorrido. También puede ayudarte a evitar 
peligros en el trayecto como, por ejemplo, bajíos o rocas 
sumergidas.
Para activar el puntero de trayecto, desde la brújula selecciona 
menu > Configurar rumbo > Línea Goto/Puntero > Trayecto 
(CDI).

El puntero de trayecto  indica tu relación con la línea de 
trayecto que conduce al destino. El indicador de desvío de 
trayecto (CDI)  proporciona la indicación de desvío (derecha o 
izquierda) de trayecto. La escala  corresponde a la distancia 
existente entre los puntos  del indicador de desvío de 
trayecto, que te indica a cuánta distancia de desvío de trayecto 
estás.

Gráfica de altura
NOTA: la gráfica de altura solo está disponible para dispositivos 
de la eTrex 32x.
De forma predeterminada, la gráfica de altura muestra la altura 
de la distancia recorrida. Puedes personalizar la configuración 
de la gráfica de altura (Configurar la gráfica de altura, 
página 5). Puedes seleccionar cualquier punto de la gráfica 
para ver detalles sobre dicho punto.

Calibrar el altímetro barométrico
Puedes calibrar el altímetro barométrico de forma manual si 
conoces la altitud o la presión barométrica correctas.
1 Dirígete a una ubicación en la que conozcas la altitud o la 

presión barométrica.
2 Selecciona Gráfica de altura > menu > Calibrar altímetro.
3 Sigue las instrucciones que se muestran en la pantalla.

Configurar la gráfica de altura
En la gráfica de altura, selecciona menu.
Cambiar tipo de gráfica: define el tipo de datos que se 

muestran en la gráfica de altura. .
Ajustar escalas de zoom: ajusta las escalas de zoom que se 

muestran en la página Altímetro.
Cambiar campos de datos: permite personalizar los campos 

de datos del altímetro.
Restablecer: restablece los datos del altímetro, incluidos los 

relacionados con waypoints, tracks y trayectos.
Calibrar altímetro: consulta (Calibrar el altímetro barométrico, 

página 5).
Restablecer a valores predeterminados: restablece el 

altímetro a la configuración predeterminada de fábrica.

Procesador de ruta
El procesador de ruta muestra la velocidad actual, la velocidad 
media, el cuentakilómetros de ruta y otras estadísticas útiles. 
Puedes personalizar el diseño del procesador de ruta, los 
controles y los campos de datos.

Configurar el procesador de ruta
En la página del procesador de ruta, selecciona menu.
Restablecer: restablece todos los valores del procesador de 

ruta a cero. Para que la información sea precisa, restablece 
la información de ruta antes de emprender una ruta.

Números grandes: cambia el tamaño de los números que se 
muestran en la página del procesador de ruta.

Cambiar campos de datos: personaliza los campos de datos 
del procesador de ruta.

Cambiar salpicadero: cambia el tema y la información que se 
muestra en los controles.
NOTA: los controles recuerdan la configuración 
personalizada. La configuración no se pierde cuando 
cambias de perfil (Perfiles, página 9).

Restablecer a valores predeterminados: restablece el 
procesador de ruta a la configuración predeterminada de 
fábrica.

Restablecimiento de la configuración 
predeterminada de la página
1 Abre la página en la que quieras restablecer la configuración.
2 Selecciona menu > Restablecer a valores 

predeterminados.

Funciones y configuración del menú 
principal

Geocachés
Geocaching es una actividad de búsqueda de tesoros en la que 
los jugadores esconden o buscan cachés escondidos a través 
de pistas y coordenadas GPS.

Descargar geocachés desde un ordenador
Puedes cargar geocachés manualmente en tu dispositivo 
utilizando un ordenador (Transferencia de archivos al 
dispositivo, página 11). Puedes colocar los archivos de 
geocaché en un archivo GPX e importarlos a la carpeta GPX del 
dispositivo. Con una suscripción premium a geocaching.com, 
puedes utilizar la función "pocket query" para cargar un gran 
número de geocachés en tu dispositivo como un único archivo 
GPX.
1 Conecta el dispositivo al ordenador mediante un cable USB.
2 Visita www.geocaching.com.
3 Si es necesario, crea una cuenta.
4 Inicia sesión.
5 Sigue las instrucciones que aparecen en geocaching.com 

para encontrar y descargar los geocachés en tu dispositivo.

Navegar hacia un geocaché
1 Selecciona Geocachés.
2 Selecciona un geocaché.
3 Selecciona Ir.
Registrar intentos
Después de intentar encontrar un geocaché, puedes registrar 
los resultados. Puedes verificar algunos geocachés en 
www.geocaching.com.
1 Selecciona Geocachés > Registrar intento.
2 Selecciona Encontrado, No se encuentra, Requiere una 

reparación, o No intentado.
3 Selecciona una opción:

• Para dejar de registrar, selecciona Hecho.
• Para comenzar la navegación hacia el geocaché más 

próximo, selecciona Buscar más próximo.
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• Para introducir un comentario sobre la búsqueda de un 
caché o del propio caché, selecciona Añadir comentario, 
introduce un comentario y selecciona Hecho.

Si has iniciado sesión en www.geocaching.com, el registro se 
carga a tu cuenta de www.geocaching.com de forma 
automática.

chirp™

Un chirp es un pequeño accesorio de Garmin® que se programa 
y se deja en un geocaché. Puedes utilizar tu dispositivo para 
buscar un chirp en un geocaché. Para obtener más información 
acerca del chirp, consulta el Manual del usuario del chirp en 
www.garmin.com.
Activar la búsqueda de chirp
1 Selecciona Ajustes > Geocachés.
2 Selecciona Búsqueda de chirp™ > Activado.

Envío y recepción de datos de forma 
inalámbrica
Para poder compartir datos de forma inalámbrica, debes estar a 
3 m (10 pies) de un dispositivo compatible.
Tu dispositivo puede enviar o recibir datos cuando está 
vinculado a otro dispositivo o smartphone compatible mediante 
la tecnología inalámbrica ANT+®. Puedes compartir waypoints, 
geocachés, rutas y tracks.
NOTA: esta función no está disponible para todos los modelos 
de dispositivo.
1 Selecciona Compartir inalámbricamente.
2 Selecciona una opción:

• Selecciona Enviar y selecciona el tipo de datos.
• Selecciona Recibir para recibir datos de otro dispositivo. 

El otro dispositivo compatible deberá estar intentando 
enviar datos.

3 Sigue las instrucciones que se muestran en la pantalla.

Configurar una alarma de proximidad
Las alarmas de proximidad te avisan cuando estás dentro de 
una distancia concreta de una ubicación específica.
1 Selecciona Alarmas de proximidad > Crear alarma.
2 Selecciona una categoría.
3 Selecciona una ubicación.
4 Selecciona Utilizar.
5 Introduce un radio.
Al entrar en un área con una alarma de proximidad, el 
dispositivo emitirá un tono.

Cálculo del tamaño de un área
1 Selecciona Cálculo del área > Iniciar.
2 Camina por el perímetro del área que desees calcular.
3 Selecciona Calcular cuando hayas terminado.

Página Satélite
La página Satélite muestra tu ubicación actual, la precisión del 
GPS, las ubicaciones de los satélites y la intensidad de la señal.

Configurar satélites GPS
Selecciona Satélite > menu.
NOTA: algunos ajustes solo están disponibles cuando está 
activada la opción Utilizar modo demo.
Utilizar modo demo: te permite desactivar el GPS.
Utilizar sistema de satélite: te permite activar el GPS.

Track arriba: indica si los satélites se muestran con los anillos 
orientados con el norte hacia la parte superior de la pantalla 
o con el track actual hacia la parte superior de la misma.

Color único: te permite seleccionar si la página de satélites se 
muestra en varios colores o en un único color.

Establecer ubicación en el mapa: te permite marcar tu 
ubicación actual en el mapa. Puedes utilizar esta ubicación 
para crear rutas o buscar ubicaciones guardadas.

Posición de AutoLocate: calcula tu posición GPS a través de 
la función AutoLocate® de Garmin.

Garmin Adventures
Puedes agrupar todos los elementos relacionados en una 
aventura. Por ejemplo, puedes crear una aventura para tu 
última excursión. La aventura puede contener el track log, fotos 
y geocachés encontrados durante el viaje. Puedes utilizar 
BaseCamp™ para crear y gestionar tus aventuras.
NOTA: BaseCamp no está disponible en todos los modelos de 
dispositivo.

Envío de archivos a BaseCamp
1 Abre BaseCamp.
2 Conecta el dispositivo al ordenador.

En equipos Windows®, el dispositivo aparecerá como una 
unidad extraíble o un dispositivo portátil y es posible que la 
tarjeta de memoria aparezca como una segunda unidad 
extraíble. En equipos Mac®, el dispositivo y la tarjeta de 
memoria aparecerán como volúmenes montados.
NOTA: es posible que algunos ordenadores con varias 
unidades en red no muestren las unidades del dispositivo 
adecuadamente. Consulta la documentación del sistema 
operativo para obtener más información sobre cómo asignar 
la unidad.

3 Abre la unidad o el volumen de Garmin o de la tarjeta de 
memoria.

4 Selecciona una opción:
• Selecciona un elemento desde un dispositivo conectado y 

arrástralo hasta Mi colección o a una lista.
• Desde BaseCamp, selecciona Dispositivo > Recibir 

desde el dispositivo y, a continuación, selecciona el 
dispositivo.

Creación de una aventura
Para crear una aventura y enviarla a tu dispositivo, debes 
descargar BaseCamp al ordenador y transferir un track del 
dispositivo al ordenador (Envío de archivos a BaseCamp, 
página 6).
1 Abre BaseCamp.
2 Selecciona Archivo > Nuevo > Aventura de Garmin.
3 Selecciona un track y selecciona Siguiente.
4 Si es necesario, añade elementos de BaseCamp.
5 Completa los campos necesarios para asignar un nombre y 

describir la aventura.
6 Si deseas cambiar la fotografía de portada de la aventura, 

selecciona Cambiar y elige una fotografía diferente.
7 Selecciona Finalizar.

Inicio de una aventura
Para empezar una aventura, debes enviar una aventura de 
BaseCamp a tu dispositivo (Envío de archivos a BaseCamp, 
página 6).
1 Selecciona Aventuras.
2 Selecciona una aventura.
3 Selecciona Iniciar.
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Mando a distancia para VIRB®

NOTA: la función de mando a distancia para VIRB solo está 
disponible para dispositivos de la eTrex 32x.
Para poder utilizar la función Mando a distancia para VIRB, 
debes activar la configuración del mando en la cámara VIRB.
La función Mando a distancia para VIRB te permite controlar la 
cámara VIRB de forma remota.
1 Selecciona Mando a distancia para VIRB.
2 Selecciona una opción:

• Selecciona REC para grabar vídeo.
• Selecciona Hacer foto para hacer una fotografía.

Herramientas adicionales del menú principal
Alarma: establece alarmas sonoras. Si no vas a utilizar el 

dispositivo en ese momento, puedes configurarlo para que 
se encienda a una hora determinada.

Calculadora: muestra una calculadora.
Calendario: muestra un calendario.
Caza y pesca: indica las mejores fechas y horas previstas para 

cazar y pescar en la ubicación actual.
Cronómetro: permite utilizar el cronómetro, marcar una vuelta y 

cronometrar vueltas.
Sol y luna: muestra las horas de la salida y la puesta de sol, así 

como las fases de la luna, en función de tu posición GPS.

Personalización del dispositivo
Ajuste del brillo de la retroiluminación
El uso continuado de la retroiluminación de la pantalla puede 
reducir significativamente la autonomía de las pilas/batería. 
Puedes ajustar el brillo de la retroiluminación para prolongar la 
autonomía de las pilas/batería.
NOTA: el brillo de la retroiluminación se puede limitar cuando el 
nivel de energía de las pilas/batería es bajo.
1 Selecciona .
2 Utiliza el control deslizante para ajustar el nivel de 

retroiluminación.
El dispositivo puede notarse caliente cuando la configuración de 
la retroiluminación tiene un valor alto.

Personalizar el menú principal
Puedes mover, añadir y borrar elementos del menú principal.
1 En el menú principal, selecciona menu > Cambiar orden de 

elementos.
2 Selecciona un elemento del menú.
3 Selecciona una opción:

• Selecciona Mover para cambiar la posición del elemento 
en la lista.

• Selecciona Insertar para añadir un nuevo elemento a la 
lista.

• Selecciona Borrar para eliminar un elemento de la lista.

Cambiar el orden de las páginas
Para cambiar el orden de la secuencia de páginas, primero 
deberás añadir páginas a la secuencia.
1 Selecciona Ajustes > Secuencia de páginas.
2 Selecciona una página.
3 Selecciona Mover.
4 Sube o baja la página en la lista.
5 Pulsa el controlador Thumb Stick.

Añadir una página
1 Selecciona Ajustes > Secuencia de páginas.
2 Selecciona Añadir página.
3 Selecciona la página que desees añadir.

Eliminar una página
1 Selecciona Ajustes > Secuencia de páginas.
2 Selecciona una página.
3 Selecciona Borrar.
4 Pulsa el controlador Thumb Stick.

Personalización de los campos de datos
Puedes personalizar los campos de datos que aparecen en 
cada página principal.
1 Abre la página en la que quieras modificar los campos de 

datos.
2 Selecciona menu.
3 Selecciona Cambiar campos de datos.
4 Selecciona el campo de datos nuevo.
5 Sigue las instrucciones que se muestran en la pantalla.

Campos de datos
Algunos campos de datos requieren que te estés desplazando o 
necesitan accesorios ANT+ para mostrar los datos.
Altura: altitud de la ubicación actual por encima o por debajo 

del nivel del mar.
Altura - Máxima: altura más alta alcanzada desde la última 

puesta a cero.
Altura - Mínima: altura más baja alcanzada desde la última 

puesta a cero.
Altura sobre el terreno: altitud de la ubicación actual sobre el 

nivel del suelo (en caso de que los mapas contengan 
información de altura suficiente).

Amanecer: hora a la que amanece según la posición GPS.
Ascenso - Máximo: nivel de ascenso máximo en pies o metros 

por minuto desde la última puesta a cero.
Ascenso - Media: distancia vertical media de ascenso desde la 

última puesta a cero.
Ascenso - Total: distancia de altura total ascendida desde la 

última puesta a cero.
Atardecer: hora a la que anochece según la posición GPS.
Barómetro: presión actual calibrada.
Cadencia: número de revoluciones de la biela o número de 

zancadas por minuto. El dispositivo debe estar conectado a 
un accesorio de cadencia para que aparezcan estos datos.

Cuentakilómetros: cuenta total de la distancia recorrida en 
todas las rutas. El total no se suprime al restablecer los datos 
de la ruta.

Cuentakilómetros de ruta: cuenta total de la distancia 
recorrida desde la última puesta a cero.

Descenso - Máximo: nivel de descenso máximo en pies o 
metros por minuto desde la última puesta a cero.

Descenso - Media: distancia vertical media de descenso desde 
la última puesta a cero.

Descenso - Total: distancia de altura total descendida desde la 
última puesta a cero.

Desvío de trayecto: distancia hacia la izquierda o la derecha 
por la que te has desviado respecto de la ruta original del 
trayecto. Debes estar desplazándote para que aparezcan 
estos datos.

Distancia del track: distancia recorrida en el track actual.
Distancia de vuelta: distancia recorrida en la vuelta actual.
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Distancia hasta destino: distancia restante hasta el destino 
final. Debes estar desplazándote para que aparezcan estos 
datos.

Distancia hasta siguiente: distancia restante hasta el siguiente 
punto intermedio de la ruta. Debes estar desplazándote para 
que aparezcan estos datos.

Distancia vertical a destino: distancia de altura entre la 
posición actual y el destino final. Debes estar desplazándote 
para que aparezcan estos datos.

ETA a destino: hora del día estimada a la que llegarás al 
destino final (ajustada a la hora local del destino). Debes 
estar desplazándote para que aparezcan estos datos.

ETA a siguiente: hora del día estimada a la que llegarás al 
siguiente punto intermedio de la ruta (ajustada a la hora local 
del punto intermedio). Debes estar desplazándote para que 
aparezcan estos datos.

Factor de planeo: factor de distancia horizontal recorrida hasta 
el cambio en la distancia vertical.

Factor de planeo a destino: factor de planeo necesario para 
descender desde la posición actual hasta la altura del 
destino. Debes estar desplazándote para que aparezcan 
estos datos.

Fecha: día, mes y año actual.
Frecuencia cardiaca: frecuencia cardiaca en pulsaciones por 

minuto (ppm). El dispositivo debe estar conectado a un 
monitor de frecuencia cardiaca compatible.

Giro: ángulo de diferencia (en grados) entre el rumbo hacia tu 
destino y el trayecto actual. L significa girar a la izquierda. R 
significa girar a la derecha. Debes estar desplazándote para 
que aparezcan estos datos.

Hora del día: hora actual del día según tu ubicación actual y la 
configuración de la hora (formato, huso horario y horario de 
verano).

Intensidad de la señal GPS: intensidad de la señal del satélite 
GPS.

Límite de velocidad: límite de velocidad indicado para 
carretera. No disponible en todos los mapas ni en todas las 
áreas. Sigue siempre las señales de circulación de los límites 
de velocidad vigentes de la carretera.

Media de vueltas: tiempo medio por vuelta durante la actividad 
actual.

Nivel de la batería: carga restante de la batería.
Precisión de GPS: margen de error de la ubicación exacta. Por 

ejemplo, tu ubicación GPS tiene una precisión de 3,65 m (+/- 
12 ft).

Presión atmosférica: presión atmosférica actual sin calibrar.
Profundidad: profundidad del agua. El dispositivo debe estar 

conectado a un dispositivo NMEA® 0183 o NMEA 2000® que 
pueda detectar la profundidad del agua.

Puntero: una flecha indica la dirección del siguiente punto 
intermedio o giro. Debes estar desplazándote para que 
aparezcan estos datos.

Punto intermedio en destino: último punto de la ruta al 
destino. Debes estar desplazándote para que aparezcan 
estos datos.

Punto intermedio en siguiente: siguiente punto de la ruta. 
Debes estar desplazándote para que aparezcan estos datos.

Rumbo: dirección hacia un destino desde tu ubicación actual. 
Debes estar desplazándote para que aparezcan estos datos.

Rumbo: dirección en la que te desplazas.
Rumbo de brújula: dirección en la que te desplazas según la 

brújula.
Temperatura: temperatura del aire. Tu temperatura corporal 

afecta a la temperatura del sensor. El dispositivo debe estar 

conectado a un sensor de temperatura inalámbrico para que 
aparezcan estos datos.

Temperatura - Agua: temperatura del agua. El dispositivo debe 
estar conectado a un dispositivo NMEA 0183 que pueda 
detectar la temperatura del agua.

Temperatura máxima en las últimas 24 horas: temperatura 
máxima registrada en las últimas 24 horas. El dispositivo 
debe estar conectado a un sensor de temperatura 
inalámbrico para que aparezcan estos datos.

Temperatura mínima en las últimas 24 horas: temperatura 
mínima registrada en las últimas 24 horas. El dispositivo 
debe estar conectado a un sensor de temperatura 
inalámbrico para que aparezcan estos datos.

Temporizador de la alarma: tiempo actual del temporizador de 
cuenta atrás.

Temporizador del cronómetro: tiempo de cronómetro de la 
actividad actual.

Tiempo de ruta: cuenta total del tiempo total empleado 
mientras te desplazas y mientras estás detenido desde la 
última puesta a cero.

Tiempo de ruta - Detenido: cuenta total del tiempo empleado 
mientras estás detenido desde la última puesta a cero.

Tiempo de ruta - En movimiento: cuenta total del tiempo 
empleado mientras te desplazas desde la última puesta a 
cero.

Tiempo de última vuelta: tiempo de cronómetro de la última 
vuelta completa.

Tiempo hasta destino: tiempo restante estimado para llegar al 
destino. Debes estar desplazándote para que aparezcan 
estos datos.

Tiempo hasta siguiente: tiempo restante estimado para llegar 
al siguiente punto intermedio de la ruta. Debes estar 
desplazándote para que aparezcan estos datos.

Total de vueltas: tiempo de cronómetro de todas las vueltas 
completadas.

Trayecto: dirección hacia un destino desde la ubicación de 
inicio. El trayecto puede visualizarse como ruta planificada o 
establecida. Debes estar desplazándote para que aparezcan 
estos datos.

Ubicación (lat/lon): posición actual en longitud y latitud, sin 
tener en cuenta la configuración de formato de posición 
seleccionada.

Ubicación (seleccionada): posición actual utilizando la 
configuración de formato de posición seleccionada.

Ubicación del destino: posición del destino final. Debes estar 
desplazándote para que aparezcan estos datos.

Velocidad: velocidad de desplazamiento actual.
Velocidad de avance al punto intermedio: velocidad a la que 

te aproximas a un destino siguiendo una ruta. Debes estar 
desplazándote para que aparezcan estos datos.

Velocidad - Máxima: velocidad más elevada alcanzada desde 
la última puesta a cero.

Velocidad - Media en movimiento: velocidad media al 
desplazarte desde la última puesta a cero.

Velocidad - Media total: velocidad media al desplazarte y 
detenerte desde la última puesta a cero.

Velocidad vertical: nivel de ascenso o descenso a lo largo del 
tiempo.

Velocidad vertical a destino: nivel de ascenso o descenso 
hasta una altitud predeterminada. Debes estar 
desplazándote para que aparezcan estos datos.

Volver a trayecto: dirección en la que te desplazas para volver 
a la ruta. Debes estar desplazándote para que aparezcan 
estos datos.
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Vuelta actual: tiempo de cronómetro de la vuelta actual.
Vueltas: número de vueltas completadas durante la actividad 

actual.

Perfiles
Los perfiles son un conjunto de parámetros de configuración 
que te permiten optimizar tu dispositivo en función de la 
actividad realizada. Por ejemplo, la configuración y las vistas 
son diferentes cuando utilizas el dispositivo para cazar que 
cuando lo utilizas para geocaching.
Cuando estás utilizando un perfil y cambias la configuración, 
como los campos de datos o las unidades de medida, los 
cambios se guardan automáticamente como parte del perfil.

Creación de un perfil personalizado
Puedes personalizar la configuración y los campos de datos de 
una actividad o ruta concretas.
1 Selecciona Ajustes > Perfiles > Crear perfil > OK.
2 Personaliza la configuración y los campos de datos.

Selección de un perfil
Cuando cambias de actividad, puedes cambiar la configuración 
del dispositivo cambiando el perfil.
1 Selecciona Cambio de perfil.
2 Selecciona un perfil.

Edición del nombre de un perfil
1 Selecciona Ajustes > Perfiles.
2 Selecciona un perfil.
3 Selecciona Editar nombre.
4 Introduce el nombre nuevo.

Eliminación de un perfil
NOTA: para poder eliminar un perfil activo, debes activar un 
perfil diferente. No puedes eliminar un perfil mientras esté 
activo.
1 Selecciona Ajustes > Perfiles.
2 Selecciona un perfil.
3 Selecciona Borrar.

Configurar el sistema
Selecciona Ajustes > Sistema.
Sistema de satélite: establece el sistema de satélite (GPS y 

otros sistemas de satélite, página 9).
WAAS/EGNOS: configura el sistema para que utilice datos del 

Sistema de aumento de área amplia/Servicio de 
superposición de navegación geoestacionario europeo 
(WAAS/EGNOS, del inglés Wide Area Augmentation System/
European Geostationary Navigation Overlay Service).

Idioma: establece el idioma del texto del dispositivo.
NOTA: al cambiar el idioma del texto, no se modifica el 
idioma de los datos de mapas o de los datos introducidos por 
el usuario, como los nombres de las calles.

Tipo de pila/batería: permite seleccionar el tipo de pilas AA que 
estás utilizando.

Modo USB: configura el dispositivo para utilizar el modo de 
almacenamiento masivo o el modo de Garmin cuando se 
conecta al ordenador.

GPS y otros sistemas de satélite
El uso conjunto de la función GPS y otros sistemas de satélite 
ofrece un rendimiento mejorado en entornos difíciles y permite 
adquirir la posición de forma más rápida que si se utilizara solo 
el GPS. No obstante, la utilización de varios sistemas puede 
reducir la autonomía de la batería más rápidamente que si se 
utilizara solo el GPS.

El dispositivo puede utilizar los sistemas globales de 
navegación por satélite (GNSS).
GPS: una constelación de satélites construida por los Estados 

Unidos.
GLONASS: una constelación de satélites construida por Rusia.

Configurar la pantalla
Selecciona Ajustes > Pantalla.
Duración de la retroiluminación: ajusta el tiempo que tarda en 

desactivarse la retroiluminación.
Ahorro de energía: prolonga la autonomía de las pilas al 

apagar la pantalla cuando se agota el tiempo de espera de la 
retroiluminación.

Colores: cambia la apariencia del fondo de pantalla y de la 
marca que resalta tu selección.

Captura de pantalla: te permite guardar la imagen de la 
pantalla del dispositivo.

Configuración de los tonos del dispositivo
Puedes personalizar los tonos de los mensajes, botones, avisos 
de giro y alarmas.
1 Selecciona Ajustes > Tonos > Tonos > Activado.
2 Selecciona un tono para cada tipo de sonido audible.

Cambio de las unidades de medida
Puedes personalizar las unidades de medida que se utilizan 
para la distancia y la velocidad, la altura, la profundidad, la 
temperatura, la presión y la velocidad vertical.
1 Selecciona Ajustes > Unidades.
2 Selecciona un tipo de medida.
3 Selecciona una unidad de medida.

Configuración de la hora
Selecciona Ajustes > Tiempo.
Formato horario: configura el dispositivo para que utilice el 

formato de 12 o de 24 horas.
Huso horario: establece el huso horario del dispositivo. 

Automático establece automáticamente el huso horario en 
función de tu posición GPS.

Configuración del formato de posición
NOTA: no cambies el formato de posición ni el sistema de 
coordenadas del datum del mapa a menos que estés utilizando 
un mapa o carta que especifique un formato de posición 
diferente.
Selecciona Ajustes > Formato de posición.
Formato de posición: establece el formato de posición en el 

que se muestra una lectura de ubicación.
Datum del mapa: establece el sistema de coordenadas con el 

que está estructurado el mapa.
Esferoide del mapa: muestra el sistema de coordenadas que 

está utilizando el dispositivo. El sistema de coordenadas 
predeterminado es WGS 84.

Configurar rutas
La configuración de rutas disponible varía en función de la 
actividad seleccionada.
Selecciona Ajustes > Rutas.
Método de indicaciones: permite establecer las preferencias a 

la hora de optimizar el cálculo de las rutas en función de la 
distancia, el tiempo, las rutas en carretera o fuera de 
carretera.
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Calcular rutas para: permite seleccionar el método empleado 
para calcular la ruta.

Mostrar en carretera: bloquea el triángulo azul, que representa 
tu posición en el mapa, en la carretera más cercana. Esta 
opción resulta de especial utilidad al conducir o navegar por 
carreteras.

Transiciones fuera de carretera: establece las preferencias a 
la hora de recalcular la ruta cuando se navega fuera de una 
ruta activa.

Configuración de elementos a evitar: establece los tipos de 
carreteras, terrenos y métodos de transporte que se deben 
evitar durante la navegación.

Configurar el altímetro
NOTA: el altímetro solo está disponible para dispositivos de la 
eTrex 32x.
Selecciona Ajustes > Altímetro.
Calibración automática: calibra automáticamente el altímetro 

cada vez que se enciende el dispositivo.
Modo barómetro: Altura variable permite que el barómetro 

mida los cambios de altura cuando te desplazas. Altitud fija 
supone que el dispositivo está parado en una altura fija, por 
lo que la presión barométrica solo debería cambiar debido a 
condiciones meteorológicas.

Tendencia de presión: establece cómo registra el dispositivo 
los datos de presión. Guardar siempre registra todos los 
datos de presión. Esto puede ser útil cuando realices un 
seguimiento de frentes de presión.

Tipo de gráfica: registra los cambios de altura a lo largo de un 
periodo de tiempo o distancia y la presión barométrica o los 
cambios de la presión atmosférica a lo largo de un periodo 
de tiempo.

Calibrar altímetro: calibra el altímetro.

Configuración de navegación
Selecciona Ajustes > Náutico.
Modo de carta marítima: configura el tipo de carta que utiliza el 

dispositivo cuando muestra datos marítimos. Náutico 
muestra los distintos elementos del mapa con diferentes 
colores para que los POI marítimos se lean con mayor 
facilidad y el mapa refleje el patrón de trazado de las cartas 
en papel. Pesca (requiere mapas marítimos): muestra una 
vista detallada de las curvas de nivel y los sondeos de 
profundidad y simplifica la presentación del mapa para 
disponer de una visualización óptima al pescar.

Presentación: establece la presentación de ayudas a la 
navegación marítima en el mapa.

Configuración de alarma marina: configura las alarmas para 
que suenen cuando sobrepasas una distancia de desvío 
determinada mientras fondeas, cuando se produce un desvío 
de trayecto según una distancia determinada y cuando 
entras en aguas de una profundidad específica.

Configuración de las alarmas marinas
1 Selecciona Ajustes > Náutico > Configuración de alarma 

marina.
2 Selecciona un tipo de alarma.
3 Selecciona Activado.
4 Introduce una distancia y selecciona Ir.

Restablecimiento de los datos
Puedes restablecer los datos de ruta, borrar todos los 
waypoints, suprimir el track actual o restablecer los valores 
predeterminados.
1 Selecciona Ajustes > Restablecer.

2 Selecciona el elemento que deseas restablecer.

Información del dispositivo
Actualizaciones del producto
En el ordenador, instala Garmin Express™ (www.garmin.com
/express). En el smartphone, instala la aplicación Garmin 
Connect™.
Esto te permitirá acceder fácilmente a los siguientes servicios 
para dispositivos Garmin:
• Actualizaciones de software
• Actualizaciones de mapas
• Carga de datos a Garmin Connect
• Registro del producto

Configurar Garmin Express
1 Conecta el dispositivo al ordenador mediante un cable USB.
2 Visita garmin.com/express.
3 Sigue las instrucciones que se muestran en la pantalla.

Registrar el dispositivo
Completa hoy mismo el registro en línea y ayúdanos a ofrecerte 
un mejor servicio. Guarda la factura original o una fotocopia en 
un lugar seguro.
1 Visita garmin.com/express.
2 Inicia sesión en tu cuenta de Garmin.

Ver la información sobre las normativas y la 
conformidad de la etiqueta electrónica
La etiqueta de este dispositivo se suministra por vía electrónica. 
La etiqueta electrónica puede proporcionar información 
normativa, como los números de identificación proporcionados 
por la FCC o las marcas de conformidad regionales, además de 
información sobre el producto y su licencia.
1 Selecciona Ajustes.
2 Selecciona Acerca de....

Realizar el cuidado del dispositivo
AVISO

No utilices disolventes, productos químicos ni insecticidas que 
puedan dañar los componentes plásticos y acabados.
No guardes el dispositivo en lugares en los que pueda quedar 
expuesto durante periodos prolongados a temperaturas 
extremas, ya que podría sufrir daños irreversibles.
El dispositivo es resistente al agua conforme a la norma IEC 
60529 IPX7. Puede resistir la inmersión accidental a una 
profundidad de 1 metro bajo el agua durante 30 minutos. La 
inmersión prolongada puede ocasionar daños en el dispositivo. 
Tras la inmersión, asegúrate de limpiar y secar el dispositivo al 
aire antes de usarlo o de cargarlo.
Aclara con cuidado el dispositivo con agua limpia tras exponerlo 
a entornos de agua clorada o salada.

Limpieza del dispositivo
AVISO

El sudor o la humedad, incluso en pequeñas cantidades, 
pueden provocar corrosión en los contactos eléctricos cuando el 
dispositivo está conectado a un cargador. La corrosión puede 
impedir que se transfieran datos o se cargue correctamente.

1 Limpia el dispositivo con un paño humedecido en una 
solución suave de detergente.

2 Seca el dispositivo.
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Después de limpiarlo, deja que se seque por completo.

Gestión de datos
Puedes almacenar archivos en el dispositivo. Este dispone, 
además, de una ranura de tarjeta de memoria para almacenar 
datos adicionales.
NOTA: el dispositivo es compatible con Windows 7 y versiones 
posteriores, y Mac OS 10.4 y versiones posteriores.

Instalación de la tarjeta de memoria

 ADVERTENCIA
No utilices ningún objeto puntiagudo para retirar las pilas.

Puedes instalar una tarjeta de memoria microSD® en el 
dispositivo de mano para obtener espacio de almacenamiento 
adicional o mapas previamente cargados.
1 Gira la anilla en el sentido contrario a las agujas del reloj y 

tira de ella para extraer la tapa.
2 Extrae las pilas.
3 Desliza la ranura de la tarjeta hacia la izquierda y levántala.

4 Coloca la tarjeta de memoria con los contactos dorados 
hacia abajo.

5 Cierra la ranura de la tarjeta.
6 Desliza la ranura de la tarjeta hacia la derecha para 

bloquearla.
7 Vuelve a colocar las pilas y la tapa.

Conexión del dispositivo a un ordenador
AVISO

Para evitar la corrosión, seca totalmente el puerto USB, la tapa 
de goma y la zona que la rodea antes de cargar el dispositivo o 
conectarlo a un ordenador.

Para poder utilizar el dispositivo mientras está conectado al 
ordenador, debes instalar la batería/pilas. Es posible que el 
puerto USB del ordenador no proporcione suficiente energía 
como para que el dispositivo funcione.
1 Levanta la tapa de goma del puerto mini-USB.
2 Conecta el extremo pequeño del cable USB al puerto mini-

USB.
3 Conecta el extremo grande del cable USB a un puerto USB 

del ordenador.
En equipos Windows, el dispositivo aparecerá como una 
unidad extraíble o un dispositivo portátil y es posible que la 
tarjeta de memoria aparezca como una segunda unidad 
extraíble. En equipos Mac, el dispositivo y la tarjeta de 
memoria aparecerán como volúmenes montados.

Transferencia de archivos al dispositivo
1 Conecta el dispositivo al ordenador.

En equipos Windows, el dispositivo aparecerá como una 
unidad extraíble o un dispositivo portátil y es posible que la 
tarjeta de memoria aparezca como una segunda unidad 
extraíble. En equipos Mac, el dispositivo y la tarjeta de 
memoria aparecerán como dispositivos de almacenamiento 
extraíble.

NOTA: es posible que algunos ordenadores con varias 
unidades en red no muestren las unidades del dispositivo 
adecuadamente. Consulta la documentación del sistema 
operativo para obtener más información sobre cómo asignar 
la unidad.

2 En el ordenador, abre el explorador de archivos.
3 Selecciona un archivo.
4 Selecciona Editar > Copiar.
5 Abre el dispositivo portátil, unidad o volumen 

correspondiente al dispositivo o la tarjeta de memoria.
6 Ve a una carpeta.
7 Selecciona Editar > Pegar.

El archivo aparecerá en la lista de archivos de la memoria 
del dispositivo o en la tarjeta de memoria.

Borrar archivos
AVISO

Si no conoces la función de un archivo, no lo borres. La 
memoria del dispositivo contiene archivos de sistema 
importantes que no se deben borrar.

1 Abre la unidad o el volumen Garmin.
2 Si es necesario, abre una carpeta o volumen.
3 Selecciona un archivo.
4 Pulsa la tecla Suprimir en el teclado.

NOTA: si estás utilizando un ordenador Apple®, debes vaciar 
la carpeta Papelera para borrar completamente los archivos.

Desconectar el cable USB
Si el dispositivo está conectado al ordenador como unidad o 
volumen extraíble, debes desconectarlo del ordenador de forma 
segura para evitar la pérdida de datos. Si el dispositivo está 
conectado al ordenador Windows como dispositivo portátil, no 
es necesario desconectarlo de forma segura.
1 Realiza una de las siguientes acciones:

• Para ordenadores con Windows, selecciona el icono 
Quitar hardware de forma segura situado en la bandeja 
del sistema y, a continuación, selecciona el dispositivo.

• Para ordenadores Apple, selecciona el dispositivo y, a 
continuación, selecciona Archivo > Expulsar.

2 Desconecta el cable del ordenador.

Especificaciones
Rango de temperatura de 
funcionamiento

De -20 °C a 70 °C (de -4 °F a 158 °F)

Protocolo/frecuencia inalámbrica 2,4 GHz a -1,13 dBm nominales

Apéndice
Accesorios opcionales
En la página http://buy.garmin.com o en tu distribuidor de 
Garmin hay disponibles accesorios opcionales, como soportes, 
mapas, accesorios de ejercicio y piezas de repuesto.

Vincular los sensores ANT+
Para poder realizar la vinculación, debes ponerte el monitor de 
frecuencia cardiaca o instalar el sensor.
La vinculación consiste en conectar sensores inalámbricos 
ANT+, por ejemplo, conectar un monitor de frecuencia cardiaca 
a tu dispositivo.
1 Coloca el dispositivo a menos de 3 m (10 ft) del sensor.

NOTA: aléjate 10 m (30 ft) de otros sensores ANT+ mientras 
se realiza la vinculación.
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2 En el cajón de aplicaciones, selecciona Ajustes > Sensor 
ANT.

3 Selecciona tu sensor.
4 Selecciona Buscar nuevo.

Cuando el sensor esté vinculado al dispositivo, el estado del 
sensor cambiará de Buscando a Conectado.

Sugerencias para vincular accesorios ANT+ con tu 
dispositivo de Garmin
• Comprueba que el accesorio ANT+ es compatible con el 

dispositivo de Garmin.
• Antes de vincular el accesorio ANT+ con el dispositivo de 

Garmin, sitúate a una distancia de 10 m (33 ft) de otros 
accesorios ANT+.

• Coloca el dispositivo Garmin en el área de alcance de 3 m 
(10 ft) del accesorio ANT+.

• Tras la primera vinculación, el dispositivo de Garmin 
reconocerá automáticamente el accesorio ANT+ cada vez 
que se active. Este proceso se produce automáticamente al 
encender el dispositivo de Garmin y solo tarda unos 
segundos si los accesorios están activados y funcionan 
correctamente.

• Cuando está vinculado, el dispositivo de Garmin solo recibe 
datos de tu accesorio y puedes acercarte a otros accesorios.

Solución de problemas
Reiniciar el dispositivo
Si el dispositivo deja de responder, deberás reiniciarlo. Con esta 
acción no se borra ningún dato ni configuración.
1 Extrae las pilas.
2 Vuelve a colocar las pilas/batería.

Restablecimiento de todas las configuraciones prede-
terminadas
Puedes restablecer toda la configuración a los valores 
predeterminados de fábrica.

Selecciona Ajustes > Restablecer > Restablecer la 
configuración > Sí.

Departamento de asistencia de Garmin
Visita support.garmin.com para obtener ayuda e información, 
como manuales de producto, preguntas frecuentes, vídeos y 
atención al cliente.
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Introdução
 ATENÇÃO

Consulte o guia Informações importantes sobre segurança e 
sobre o produto na caixa do produto para obter mais detalhes 
sobre avisos e outras informações importantes.

Visão geral do dispositivo

Teclas de zoom. Pressione para aumentar ou diminuir o zoom.

Tecla back. Pressione para retornar ao menu anterior.

Controlador Thumb Stick™. Mova de forma direcional para rolar ou 
realçar um item. Pressione para selecionar um item.
Tecla menu. Pressione para abrir o menu de uma página. 
Pressione duas vezes para retornar ao menu principal.

 Pressione para ajustar a luz de fundo. Mantenha pressionado 
para ligar e desligar o dispositivo.
Porta mini-USB (por baixo da cobertura de proteção).

Tampa do compartimento da pilha.

Anel de bloqueio da tampa do compartimento da pilha.

Suporte de montagem.

Informações sobre a bateria
 ATENÇÃO

A classificação de temperatura para o dispositivo pode exceder 
a faixa útil de algumas pilhas. As pilhas alcalinas podem 
explodir sob temperaturas altas.

AVISO
Pilhas alcalinas perdem uma quantidade significativa da sua 
capacidade à medida que a temperatura diminui. Use baterias 
de lítio ao operar o dispositivo em condições de congelamento.

Instalando pilhas AA
O dispositivo portátil funciona com duas pilhas AA (não 
incluídas). Use baterias de NiMH ou lítio para obter os melhores 
resultados.
1 Gire a argola em D no sentido anti-horário e puxe-a para 

remover a tampa.
2 Insira as duas pilhas AA, observando as polaridades.

3 Recoloque a tampa do compartimento da bateria e gire a 
argola em D no sentido horário.

Selecionar o tipo de pilha
1 No menu principal, selecione Configur > Sistema > Tipo de 

pilha.
2 Selecione Alcalina, Lítio ou NiMH recarregável.

Maximizando a vida útil da bateria
É possível fazer diversas coisas para estender a duração das 
baterias.
• Reduzir o brilho da luz de fundo (Ajustando o brilho da luz de 

fundo, página 7).
• Reduzir o tempo limite da luz de fundo (Configurações do 

visor, página 9).
• Usar o modo de economia de bateria (Ativando o modo de 

economia de bateria, página 1).
• Diminuir a velocidade com que o mapa é desenhado 

(Configurações do mapa, página 4).
• Desligar o GLONASS (GPS e outros sistemas de satélite, 

página 9).

Ativando o modo de economia de bateria
É possível usar o modo de economia de bateria para estender a 
duração da bateria.

Selecione Configur > Ecrã > Poupança de bateria > 
Activar.

No modo de economia de bateria, a tela desligará quando a luz 
de fundo chegar ao tempo limite. Você pode selecionar  para 
ligar a tela e tocar duas vezes em  para visualizar a página de 
status.

Armazenamento de longo prazo
Quando não pretender utilizar o dispositivo durante vários 
meses, remova as baterias. Os dados armazenados não se 
perdem ao remover as baterias.

Ligando o dispositivo
Pressione .

Obtendo sinais de satélite
Poderá levar de 30 a 60 segundos para obter os sinais do 
satélite.
1 Dirija-se a uma área aberta.
2 Se necessário, ligue o dispositivo.
3 Aguarde enquanto o dispositivo pesquisa satélites.

 pisca enquanto o dispositivo determina a sua localização.
 mostra a intensidade do sinal do satélite.

Ativar a luz de fundo
Pressione qualquer tecla para ativar a luz de fundo.
A luz de fundo acende automaticamente quando alertas e 
mensagens são exibidos.

Abrindo o menu principal
O menu principal dá acesso a ferramentas e telas de 
configuração para pontos de parada, atividades, rotas e muito 
mais (Ferramentas adicionais no menu principal, página 7).

De qualquer página, selecione menu duas vezes.

Paradas, rotas e trajetos
Menu Para onde?
Você pode usar o menu Para Onde? Para encontrar um destino 
para navegar. Nem todas as categorias Para Onde? estão 
disponíveis em todas as áreas e mapas.
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Encontrar um local perto de outro
1 Selecione Para Onde? > menu > Procurar perto de....
2 Selecione uma opção.
3 Selecione um local.

Pontos de parada
Pontos de parada são locais gravados e armazenados no 
dispositivo. Os pontos de parada podem marcar onde você 
está, para onde vai, ou onde você esteve. Você pode adicionar 
detalhes sobre a localização, como nome, elevação e 
profundidade.
É possível adicionar um arquivo .gpx que contenha pontos de 
parada, transferindo o arquivo para a pasta GPX (Transferir 
arquivos para seu dispositivo, página 11).

Criar um ponto de parada
Você pode salvar seu local atual como um ponto de parada.
1 Selecione Marcar Ponto.
2 Se necessário, selecione um campo para fazer alterações no 

ponto de parada.
3 Selecione Concluído.

Projetando um ponto de parada
Você pode criar um novo local ao projetar a distância e a 
direção de um local marcado para um novo local.
1 Selecione Gest. Pontos de Passagem.
2 Selecione um ponto de parada.
3 Selecione menu > Projectar Ponto Pass.
4 Insira a direção e selecione Concluído.
5 Selecione uma unidade de medida.
6 Insira a distância e selecione Concluído.
7 Selecione Guard..

Navegando para um ponto de parada
1 Selecione Para Onde? > Pontos de passagem.
2 Selecione um ponto de parada.
3 Selecione Ir.

Encontrar um local pelo nome
1 Selecione Para Onde? > Pontos de passagem > menu > 

Procura por ortografia.
2 Digite o nome ou parte do nome.
3 Selecione Ir.

Editando uma parada
1 Selecione Gest. Pontos de Passagem.
2 Selecione um ponto de parada.
3 Selecione um item para editar, como o nome.
4 Insira as novas informações e selecione Ir.

Eliminar uma parada
1 Selecione Gest. Pontos de Passagem.
2 Selecione um ponto de parada.
3 Selecione menu > Eliminar.

Média de paradas
É possível especificar a localização de uma parada para mais 
precisão. Ao calcular a média, o dispositivo efetua várias 
leituras no mesmo local e utiliza o valor médio para fornecer 
mais precisão.
1 Selecione Gest. Pontos de Passagem.
2 Selecione um ponto de parada.
3 Selecione menu > Média Local.
4 Mova para a localização da parada.

5 Selecione Iniciar.
6 Siga as instruções na tela.
7 Quando a barra de status atingir 100%, selecione Guard..
Para obter melhores resultados, reúna quatro a oito amostras 
para a parada, aguarde, pelo menos, 90 minutos entre as 
amostras.

Rotas
Uma rota é uma sequência de pontos de parada ou locais que 
orienta você ao seu destino final.

Criar uma rota
1 Selecione Planificador de Rotas > Criar Rota > Selecc 1º 

ponto.
2 Selecione uma categoria.
3 Selecione o primeiro ponto na rota.
4 Selecione Utilize.
5 Selecione Selec. Próx. Ponto para adicionar pontos 

adicionais à rota.
6 Selecione back para salvar a rota.

Exibindo uma rota no mapa
1 Selecione Planificador de Rotas.
2 Selecione uma rota.
3 Selecione Ver mapa.

Navegar para uma rota salva
1 Selecione Para Onde? > Rotas.
2 Selecione uma rota.
3 Selecione Ir.

Visualizando a rota ativa
1 Ao navegar por uma rota, selecione Rota Activa.
2 Selecione um ponto na rota para visualizar detalhes 

adicionais.

Editar o nome de uma rota
1 Selecione Planificador de Rotas.
2 Selecione uma rota.
3 Selecione Mudar o nome.
4 Insira o novo nome.

Editando uma rota
1 Selecione Planificador de Rotas.
2 Selecione uma rota.
3 Selecione Editar Rota.
4 Selecione um ponto.
5 Selecione uma opção:

• Para visualizar o ponto no mapa, selecione Rever.
• Para alterar a ordem dos pontos na rota, selecione Subir 

ou Descer.
• Para inserir um ponto adicional na rota, selecione Inserir.

O ponto adicional é inserido antes do ponto que você está 
editando.

• Para remover o ponto da rota, selecione Retirar.
6 Selecione back para salvar a rota.

Excluir uma rota
1 Selecione Planificador de Rotas.
2 Selecione uma rota.
3 Selecione Eliminar Rota.
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Inverter uma rota
Você pode alternar os pontos inicial e final de sua rota para 
navegar na rota em marcha a ré.
1 Selecione Planificador de Rotas.
2 Selecione uma rota.
3 Selecione Inverter Rota.

Interrompendo a navegação
Selecione Para Onde? > Parar a navegação.

Trajetos
Um trajeto é um registro do seu caminho. O registro do trajeto 
contém informações sobre pontos ao longo do caminho 
gravado, inclusive tempo, local e elevação para cada ponto. Por 
padrão, o dispositivo cria um registro do trajeto enquanto você 
se move com o dispositivo ligado.

Gravar registros do trajeto
1 No Menu principal, selecione Configur > Trajectos > 

Registo de trajectos.
2 Selecione Gravar, Não mostrar ou Grav, Mostrar no mapa.

Se você selecionar Grav, Mostrar no mapa, uma linha no 
mapa indica seu trajeto.

3 Selecione Método d/Gravação.
4 Selecione uma opção:

• Para registrar trajetos em uma frequência variável que 
crie uma excelente representação de seus trajetos, 
selecione Auto.

• Para registrar trajetos a uma distância especificada, 
selecione Distância.

• Para registrar trajetos em um horário especificado, 
selecione Hora.

5 Selecione Intervalo.
6 Execute uma ação:

• Se você tiver selecionado Auto para o Método d/
Gravação, selecione uma opção para registrar os trajetos 
com mais ou menos frequência.

OBSERVAÇÃO: o intervalo Mais Frequente fornece o 
máximo de detalhes do trajeto, mas enche a memória do 
dispositivo mais rapidamente.
• Se você tiver selecionado Distância ou Hora para o 

Método d/Gravação, insira um valor.
À medida que você se move com o dispositivo ligado, um 
registro de trajetos é criado.

Visualizar o trajeto atual
1 Selecione Gestor de trajecto > Trajecto Actual.
2 Selecione uma opção:

• Para exibir o trajeto atual no mapa, selecione Ver mapa.
• Para exibir o plano de elevação do trajeto atual, selecione 

Registos de elevação.

Salvar o trajeto atual
1 Selecione Gestor de trajecto > Trajecto Actual.
2 Selecione uma opção:

• Selecione Guardar Traj. para salvar o trajeto completo.
• Selecione Guardar parte e selecione uma parte.

Navegar para um trajeto salvo
1 Selecione Para Onde? > Trajectos.
2 Selecione um trajeto salvo.
3 Selecione Ir.

Apagar o trajeto atual
Selecione Gestor de trajecto > Trajecto Actual > Eliminar 
Trajecto Act.

Excluir um trajeto
1 Selecione Gestor de trajecto.
2 Selecione um trajeto.
3 Selecione Eliminar.

Configurações de trajetos
Selecione Configur > Trajectos.
Registo de trajectos: ativar ou desativar gravação de trajetos.
Método d/Gravação: define um método de gravação de 

trajetos. Auto grava os trajetos a uma velocidade variável 
para criar uma excelente representação de seus trajetos.

Intervalo: define uma velocidade de gravação do registro de 
trajetos. A gravação de pontos mais frequentes cria um 
trajeto com mais detalhes, mas ocupa rapidamente a 
memória do registro de trajetos.

Eliminar Trajecto Act: apaga a memória de trajetos atual.
Config avançada > Auto-arquivamento: define um método de 

arquivamento automático para organizar seus trajetos. Os 
trajetos são salvos e limpos automaticamente.

Config avançada > Cor: altera a cor da linha de trajeto no 
mapa.

Adquirindo mapas adicionais
1 Acesse a página do produto do seu dispositivo em 

garmin.com.
2 Clique na guia Mapas.
3 Siga as instruções na tela.

Encontrando um Endereço
Você pode usar mapas opcionais City Navigator® para pesquisar 
os endereços.
1 Selecione Para Onde? > Endereços.
2 Selecione um país ou estado, se necessário.
3 Insira a cidade ou o CEP.

OBSERVAÇÃO: nem todos os dados do mapa oferecem 
opção de pesquisa de CEP.

4 Selecione a cidade.
5 Insira o número da casa.
6 Inserir a rua.

Navegação
Você pode navegar até uma rota, trajeto, ponto de parada, 
geocache ou qualquer local salvo no dispositivo. Você pode 
usar o mapa ou a bússola para navegar até o seu destino.

Navegando até um destino
1 Selecione Para Onde?.
2 Selecione uma categoria.
3 Se necessário, selecione menu > Procura por ortografia e 

insira o nome ou parte do nome do destino.
4 Selecione um destino.
5 Selecione Ir.

A rota aparece como uma linha magenta no mapa.
6 Navegue usando o mapa (Navegando com o mapa, 

página 4) ou a bússola (Navegando com a bússola, 
página 4).
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Navegar com o Sight 'N Go
Você pode apontar o dispositivo para um objeto distante, travar 
na direção e navegar até o objeto.
OBSERVAÇÃO: sight 'N Go está disponível apenas com 
dispositivos eTrex 32x.
1 Selecione Avistar e Seguir.
2 Aponte o dispositivo para um objeto.
3 Selecione Bloquear Direcção > Definir Rumo.
4 Navegue utilizando a bússola.

Configurações de direção
É possível personalizar as configurações da bússola.
Selecione Configur > Direcção.
Ecrã: configura o tipo de direção exibido na bússola.
Referência de Norte: configura a referência ao norte utilizada 

na bússola.
Ir para a linha/ponteiro: define o comportamento do ponteiro 

que é exibido no mapa. Azimute exibe a direção do seu 
destino. Percurso mostra a sua relação com a linha do 
percurso que leva ao destino.

Bússola: muda, automaticamente, de uma bússola eletrônica 
para uma bússola de GPS ao se deslocar a uma velocidade 
mais elevada durante determinado período.

Calibração da bússola: consulte Calibrando a bússola, 
página 4.

Mapa
 representa a sua localização no mapa. Durante o percurso, 

se move e deixa um registro do trajeto (rastro). Os nomes dos 
pontos de parada e os símbolos são exibidos no mapa. Ao 
navegar até um destino, sua rota é marcada com uma linha 
colorida no mapa.

Navegando com o mapa
AVISO

Os mapas incluídos no seu dispositivo podem criar rotas 
pedonais ou para ciclismo usando estradas e trilhas, mas não 
pode criar rotas para automóveis.

1 Iniciar navegação para um destino.
2 Selecione Mapa.

 representa a sua localização no mapa. Sua rota está 
marcada com uma linha colorida.

3 Realize uma ou mais ações:
• Use o controlador Thumb Stick para mover o cursor no 

mapa e visualizar diferentes áreas.
• Para ampliar e diminuir o mapa, selecione  e .

Alterando a orientação do mapa
1 No mapa, selecione menu.
2 Selecione Configurar mapa > Orientação.
3 Selecione uma opção:

• Selecione Norte no Topo para mostrar o norte no topo da 
página.

• Selecione Trajecto para cima para mostrar a direção 
atual de sua viagem no topo da página.

• Selecione Modo Automóvel para mostrar uma 
perspectiva do automóvel com o sentido de deslocamento 
na parte superior.

Medindo distâncias no mapa
É possível medir a distância entre duas localizações.
1 No mapa, selecione um local.
2 Selecione menu > Medir distância.

3 Mova o pino para outro local no mapa.

Configurações do mapa
Selecione Configur > Mapa.
Orientação: ajusta a apresentação do mapa na página. Norte 

no Topo mostra o norte no topo da página. Trajecto para 
cima mostra uma visualização de cima para baixo com a 
direção atual da viagem em direção ao topo da página. Modo 
Automóvel mostra uma vista automotiva 3D com o sentido de 
deslocamento na parte superior.

Seleccionáveis: personaliza os campos de dados e os painéis 
do mapa, da bússola, do plano de elevação e do computador 
de bordo.

Config avançada mapa: permite abrir as configurações 
avançadas do mapa (Configurações do mapa, página 4).

Informações do Mapa: ativa ou desativa os mapas atualmente 
carregados no dispositivo.

Configurações avançadas do mapa
Selecione Configur > Mapa > Config avançada mapa.
Auto Zoom: seleciona automaticamente o nível de zoom 

adequado para uso otimizado no seu mapa. Quando a opção 
Desligado estiver selecionada, você deverá aplicar mais ou 
menos zoom manualmente.

Níveis Zoom: ajusta o nível de zoom no qual itens do mapa 
serão exibidos. Os itens do mapa não serão exibidos quando 
o nível de zoom do mapa é mais alto que o nível 
selecionado.

Dimens. Texto: configura o tamanho do texto para itens do 
mapa.

Detalhe: seleciona a quantidade de detalhes exibida no mapa. 
A exibição de mais detalhes pode fazer com que o mapa se 
apresente de forma mais lenta.

Relevo sombreado: exibe um relevo detalhado no mapa (se 
disponível) ou desativa o sombreado.

Bússola
Ao navegar,  aponta para seu destino, independentemente da 
direção em que você está se movendo. Quando  aponta para o 
topo da bússola eletrônica, você está se deslocando 
diretamente em direção ao seu destino. Se  aponta para 
qualquer outra direção, gire até ele apontar para o topo da 
bússola.

Calibrando a bússola
O dispositivo tem uma bússola eletrônica de 3 eixos (somente 
dispositivos eTrex 32x). Você deve calibrar a bússola depois de 
percorrer grandes distâncias, passar por alterações bruscas de 
temperatura ou quando trocar a bateria.
1 Afaste-se de objetos que influenciam os campos magnéticos, 

como carros, edifícios ou linhas elétricas.
2 Na bússola, selecione menu.
3 Selecione Calibração da bússola > Iniciar.
4 Siga as instruções na tela.

Navegando com a bússola
Ao navegar para um destino,  aponta para seu destino, 
independentemente da direção em que você está se movendo.
1 Comece a navegar para um destino (Navegando até um 

destino, página 3).
2 Selecione Bússola.
3 Gire até que  aponte para o topo da bússola e continue se 

movendo na direção do destino.

Ponteiro de curso
O ponteiro de curso é mais útil quando você está navegando ou 
quando não há grandes obstáculos no caminho. Também pode 
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ajudá-lo a evitar perigos próximos ao percurso, como bancos de 
areia ou rochas submersas.
Para ativar o ponteiro de percurso, na bússola, selecione menu 
> Configurar direcção > Ir para a linha/ponteiro > Rumo 
(CDI).

O  de ponteiro de percurso indica sua posição em relação à 
direção do percurso até o destino. O indicador de desvio de 
percurso (CDI)  fornece a indicação de desvio (esquerda ou 
direita) do percurso. A escala  refere-se à distância entre 
pontos  no indicador de desvio de percurso, que diz o quanto 
você está fora do percurso.

Plano de elevação
OBSERVAÇÃO: o plano de elevação está disponível apenas 
com dispositivos eTrex 32x.
Por padrão, o plano de elevação exibe a elevação sobre a 
distância percorrida. Você pode personalizar as configurações 
do plano de elevação (Configurações de plano de elevação, 
página 5). É possível selecionar qualquer ponto no gráfico 
para exibir detalhes sobre tal ponto.

Calibrando o altímetro barométrico
Você pode calibrar manualmente o altímetro barométrico se 
souber qual a elevação ou a pressão barométrica correta.
1 Dirija-se para um local onde a elevação ou a pressão 

barométrica é conhecida.
2 Selecione Registos de elevação > menu > Calibração do 

altímetro.
3 Siga as instruções na tela.

Configurações de plano de elevação
No plano de elevação, selecione menu.
Mudar o tipo de gráfico: define o tipo de dados exibidos no 

plano de elevação. .
Ajustar escalas de zoom: ajusta os intervalos de zoom 

mostrados na página do altímetro.
Mudar Campos Dados: permite que você personalize os 

campos de dados do altímetro.
Repor: redefine os dados do altímetro, incluindo dados de 

ponto de parada, trajeto e viagem.
Calibração do altímetro: consulte (Calibrando o altímetro 

barométrico, página 5).
Repor predefinições: restaura o altímetro para as 

configurações padrão de fábrica.

Computador de bordo
O computador de bordo exibe a velocidade atual, a velocidade 
média, o odômetro de viagem e outras estatísticas úteis. É 
possível personalizar o layout, o painel e os campos de dados 
do computador de bordo.

Configurações do computador de bordo
No computador de bordo, selecione menu.
Repor: redefine todos os valores do computador de bordo para 

zero. Para informações precisas, redefina as informações de 
viagem antes de iniciar uma viagem.

Números Grandes: altera o tamanho dos números exibidos na 
página do computador de bordo.

Mudar Campos Dados: personaliza os campos de dados do 
computador de bordo.

Mudar painel de instr: altera o tema e as informações exibidas 
no painel.
OBSERVAÇÃO: suas configurações personalizadas são 
lembradas pelo painel. Suas configurações personalizadas 
não são perdidas quando você altera os perfis (Perfis, 
página 8).

Repor predefinições: restaura o computador de bordo para as 
configurações padrão de fábrica.

Restaurar configurações padrão da página
1 Abrir uma página para a qual você restaurará as 

configurações.
2 Selecione menu > Repor predefinições.

Recursos e configurações do menu 
principal

Geocaches
O Geocaching é uma atividade de caça ao tesouro na qual os 
jogadores escondem ou procuram por caches escondidos 
utilizando pistas e coordenadas de GPS.

Download de geocaches utilizando o computador
Você pode carregar geocaches manualmente para o dispositivo 
usando um computador (Transferir arquivos para seu 
dispositivo, página 11). Você pode colocar arquivos de 
geocache em um ficheiro GPX e importá-los para a pasta GPX 
no dispositivo. Com uma assinatura Premium de 
geocaching.com, você pode usar o recurso "Pocket Query" para 
carregar um grupo grande de geocaches para o dispositivo 
como um arquivo GPX único.
1 Conecte o dispositivo ao computador usando um cabo USB.
2 Acesse www.geocaching.com.
3 Se necessário, crie uma conta.
4 Login.
5 Siga as instruções em geocaching.com para localizar e 

baixar geocaches para seu dispositivo.

Navegar para um geocache
1 Selecione Geocaches.
2 Selecione uma geocache.
3 Selecione Ir.
Registro da tentativa
Depois de tentar encontrar um geocache, você pode registrar os 
resultados. Você pode verificar alguns geocaches em 
www.geocaching.com.
1 Selecione Geocaches > Tentativa de Registo.
2 Selecione Encontrados, Não Encontrou, Necessária 

Reparação ou Não Tentado.
3 Selecione uma opção:

• Para parar o registo, selecione Concluído.
• Para iniciar a navegação para o geocache mais próximo a 

você, selecione Encon. Seg. Mais Próx..
• Para inserir um comentário sobre a pesquisa de cache ou 

sobre o cache em si, selecione a opção Adicionar 
Comentário, insira um comentário e selecione 
Concluído.
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Se você estiver conectado a www.geocaching.com, o registro é 
enviado para sua conta www.geocaching.com 
automaticamente.

chirp™

O chirp é um pequeno acessório Garmin® programado e deixado 
em um geocache. Você pode utilizar seu dispositivo para 
encontrar um chirp em um geocache. Para obter mais 
informações sobre chirp, consulte o Manual do proprietário do 
chirp em www.garmin.com.
Ativar a pesquisa por chirp
1 Selecione Configur > Geocaches.
2 Selecione A procurar chirp™ > Activar.

Enviando e recebendo dados sem fio
Para poder compartilhar dados sem fio, você deve estar a 3 
metros (10 pés) de um dispositivo compatível.
Seu dispositivo pode enviar e receber dados quando 
emparelhado com outro dispositivo ou smartphone compatível 
usando a tecnologia sem fio ANT+®. Você pode compartilhar 
pontos de parada, geocaches, rotas e trilhas.
OBSERVAÇÃO: este recurso não está disponível para todos os 
modelos de dispositivo.
1 Selecione Partilhar sem fios.
2 Selecione uma opção:

• Selecione Env e selecione o tipo de dado.
• Selecione Receber para receber dados de outro 

dispositivo. O outro dispositivo compatível deve estar 
tentando enviar um dado.

3 Siga as instruções na tela.

Definindo um alarme de proximidade
Os alarmes de proximidade alertam quando você está dentro de 
uma faixa especificada de um local em particular.
1 Selecione Alarmes proximidade > Criar alarme.
2 Selecione uma categoria.
3 Selecione um local.
4 Selecione Utilize.
5 Insira um raio.
Ao entrar em uma área com um alarme de proximidade, o 
dispositivo emite um tom.

Calcular o tamanho de uma área
1 Selecione Calcular áreas > Iniciar.
2 Caminhe em torno do perímetro da área que deseja calcular.
3 Selecione Calc quando terminar.

Página de satélites
A página de satélites exibe sua localização atual, a precisão do 
GPS, as localizações dos satélites e a intensidade do sinal.

Configurações de satélite GPS
Selecione Satélite > menu.
OBSERVAÇÃO: algumas configurações estarão disponíveis 
somente quando Usar c/GPS Deslig. estiver ativado.
Usar c/GPS Deslig.: permite desligar o GPS.
Usar c/GPS Ligado: permite ativar o GPS.
Trajecto para cima: indica se os satélites são exibidos com os 

anéis orientados com o norte para cima da tela ou orientados 
com o seu trajeto atual para cima da tela.

Uma só Cor: permite definir se a página de satélite é exibida 
em várias cores ou cor única.

Def. Local no Mapa: permite marcar a localização atual no 
mapa. É possível utilizar essa localização para criar rotas ou 
pesquisar localizações salvas.

Localiz. posição auto: calcula sua posição de GPS por meio 
do recurso Garmin AutoLocate®.

Garmin Aventuras
Você pode agrupar itens relacionados à uma aventura. Por 
exemplo, você pode criar uma aventura para sua mais recente 
viagem de trilha. A aventura pode conter o registro de trajetos 
da viagem, fotos da viagem e geocaches que você caçou. Você 
pode usar BaseCamp™ para criar e gerenciar suas aventuras.
OBSERVAÇÃO: BaseCamp não está disponível para todos os 
modelos do dispositivo.

Enviando arquivos para BaseCamp
1 Abrir BaseCamp.
2 Conecte o dispositivo ao computador.

Em computadores Windows®, o dispositivo é exibido como 
uma unidade removível ou um dispositivo portátil, e o cartão 
de memória pode ser exibido como uma segunda unidade 
removível. Em computadores Mac® , o dispositivo e o cartão 
de memória são exibidos como volumes montados.
OBSERVAÇÃO: alguns computadores com diversas 
unidades de rede não podem exibir unidades de dispositivo 
corretamente. Consulte a documentação do sistema 
operacional para saber como mapear a unidade.

3 Abra o Garmin ou a unidade do cartão de memória ou o 
volume.

4 Selecione uma opção:
• Selecione um item de um dispositivo conectado e arraste-

o para Minha coleção ou para uma lista.
• De BaseCamp, selecione Dispositivo > Receber do 

dispositivo e selecione o dispositivo.

Criando uma Aventura
Antes de criar uma aventura e enviá-la ao dispositivo, você 
deve fazer o download do BaseCamp para o seu computador e 
transferir um trajeto do seu dispositivo para o computador 
(Enviando arquivos para BaseCamp, página 6).
1 Abrir BaseCamp.
2 Selecione Arquivo > Novo > Aventura Garmin.
3 Selecione um trajeto e, depois Próxima.
4 Se necessário, adicione itens de BaseCamp.
5 Preencha os campos necessários para nomear e descrever 

a aventura.
6 Se desejar alterar a foto de capa da aventura, selecione 

Alterar e escolha uma foto diferente.
7 Selecione Finalizar.

Iniciando uma aventura
Antes de iniciar uma aventura, é necessário enviar uma 
aventura do BaseCamp para o seu dispositivo (Enviando 
arquivos para BaseCamp, página 6).
1 Selecione Aventuras.
2 Selecione uma Aventura.
3 Selecione Iniciar.

VIRB® Remota
OBSERVAÇÃO: o recurso VIRB Remoto está disponível 
apenas para dispositivos eTrex 32x.
Para usar a função VIRB Remoto, ative a configuração remota 
na câmera VIRB.
A função VIRB Remoto permite que você controle a câmera 
VIRB à distância.
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1 Selecione VIRB Remoto.
2 Selecione uma opção:

• Selecione GRAVAR para gravar vídeos.
• Selecione Tirar fotografia para tirar uma foto.

Ferramentas adicionais no menu principal
Despertador: define um alarme sonoro. Se você não está 

usando o dispositivo no momento, pode configurar o 
dispositivo para ligar em um horário específico.

Calculadora: exibe uma calculadora.
Calendário: exibe um calendário.
Caça e Pesca: exibe as melhores previsões de datas e horários 

para caça e pesca em sua localização atual.
Cronómetro: permite que você utilize um timer, marque uma 

volta e o tempo das voltas.
Sol e Lua: exibe os horários do nascer e pôr do sol, juntamente 

com a fase da lua, com base em sua posição de GPS.

Personalizando o dispositivo
Ajustando o brilho da luz de fundo
O uso extensivo da luz de fundo da tela pode reduzir 
significativamente a duração da bateria. É possível ajustar o 
brilho da luz de fundo para maximizar a vida útil da bateria.
OBSERVAÇÃO: o brilho da luz de fundo pode ser limitado 
quando a bateria está fraca.
1 Selecione .
2 Use o controle deslizante para ajustar o nível da luz de 

fundo.
O dispositivo pode esquentar quando a configuração da luz de 
fundo está alta.

Personalizando o menu principal
Você pode mover, adicionar e excluir itens no menu principal.
1 No menu principal, selecione menu > Mudar ordem dos 

itens.
2 Selecione um item do menu.
3 Selecione uma opção:

• Selecione Mover para alterar o local do item na lista.
• Selecione Inserir para adicionar um novo item à lista.
• Selecione Retirar para excluir um item da lista.

Alterar a sequência de páginas
Antes de alterar a ordem da sequência de páginas, é 
necessário adicionar páginas à sequência.
1 Selecione Configur > Sequência de páginas.
2 Selecione uma página.
3 Selecione Mover.
4 Mover a página para cima ou para baixo na lista.
5 Pressione o controlador Thumb Stick.

Adicionar uma página
1 Selecione Configur > Sequência de páginas.
2 Selecione Adicionar página.
3 Selecione uma página para excluir.

Remover uma página
1 Selecione Configur > Sequência de páginas.
2 Selecione uma página.
3 Selecione Retirar.
4 Pressione o controlador Thumb Stick.

Personalizar os campos de dados
É possível personalizar os campos de dados exibidos em cada 
página principal.
1 Abra a página para a qual alterará os campos de dados.
2 Selecione menu.
3 Selecione Mudar Campos Dados.
4 Selecione o novo campo de dados.
5 Siga as instruções na tela.

Campos de dados
Alguns campos de dados exigem que você esteja navegando 
ou exigem acessórios ANT+ para exibir os dados.
Azimute: a direção da sua posição atual até um destino. É 

necessário estar navegando para que estes dados sejam 
exibidos.

Barómetro: a pressão atual calibrada.
Cadência: o número de rotações da pedivela ou o número de 

passos por minuto. O dispositivo deve estar conectado a um 
acessório de cadência para que esses dados sejam exibidos.

Cardíaco Máximo: sua frequência cardíaca em batidas por 
minuto (bpm). O dispositivo deve estar conectado a um 
monitor de frequência cardíaco compatível.

Carga Pilha: bateria restante.
Conta-quilómetros: uma contagem constante da distância 

percorrida em todas as viagens. Este total não é apagado ao 
redefinir os dados de viagem.

Conta-quil Viag: uma contagem constante da distância 
percorrida desde o último zeramento.

Data: o dia, o mês e o ano atuais.
Descida - Máxima: a taxa máxima de descida em pés por 

minuto ou metros por minuto desde a última zerada.
Descida - Média: a distância vertical média de descida desde a 

última zerada.
Descida - Total: a distância de elevação total de descida desde 

a última zerada.
Direção da Bússola: a direção para onde se desloca com base 

na bússola.
Direcção: a direção para onde se desloca.
Dist. Volta: a distância percorrida para a volta atual.
Distância ao próximo: a distância restante até a próxima 

parada na rota. É necessário estar navegando para que 
estes dados sejam exibidos.

Distância até o destino: a distância que falta até o destino 
final. É necessário estar navegando para que estes dados 
sejam exibidos.

Distância do trajeto: a distância percorrida para o trajeto atual.
Distância vertical até destino: a distância de elevação entre a 

sua posição atual e o destino final. É necessário estar 
navegando para que estes dados sejam exibidos.

Elevação: a altitude da sua localização atual acima ou abaixo 
do nível do mar.

Elevação acima do solo: a altitude da sua localização atual 
acima do nível do solo (se os mapas contiverem informações 
de elevação suficientes).

Elevação - Máxima: a maior distância de elevação atingida 
desde a última zerada.

Elevação - Mínima: a menor distância de elevação atingida 
desde a última zerada.

ETA Destino: a hora do dia prevista para chegada no destino 
final (ajustado à hora local do destino). É necessário estar 
navegando para que estes dados sejam exibidos.

ETA Próximo: o horário previsto do dia que você chegará à 
próxima parada na rota (ajustado para o horário local da 
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parada). É necessário estar navegando para que estes 
dados sejam exibidos.

Fora de Percurso: a distância para a esquerda ou para a 
direita pela qual você se desviou do percurso original. É 
necessário estar navegando para que estes dados sejam 
exibidos.

Hora do dia: a hora do dia atual com base em sua localização 
atual e nas definições de hora (formato, fuso horário, horário 
de verão).

Limite de velocidade: o limite de velocidade reportado para a 
rodovia. Não disponível em todos os mapas e em todas as 
áreas. Confie sempre nas placas das rodovias que indicam 
os limites reais de velocidade.

Local (lat/lon): a posição atual de latitude e longitude, 
independentemente da definição de formato da posição 
selecionada.

Local (seleccionado): a posição atual usando a definição de 
formato da posição selecionada.

Local de destino: o posicionamento do seu destino final. É 
necessário estar navegando para que estes dados sejam 
exibidos.

Média da volta: o tempo médio da volta para a atividade atual.
Nascer do Sol: a hora do nascer do sol com base na posição 

do GPS.
Para o percurso: a direção em que deve seguir para voltar à 

rota. É necessário estar navegando para que estes dados 
sejam exibidos.

Percurso: a direção da sua posição de partida até um destino. 
O curso pode ser visto como uma rota planejada ou definida. 
É necessário estar navegando para que estes dados sejam 
exibidos.

Ponteiro: uma seta aponta na direção da próxima parada ou 
curva. É necessário estar navegando para que estes dados 
sejam exibidos.

Ponto pass. no dest.: o último ponto na rota até o destino. É 
necessário estar navegando para que estes dados sejam 
exibidos.

Ponto pass. no próx.: o próximo ponto na rota. É necessário 
estar navegando para que estes dados sejam exibidos.

Pôr-do-Sol: a hora do pôr-do-sol com base na posição do GPS.
Potência do sinal GPS: a intensidade do sinal de satélite GPS.
Precisão do GPS: a margem de erro de sua localização exata. 

Por exemplo, sua localização por GPS tem uma margem de 
erro de +/- 3,65 m (12 pés).

Pressão Ambiente: pressão não calibrada do ambiente.
Profund.: a profundidade da água. Seu dispositivo deve estar 

conectado a um dispositivo NMEA® 0183 ou NMEA 2000®

capaz de obter a profundidade da água.
Subida - Máxima: a taxa máxima de subida em pés por minuto 

ou metros por minuto desde a última zerada.
Subida - Média: a distância vertical média de subida desde a 

última zerada.
Subida - Total: a distância de elevação total de subida desde a 

última zerada.
Taxa Desliz. até Dest.: a proporção de deslize necessária para 

decrescer de sua posição atual até a elevação de destino. É 
necessário estar navegando para que estes dados sejam 
exibidos.

Taxa Deslizamento: a proporção de distância horizontal 
percorrida até a mudança na distância vertical.

Temp - Ambiente: a temperatura do ar. A temperatura do corpo 
afeta o sensor de temperatura. O dispositivo deve estar 
conectado a um sensor de temperatura sem fio para que 
esses dados sejam exibidos.

Temperatura - Água: a temperatura da água. Seu dispositivo 
deve estar conectado a um NMEA dispositivo 0183 capaz de 
obter a temperatura da água.

Temperatura máxima de 24 horas: a temperatura máxima 
registrada nas últimas 24 horas. O dispositivo deve estar 
conectado a um sensor de temperatura sem fio para que 
esses dados sejam exibidos.

Temperatura mínima de 24 horas: a temperatura mínima 
registrada nas últimas 24 horas. O dispositivo deve estar 
conectado a um sensor de temperatura sem fio para que 
esses dados sejam exibidos.

Tempo da última volta: o tempo do cronômetro para a última 
volta concluída.

Tempo para destino: a estimativa de tempo restante antes de 
chegar ao destino. É necessário estar navegando para que 
estes dados sejam exibidos.

Tempo Próx.: a estimativa de tempo restante antes de chegar à 
próxima parada na rota. É necessário estar navegando para 
que estes dados sejam exibidos.

Temporizador do alarme: a hora atual do timer de contagem 
regressiva.

Temporizador do cronômetro: o tempo do cronômetro para a 
atividade atual.

Tempo Viagem: uma contagem constante do tempo total gasto 
movendo-se e sem se mover desde o último zeramento.

Tempo Viagem - mov.: uma contagem constante do tempo 
gasto movendo-se desde o último zeramento.

Tempo Viagem - par.: uma contagem constante do tempo 
gasto sem se mover desde o último zeramento.

Veloc. Vertical: a taxa de subida ou descida ao longo do 
tempo.

Velocidade: a taxa atual do percurso.
Velocidade - Máxima: a mais alta velocidade atingida desde o 

último zeramento.
Velocidade - Méd. Total: a velocidade média durante o 

movimento e a parada desde o último zeramento.
Velocidade Verdadeira: a velocidade que se encontra ao 

aproximar-se de um destino ao longo da rota. É necessário 
estar navegando para que estes dados sejam exibidos.

Velocidade vertical até destino: a taxa de subida ou descida a 
uma altitude predefinida. É necessário estar navegando para 
que estes dados sejam exibidos.

Veloc - Méd. em Mov.: a velocidade média durante o 
movimento desde o último zeramento.

Vire: o ângulo de diferença (em graus) entre a direção do 
destino e seu percurso atual. L significa virar à esquerda. R 
significa virar à direita. É necessário estar navegando para 
que estes dados sejam exibidos.

Volta actual: o tempo do cronômetro para a volta atual.
Voltas: o número de voltas concluídas para a atividade atual.
Volta Total: o tempo do cronômetro para todas as voltas 

concluídas.

Perfis
Os perfis são uma coleção de configurações que otimizam seu 
dispositivo com base no modo como você o utiliza. Por 
exemplo, as configurações e as visualizações são diferentes 
quando você usa o dispositivo ao caçar do que ao fazer 
geocaching.
Quando você está utilizando um perfil e altera configurações, 
como campos de dados ou unidades de medida, as alterações 
são salvas automaticamente como parte do perfil.
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Criar perfil personalizado
Além disso, você pode personalizar suas configurações e os 
campos de dados para uma atividade ou viagem específica.
1 Selecione Configur > Perfis > Criar perfil > OK.
2 Personalize as configurações e os campos de dados.

Selecionar perfil
Quando altera as atividades, você pode alterar a configuração 
do dispositivo ao alterar o perfil.
1 Selecione Alterar o perfil.
2 Selecione um perfil.

Editar um nome de perfil
1 Selecione Configur > Perfis.
2 Selecione um perfil.
3 Selecione Editar Nome.
4 Insira o novo nome.

Excluir um perfil
OBSERVAÇÃO: antes de excluir o perfil ativo, é necessário 
ativar um perfil diferente. Não é possível excluir um perfil 
enquanto ele está ativo.
1 Selecione Configur > Perfis.
2 Selecione um perfil.
3 Selecione Eliminar.

Configurações do sistema
Selecione Configur > Sistema.
Sistema de satélite: define o sistema de satélite (GPS e outros 

sistemas de satélite, página 9).
WAAS: permite que o sistema utilize dados do Sistema de 

Aumento de Área Ampliada/Sistema Europeu Complementar 
Geoestacionário (WAAS/EGNOS).

Idioma: configura o idioma do texto no dispositivo.
OBSERVAÇÃO: a alteração do idioma do texto não altera o 
idioma de dados inseridos pelo usuário ou dados do mapa, 
como nomes de rua.

Tipo de pilha: permite alterar o tipo de bateria AA sendo 
utilizada.

Modo USB: configura o dispositivo para usar o modo de 
armazenamento em massa ou modo Garmin quando 
conectado a um computador.

GPS e outros sistemas de satélite
Usar o GPS junto com outro sistema de satélite oferece um 
melhor desempenho em ambientes desafiadores e obtém o 
posicionamento mais rápido do que usando apenas o GPS. No 
entanto, usar vários sistemas pode reduzir a duração da bateria 
mais rapidamente do que usando apenas o GPS.
Seu dispositivo pode usar os Sistemas de navegação global por 
satélite (GNSS).
GPS: uma constelação de satélites construída pelos Estados 

Unidos.
GLONASS: uma constelação de satélites construída pela 

Rússia.

Configurações do visor
Selecione Configur > Ecrã.
Tempo da retro-ilumin.: define o período de tempo restante 

antes de a luz de fundo apagar.
Poupança de bateria: economiza a energia e prolonga a vida 

útil da bateria ao apagar a tela quando a luz de fundo se 
esgota.

Cores: Altera a aparência do fundo da tela e o destaque da 
seleção.

Captura de ecrã: permite salvar a imagem na tela do 
dispositivo.

Definindo toques do dispositivo
Você pode personalizar toques para mensagens, teclas, avisos 
de curva e alarmes.
1 Selecione Configur > Tons > Tons > Activar.
2 Selecione um toque para cada tipo audível.

Definir as unidades de medida
Você pode personalizar unidades de medida para distância e 
velocidade, elevação, profundidade, temperatura, pressão e 
velocidade vertical.
1 Selecione Configur > Unidades.
2 Selecione um tipo de medida.
3 Selecione uma unidade de medida.

Configurações de hora
Selecione Configur > Hora.
Formato da hora: configura o dispositivo para mostrar a hora 

no formato de 12 horas ou 24 horas.
Fuso horário: Define o fuso horário para o dispositivo. 

Automático define automaticamente o fuso horário com base 
em sua posição de GPS.

Configurações do formato de posição
OBSERVAÇÃO: não altere o formato de posição ou o sistema 
de coordenadas de dados do mapa, a menos que esteja usando 
um mapa ou um gráfico que especifique um formato de posição 
diferente.
Selecione Configur > Formato da posição.
Formato da posição: define o formato de posição no qual a 

leitura de um local é exibida.
Dados Refer. Mapa: define o sistema de coordenadas no qual 

o mapa é estruturado.
Esferóide do Mapa: exibe o sistema de coordenadas que o 

dispositivo está utilizando. O sistema de coordenadas padrão 
é WGS 84.

Configurações de rotas
As configurações de rota disponíveis podem variar com base na 
atividade selecionada.
Selecione Configur > Encaminham..
Método Orientação: define a preferência para otimizar o 

cálculo da rota com base na distância, tempo, e rota on-road 
ou off-road.

Calcular Rotas para: define o método usado para calcular sua 
rota.

Bloquear na Estrada: bloqueia o triângulo azul, que representa 
sua posição no mapa, na estrada mais próxima. Isso é muito 
útil ao dirigir ou navegar em estradas.

Transições Fora Estr.: define as preferências de recálculo ao 
navegar para fora de uma rota ativa.

Config elem evitar: configura os tipos de estradas, terreno e 
modos de transporte a serem evitados durante a navegação.

Configuração do altímetro
OBSERVAÇÃO: o altímetro está disponível apenas com 
dispositivoseTrex 32x.
Selecione Configur > Altímetro.
Calibração Automática: calibra automaticamente o altímetro 

sempre que o dispositivo é ligado.
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Modo de Barômetro: Elevação Variável permite que o 
barômetro meça alterações de elevação em movimento. 
Elevação Fixa supõe que o dispositivo esteja parado a uma 
elevação fixa, portanto a pressão barométrica deve apenas 
ser alterada em razão das condições meteorológicas.

Tendência Barométrica: configura o modo como o dispositivo 
registra dados de pressão. Gravar Sempre registra todos os 
dados de pressão, que podem ser úteis quando você está 
observando as frentes de pressão.

Tipo de gráfico: grava alterações de elevação durante um 
período ou distância, a pressão barométrica durante um 
período ou as alterações de pressão do ambiente em um 
período.

Calibração do altímetro: calibra o altímetro.

Definições marítimas
Selecione Configur > Náutica.
Modo de Carta náutica: configura o tipo de gráfico que o 

dispositivo utiliza ao exibir dados marítimos. Náutico 
apresenta vários recursos dos mapas em diferentes cores, 
para que os POIs marítimos sejam mais legíveis, portanto o 
mapa reflete o esquema de desenho dos gráficos impressos. 
Pesca (exige mapas marítimos) exibe uma visualização 
detalhada dos contornos de fundo e das sondagens de 
profundidade, e simplifica a apresentação do mapa para uma 
utilização otimizada durante a pesca.

Aspecto: configura a aparência dos auxílios de navegação 
marítima no mapa.

Def alarme náutico: configura os alarmes ao exceder 
determinada distância de deriva enquanto ancorado, a 
determinada distância fora de rumo e ao entrar na água em 
uma profundidade específica.

Configurando alarmes marítimos
1 Selecione Configur > Náutica > Def alarme náutico.
2 Selecione um tipo de alarme.
3 Selecione Activar.
4 Insira uma distância e selecione Ir.

Redefinir dados
É possível redefinir os dados de viagem, excluir todas as 
paradas, apagar o trajeto atual ou restaurar os valores padrão.
1 Selecione Configur > Repor.
2 Selecione um item para redefinir.

Informações sobre o dispositivo
Atualizações do produto
Em seu computador, instale o Garmin Express™

(www.garmin.com/express). Em seu smartphone, instale o 
aplicativo Garmin Connect™.
Isso fornece fácil acesso a esses serviços para dispositivos 
Garmin:
• Atualizações de software
• Atualizações de mapa
• Carregamento de dados para Garmin Connect
• Registro do produto

Definindo Garmin Express
1 Conecte o dispositivo ao computador usando um cabo USB.
2 Acesse garmin.com/express.
3 Siga as instruções na tela.

Registro do dispositivo
Ajude-nos a atendê-lo melhor completando ainda hoje nosso 
registro online. Mantenha o recibo de venda original ou uma 
cópia em um local seguro.
1 Acesse garmin.com/express.
2 Faça login em sua conta Garmin.

Visualizar informações de conformidade e 
regulamentação do rótulo eletrônico
O rótulo deste dispositivo é fornecido eletronicamente. O rótulo 
eletrônico pode fornecer informações de regulamentação, tal 
como os números de identificação da FCC ou marcas de 
conformidade regionais, bem como informações aplicáveis de 
produto e licenciamento.
1 Selecione Configur.
2 Selecione Acerca de.

Cuidados com o dispositivo
AVISO

Evite produtos químicos, solventes, e repelentes de insetos que 
possam danificar os componentes de plástico e acabamentos.
Não coloque o dispositivo em locais com exposição prolongada 
a temperaturas extremas, pois isso pode causar danos 
permanentes.
O dispositivo é resistente à água de acordo com os padrões IEC 
60529 IPX7. Suporta a imersão acidental em 1 metro de água 
durante 30 minutos. Submersão prolongada pode causar danos 
ao dispositivo. Após submersão, seque o dispositivo com um 
pano e ao ar antes de usá-lo ou carregá-lo.
Lave cuidadosamente o dispositivo com água potável, após 
exposição a ambientes de água salgada ou com cloro.

Limpar o dispositivo
AVISO

Mesmo pequenas quantidades de suor ou umidade podem 
causar corrosão dos contatos elétricos quando conectados a 
um carregador. A corrosão pode interferir no carregamento e na 
transferência de dados.

1 Limpe o dispositivo usando um pano umedecido com 
solução de detergente neutro.

2 Seque-o com um pano.
Após a limpeza, deixe o dispositivo secar completamente.

Gerenciamento de dados
Você pode armazenar arquivos no seu dispositivo. O dispositivo 
possui um slot de cartão de memória para armazenamento 
adicional de dados.
OBSERVAÇÃO: o dispositivo é compatível com Windows 7 e 
posterior e com Mac OS 10.4 e posterior.

Instalando um cartão de memória

 ATENÇÃO
Não use qualquer objeto afiado para retirar as pilhas 
substituíveis pelo usuário.

Você pode instalar um cartão de memória microSD® no 
dispositivo portátil para armazenamento adicional ou mapas 
pré-carregados.
1 Gire a argola em D no sentido anti-horário e puxe-a para 

remover a tampa.
2 Remova a bateria.
3 Deslize o suporte do cartão para a esquerda e levante-o.
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4 Coloque o cartão de memória com os contatos dourados 
virados para baixo.

5 Feche o suporte do cartão.
6 Deslize o suporte do cartão para a direita, para travá-lo.
7 Recoloque a bateria e a tampa.

Conectando o dispositivo ao computador
AVISO

Para evitar corrosão, seque cuidadosamente a mini-porta USB, 
a capa contra intempéries e a área envolvente antes de 
carregar ou ligar o dispositivo a um computador.

Antes de poder operar o dispositivo enquanto estiver conectado 
ao computador, é necessário instalar as baterias. A porta USB 
do computador pode não fornecer energia suficiente para 
operar o dispositivo.
1 Levante a cobertura de proteção da porta mini-USB.
2 Conecte a extremidade menor do cabo USB à porta mini-

USB.
3 Conecte a extremidade maior do cabo USB à porta USB do 

computador.
Em computadores Windows, o dispositivo é exibido como 
uma unidade removível ou um dispositivo portátil, e o cartão 
de memória pode ser exibido como uma segunda unidade 
removível. Em computadores Mac , o dispositivo e o cartão 
de memória são exibidos como volumes montados.

Transferir arquivos para seu dispositivo
1 Conecte o dispositivo ao computador.

Em computadores Windows, o dispositivo é exibido como 
uma unidade removível ou um dispositivo portátil, e o cartão 
de memória pode ser exibido como uma segunda unidade 
removível. Em computadores Mac , o dispositivo e o cartão 
de memória são exibidos como volumes montados.
OBSERVAÇÃO: alguns computadores com diversas 
unidades de rede não podem exibir unidades de dispositivo 
corretamente. Consulte a documentação do sistema 
operacional para saber como mapear a unidade.

2 No computador, abra o navegador de arquivos.
3 Selecione um arquivo.
4 Selecione Editar > Copiar.
5 Abra o dispositivo portátil, a unidade ou o volume do 

dispositivo ou do cartão de memória.
6 Navegue até uma pasta.
7 Selecione Editar > Colar.

O arquivo aparece na lista de arquivos na memória do 
dispositivo ou no cartão de memória.

Excluindo arquivos
AVISO

Se você não souber a finalidade de um arquivo, não o exclua. A 
memória do dispositivo contém arquivos do sistema importantes 
que não devem ser excluídos.

1 Abra a unidade Garmin ou o volume.
2 Se necessário, uma pasta ou o volume.

3 Selecione um arquivo.
4 Pressione a tecla Excluir no teclado.

OBSERVAÇÃO: se você está usando um computador 
Apple®, é necessário esvaziar a pasta Lixo para remover os 
arquivos completamente.

Desconectando o cabo USB
Se seu dispositivo estiver conectado a um computador como 
uma unidade removível ou volume, você deverá desconectá-lo 
com segurança do computador para evitar perda de dados. Se 
o dispositivo estiver conectado ao computador Windows como 
um dispositivo portátil, não será necessário desconectá-lo com 
segurança.
1 Execute uma ação:

• Em computadores Windows selecione o ícone Remover 
hardware com segurança na bandeja do sistema e 
selecione seu dispositivo.

• Para computadores Apple, selecione o dispositivo e 
selecione Arquivo > Ejetar.

2 Desconecte o cabo do computador.

Especificações
Intervalo de temperatura de funciona-
mento

De -20° a 70°C (de -4° a 158°F)

Frequência/protocolo sem fio 2,4 GHz a -1,13 dBm nominal

Apêndice
Acessórios opcionais
Acessórios opcionais, como suportes, mapas, acessórios de 
condicionamento físico e peças de reposição, estão disponíveis 
em http://buy.garmin.com ou no seu revendedor Garmin.

Emparelhando seus sensores ANT+
Antes de emparelhar, você deve vestir o monitor cardíaco ou 
instalar o sensor.
O emparelhamento é a conexão de sensores sem fio ANT+, por 
exemplo, a conexão de um monitor cardíaco com o seu 
dispositivo.
1 Coloque o dispositivo ao alcance de até 3 m (10 pés) do 

sensor.
OBSERVAÇÃO: afaste-se 10 m de outros sensores ANT+ 
durante o emparelhamento.

2 Na bandeja de aplicativos, selecione Configur > 
Sensor ANT.

3 Selecione o seu sensor.
4 Selecione Procurar novo.

Após emparelhar o sensor com o seu dispositivo, seu status 
mudará de A procurar para Com ligação.

Dicas para emparelhar acessórios ANT+ com o seu 
dispositivo Garmin
• Verifique se o acessório ANT+ é compatível com o seu 

dispositivo Garmin.
• Antes de emparelhar o acessório ANT+ com o seu 

dispositivo Garmin, afaste-se 10 m (33 pés) de outros 
acessórios ANT+.

• Coloque o dispositivo Garmin a um alcance de 3 m (10 pés) 
do acessório ANT+.

• Após emparelhar pela primeira vez, seu dispositivo Garmin 
reconhecerá automaticamente o acessório ANT+ sempre 
que ele for ativado. Esse processo ocorre automaticamente 
ao ligar o dispositivo Garmin, levando apenas alguns 
segundos quando os acessórios estão ativados e 
funcionando corretamente.
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• Quando emparelhado, o seu dispositivo Garmin recebe 
dados apenas do seu acessório, sendo possível se 
aproximar de outros acessórios.

Solução de problemas
Reiniciar o dispositivo
Se o dispositivo parar de responder, talvez seja necessário 
reiniciá-lo. Isso não apaga seus dados nem suas configurações.
1 Remova as baterias.
2 Instale novamente as baterias.

Restaurar todas as configurações padrão
É possível redefinir todas as configurações para as 
configurações padrão de fábrica.

Selecione Configur > Repor > Repor todas defin. > Sim.

Central de suporte da Garmin
Acesse support.garmin.com para obter ajuda e informações, 
tais como manuais do produto, perguntas frequentes, vídeos e 
suporte ao cliente.
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